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ABOUT THIS MANUAL 
 
Edupoint Educational Systems develops software with multiple release dates for the 
software and related documentation. The documentation is being released in multiple 
volumes to meet this commitment. 
 
The table below lists the release date, software version, documentation volume number, 
and the content included in each volume of documentation to date. 
 
Software and Document History 
Date  Volume  Edition  Revision  Content 

October 2009 1 1 1 Initial release of this document 

March 2010 1 1 2 
Updated to include changes from 
the November 2009 release and 
the February and March 2010 
patches 

April 2011 1 1 3 
Updated to include changes from 
the November 2010 release, and 
added chapter on ClassBoard 

November 2012 1 1 4 
Updated to include release notes 
and technical notifications since 
the June 2011 release. 

May 2013 1 1 5 Updated to the 8.0 release. 

 
May 2013 

 
1 

 
1 

 
6 

Course information added to 
create a combined Scheduling and 
Course guide 

 
July 2013 

 
1 

 
1 

 
7 Updated to include changes 

from release 8.0.2.0 

September 2013 1 1 8 
Updated to the 8.0.4.0 release. 
Added four new reports and 
section lock feature. 

 
  



Scheduling and Course Guide  

8 Copyright© 2013 Edupoint Educational Systems, LLC 

CONVENTIONS USED IN THIS MANUAL 
 
Bold 
Text 

Bold Text - Indicates a button or menu or other text on the 
screen to click, or text to type. 

 

Tip – Suggests advanced techniques or alternative ways of 
approaching the subject. 

 

Note – Provides additional information or expands on the topic 
at hand. 

 

Reference – Refers to another source of information, such as 
another manual or website 

 

Caution – Warns of potential problems. Take special care 
when reading these sections. 

 
 
BEFORE YOU BEGIN 
 
Before installing any of the Edupoint family of software products, please be sure to review 
the system requirements and make sure the district’s computer hardware and software 
meet the minimum requirements. If there are any questions about the system requirements, 
please contact an Edupoint representative at (877) 899-9111.  
 
 

  

Caution: The Edupoint family of software does not support the use of 
pop-up blockers or third-party toolbars in the browser used to access 
Synergy SIS. Please disable any pop-up blockers (also known as pop-
up ad blockers) and extra toolbars in the browser before logging into 
any Edupoint product. 

 
 
At any point, if there are any technical difficulties, please contact the Edupoint technical 
support team at support@edupoint.com or by phone at 1-877-899-9111 option 1. 
  

mailto:support@edupoint.com
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Chapter One:
OVERVIEW 

 
 
 
 
 
 
 
 
 
 
 
 

In this chapter, the following topics are covered: 
 

  Overview of Scheduling and Mass Scheduling 
 

  About Course 
 

  Implementation considerations 
 

  Steps to complete before starting the schedule 
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OVERVIEW OF SCHEDULING 
 
There are two main methods to creating the students’ class schedules in Synergy SIS. Mass 
Scheduling allows students to be scheduled by groups and is primarily used by large 
secondary schools. Scheduling is primarily used by elementary schools or smaller schools 
where only one or two sections of a given course may be offered. 
 
Synergy SIS offers two ways to conduct mass scheduling. The Scheduler requires that the 
proposed sections be added to the scheduler, and then analyzes the student requests that can 
be fulfilled with the proposed sections.  
 
Master Schedule Builder takes the process a step further, and presents a much easier, faster 
way to build a schedule. It allows schools to compare options such as the maximum number of 
students in a room, or the maximum number of periods a teacher is assigned per day. Master 
Schedule Builder takes the existing course requests and available teachers and rooms, and 
builds the proposed sections for the school. Its many reports can also show which courses are 
understaffed, or where more room space is needed. There is an additional cost for the Master 
Schedule Builder, so please contact the district’s Edupoint sales representative to add this 
valuable tool to the district’s Synergy SIS installation. 
 
This manual covers all aspects of the scheduling process except for the Master Schedule 
Builder, and explains all the views in the Course, Mass Scheduling and Schedule folders. 
There are also a number of reports that can be generated from the information, and Chapter 
Nine reviews the available reports and shows how to customize and print these reports. 
Chapter Ten outlines the security options available for each screen used in scheduling. 
 
The ClassBoard tool for mass scheduling is also covered in Chapter Seven.  
 
  



Chapter One   Scheduling and Course Guide 
 

Copyright© 2013 Edupoint Educational Systems, LLC 11 

To access a screen: 

1. Open the Synergy SIS Navigation Tree by clicking on the Tree button. 

 
Figure 1.1 – Synergy SIS Navigation Tree 

2. Expand the Synergy SIS folder by clicking on the blue triangle pointing right, next to the 
word Synergy SIS. Once clicked, the triangle turns green and points downward. 

 
Figure 1.2 – Synergy SIS Folder 

 

 
Figure 1.3 – Synergy SIS Folder 

Expanded 

1. Under the Synergy SIS folder, open the Course folder by clicking on the blue triangle 
pointing right, next to the word Course. Once clicked, the triangle turns green and points 
downward. 

 
Figure 1.4 – Course Folder 

 

 
Figure 1.5 – Course Folder Expanded 

 

  

Note: In the rest of the manual, the location of a screen or report 
in the Navigation Tree (also referred to as the PAD tree) is 
indicated using “>”. The example above would be indicated as 
Synergy SIS > Course. This would mean go to the Navigation 
Tree, click on the Synergy SIS folder, and then click on the 
Course folder. 

 

ABOUT COURSE 
Some Synergy SIS screens are available in multiple places in the Navigation Tree, but 
administrative personnel can limit your access to those places. Therefore, you might have 
access to Synergy SIS > Course, Synergy SIS > Schedule, or both. 
 
The screens in Synergy SIS > Course are described in Chapter Two of this guide, except 
CTE Programs, which is described in the Synergy SIS – Course History Administrator 
Guide. The reports in Synergy SIS > Course are described in Chapter Nine of this guide. 
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IMPLEMENTATION CONSIDERATIONS 
 
Before beginning the scheduling process, it is important to identify all of the rules and 
standards that apply to the student’s schedule. The following issues should be decided prior 
to scheduling. 
 
Core Courses 

• Do certain grades have required core courses? For example, 7th grade 
students must be scheduled in English 101, Math 101, Science 101, and Social 
Studies 101.  

• Do certain groups of students have required core courses? For example, 
students in the band must be scheduled for the Marching Band course in Period 
1, cheerleaders must take PE in Period 6, and ROTC students must be 
scheduled in the ROTC class in Period 6. 

 
Pre-Requisites and Co-Requisites for District Courses 

• Do students have to pass another course before enrolling in this course 
(pre-requisite)? For example, Keyboarding 101 must be completed before 
taking Computers 101, or Spanish 1 must be completed before taking Spanish 
2. 

• Do some courses need to be taken together in the same semester (co-
requisite)? For example, students must take Biology 101 and Lab 101 in the 
same semester. 

 
Course Requests 
 

• Are alternate course requests allowed? Alternate course requests are backup 
course requests that are used if the student cannot be scheduled for their 
primary course request.  

• If alternate requests are allowed, are they one-to-one for any type of 
course (core or elective), or are they allowed to select global alternates for 
any elective, or are both types allowed? A one-to-one alternate would be if 
the student’s primary course request is Algebra 1, but if they cannot take that 
class they would like to take Business Math. Global alternates would be if the 
student has selected 2 elective classes, and provided a list of several alternative 
classes that will be used if they can’t be scheduled for either or both of their 
chosen electives. 

• How should duplicate course requests be handled? Should they all be 
scheduled, all rejected or only one scheduled? 

• Will students have the option to select a term or teacher preference? A 
term preference is if the student may select which term they would prefer to be 
scheduled for a course. A teacher preference is if the student may select which 
teacher they would prefer. 
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Scheduling Options 

• Will students be teacher aides? If so, will a generic teacher aide course be 
used? 

• Will sections be limited by the maximum seats defined for the section or 
the maximum seats defined for the assigned room? Most schools use the 
maximum seats for the section as this gives them the flexibility to adjust for 
teacher considerations as well as room constraints, but either option is available. 

• Will students be pre-scheduled in sections? Pre-scheduling students may 
limit the overall options when using Mass Scheduling, but may be appropriate 
for sections offered for a very specific group of students such as students 
repeating a course for credit. 

• Will term override by used? For example, with Term Override enabled for a 
yearlong course, a student could be scheduled to take only one semester of the 
yearlong course.  

• Will some classes need to be scheduled in separate terms? For example, 
State Government and Free Economics are two required classes for students in 
12th grade. However, the students must take these courses in different terms.  

• Are the majority of the students scheduled for a set number of hours or 
periods? For example, the majority of the students are scheduled for 6 periods; 
however there are students who are scheduled for 1 hour or half a day. 

• Will the student’s schedule be the same on every day, or will the schedule 
vary depending on the day of the week? If the schedule varies, rotation 
periods and/or rotation days can be used to define when course sections meet. 

 
 
Class & Student Groupings 

• When sections are created, should they be grouped in any particular 
combination to keep select students with select teachers, etc.? If yes, 
teams will be used to keep the group of students scheduled in the same 
sections. 

• If teams will be used, what options need to remain the same for the group 
of students? Students can be restricted to the same teacher, period, and /or 
room, or they can be scheduled with no restrictions. 

• When students are scheduled, should they be grouped in any particular 
combination of sections? If yes, houses will be used to keep students in the 
same group of courses. 

• When courses are grouped together in repetition, should they be grouped 
together in any particular combination of sections? If yes, wheels will be 
used to allow ease of scheduling these course “wheels.” 
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BEFORE STARTING 
 
Before beginning the Scheduling process, several decisions need to be made and 
information about the new school year needs to be gathered. 

• Gather all information about the course catalog, any pre-requisite/co-requisite 
info, and a list of any changes for the new school year 

• Identify any changes to the rooms available for classes, or any changes to 
capacity. Update the information in the School Room screen. 

• Get an updated list of the teachers for the new school year, and update the 
information in the Staff screen. 

• Complete the New Year Rollover as outlined in the Synergy SIS – New Year 
Rollover Guide. 

Once the preparatory tasks are completed as outlined above, the scheduling process can 
begin. A checklist of the order of tasks needed to complete the Mass Scheduling process is 
outlined below. 
 
Mass Scheduling Check List 
 
Task Completed 
Setup the Scheduling Options 

• Define the terms and periods for new school year in the School 
Setup screen 

• Update courses in the District Course screen  

• Opt-in to any new courses and opt-out of courses that will not 
be used though the School Course screen 

• Identify any changes to staff, classes offered, and House and 
Team assignments  

• Modify the School Scheduling Options as needed 

 

Enter Student Course Requests 

• Setup ParentVUE/StudentVUE if allowing students to make 
online course requests (optional) 

• Mass assign Period Restrictions through Mass Assign House 
and Team (optional) 

• Mass Assign House and Team (optional) 

• Mass Assign Course Requests (optional) 

• Enter and maintain student course requests in the Schedule 
Request screen 

• Have students complete online course requests in ParentVUE 
and StudentVUE (optional) 

 
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Review Reports 

• Review reports to verify and determine initial section offering, 
students without full requests, etc.  

 

Create Initial Master Schedule 

• Copy last year’s master schedule as reference 

• Copy or create a new option set named 98 Working Copy 

• Create the sections within the 98 Working Copy Option Set 

 

Review Reports 

• Review reports to verify initial section offering with student 
course requests 

• Modify course requests and sections as needed after analyzing 
reports 

• Pre-schedule students as needed  

 

Create Additional Test Schedules 

• Copy 98 Working Copy to a new option set named 97 Working 
Copy  

• Check out a copy of the new option set 97 Working Copy 

• Select scheduling rules and options for this option set 

• Run the schedule 

 

Analyze Scheduling Results 

• Review the results of the scheduling in the Option Set 

• Screen any conflicts lists in the Schedule Student screen of the 
Option Set 

 

Review Reports 

• Analyze reports for analysis of scheduling results 

 

Run Final Test Schedules 

• Copy 98 Working Copy to a new option set named 96 Working 
Copy for updating and re-scheduling  

• Modify Schedule Requests as necessary 

 

Finalize Schedule 

• Copy the final option set with student results to a new option set 
titled YR/YR Final Master Schedule 

• Run the Update Schedule process. This will copy the YR/YR 
Final Master Schedule from Mass Schedule to Schedule 

• Hide the Mass Scheduling folder from end users 

 
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• Print student schedules using STU202 report 
 
Once the schedule has been finalized, all scheduling for new students and any schedule 
changes for returning students should be completed in the Walk In Schedule screen.  
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Chapter Two: 
COURSES & ROOMS SETUP 

 
 
 
 
 
 
 
 
 
 
 
 

In this chapter, the following topics are covered: 
 

  How to set up the course catalog at the district level 
 

  How to “opt-in” to a course 
 

  How to set up a course group 
 

  How to define the rooms used at a school
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DISTRICT COURSE SETUP 
 

On the District Course screen are several drop-down lists, where users select pre- 
populated values. The values in each list are stored in a lookup table. The lookup tables 
can be modified on Synergy SIS > System > Setup > Lookup Table Definition. Some 
lookup tables are considered “product-owned,” meaning the values have been hard-coded 
into the Synergy SIS programming, and consequently cannot be changed. The other tables 
may be modified to match the needs of the school district. Before creating courses in the 
District Course screen, these values should be entered. To modify a lookup table’s values: 

 

1.  Go to Synergy SIS > System > Setup > Lookup Table Definition. 
 

2.  Find the table that needs to be changed by clicking on the triangles for each node. 
All the lookup tables for the District Course screen are found under the node 
K12.CourseInfo. 

 

3.  Once the table is located, click the Add button to add a new code. 

 
Figure 2.1 – Academic Type Lookup Table 

4.  A defined order can be set by entering the order number in the ListOrder column. 
Otherwise, the values are sorted in alphanumeric order by the Description field. If 
the numbers in the ListOrder field are the same, the Description is used to sort the 
list. 

 

5.  Enter a code for the item in the Code column. This value must be unique since it is 
used internally to link the tables in the database and it is displayed in the drop-down 
list. 

 

6.  Enter the description of the code in the Description column. 
 

7.  The Other SIS column is used to import data during the conversion process from 
another student records system. Enter the code used in the old system in this 
column. 

 

8.  If appropriate, a start date and end date may be entered for the code in the Status 
column to activate or deactivate the code for a particular year. If a code is inactive, it 
shows in data already entered but it is no longer available for selection for new 
records. For example, if a code is no longer valid for records beginning FY2008, 
select 2008 for the end year. 

 

9.  The State Code, Alt Code 3, and Alt Code SIF are not needed since this 
information is not uploaded to the state. The checkbox at the top of the table Use 
Code as the State Code is not used as well. 

 

10. Click the Save button at the top of the screen to save the changes. 
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To delete a code, click the box in the X column, and click the Save button at the top of the 
screen. 
 
The District Course screen  has the following lookup  tables on the Course tab: 
 

 

  
Figure 2.2 – District Course Screen 
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• Course Duration – the length of the course such as semester or quarter. 
The lookup table is located in K12.CourseInfo, and the table name is 
Course Duration. 

 
Figure 2.3 – Course Duration Lookup Table 

 
• Department – the department at the school or district overseeing the 

course, such as English or Math. The lookup table is located under 
K12.CourseInfo, and the table name is Department. 

 
Figure 2.4 – Department Lookup Table 

 
• Academic Type – the type of course, such as honors or regular. The lookup 

table is located under K12.CourseInfo, and the table name is Academic 
Type. 

 
Figure 2.5 – Academic Type Lookup Table 
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• Course History Type – the type of course, such as Jr. High School or 
High School. The lookup table is located under K12.CourseHistoryInfo, 
and the table name is Course History Type. 

 
Figure 2.6 – Course History Type Lookup Table 

 
• Duplicate Request – how to handle a course request when a student 

has requested the same course twice. The lookup table is located 
under K12.CourseInfo, and the table name is Duplicate Request. 
This table is a product-owned table and cannot be changed. 

 
Figure 2.7 – Duplicate Request Lookup Table 

 
• Schedule Priority – the priority the course should receive during the 

scheduling process. The lookup table is located under K12.CourseInfo, and 
the table name is Schedule Priority. This table is a product-owned table 
and cannot be changed. 

 
Figure 2.8 – Schedule Priority Lookup Table 

• Grade Range Low & High, Grade Low & High – a list of possible grade 
levels. 

This is the same list of grade levels that is used through Synergy SIS, and 
the setup of the list is outlined in the data reporting guide for your state. 

 

• Gender – a list of gender abbreviations. This is the same list of 
abbreviations that is used through Synergy SIS, and the setup of the list is 
outlined in the data reporting guide for your state.  
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Subject Area 1-5 – the subjects assigned to the course for matching graduation 
requirements for high school. The lookup table is located under 
K12.CourseInfo, and the table name is Subject Area. 

 
Figure 2.9 – Subject Area Lookup Table 

 
• College Area 1-5 – the list of subjects that must be completed in high school 

for college admission. The lookup table is located under K12.CourseInfo, 
and the table name is College Subject Area. 

 
Figure 2.10 – College Subject Area Lookup Table 
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• University Area 1-5 – the list of subjects that must be completed in high school 
for university admission. The lookup table is located under K12.CourseInfo, and 
the table name is University Subject Area. 

 
Figure 2.11 – University Subject Area Lookup Table 

• Category Code – the code assigned by the state to the course. The lookup 
table is located under K12.CourseInfo, and the table name is State Cat. 

 
Figure 2.12 – State Cat Lookup Table 

• Instructional Level – if the instructional level of the course is non-standard, the 
list of possible instructional levels as assigned by the state. The lookup table is 
located under K12.CourseInfo, and the table name is Instructional Level. 

 
Figure 2.13 – Instructional Level Lookup Table 
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• NCLB Core – a list of the type of core courses for NCLB reporting. The lookup 
table is located under K12.CourseInfo, and the table name is NCLB Core. This 
table is a product-owned table and cannot be changed. 

 
Figure 2.14 – NCLB Core Lookup Table 

• Technical Provider – a list of the providers of vocational & technical education 
courses (generally set by the state). The lookup table is located under 
K12.CourseInfo, and the table name is Technical Provider. 

 
Figure 2.15 – Technical Provider Lookup Table 

• Provider Description – a list types of providers such as LEA Contract Provider 
and Post-Secondary Institution.  The lookup table is located under 
K12.CourseInfo, and the table name is Provider Description. 

 
Figure 2.16 –Provider Description Lookup Table 

• Voc Ed Type – a list of the types of vocational & technical education courses 
(generally set by the state). The lookup table is located under K12.CourseInfo, 
and the table name is Voc Ed Type. 

 
Figure 2.17 – Voc Ed Type Lookup Table 
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• Funding Source – if the course qualifies for alternative state funding, a list of 
possible funding sources (generally set by the state, particularly California). The 
lookup table is located under K12.CourseInfo, and the table name is Funding 
Source. 

 
Figure 2.18 – Funding Source Lookup Table 

• Apportionment Category – used in California to specify the category used for 
the course. The lookup table is located under K12.CourseInfo, and the table 
name is Apportionment Category. 

 
Figure 2.19 - Apportionment Category Lookup Table 

• Course Type – used in California to indicate the type of course for funding. The 
lookup table is located under K12.CourseInfo, and the table name is Course 
Type. 

 
Figure 2.20 - Course Type Lookup Table 
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• Proficiency Core – used in California to indicate if the course is a core course 
or for proficiency. The lookup table is located under K12.CourseInfo, and the 
table name is Proficiency Core. 

 
Figure 2.21 – Proficiency Core Lookup Table 

• Course Discipline – the course discipline category is assigned to courses in 
states using verified credit such as Virginia. For this lookup to display, verified 
credit must be enabled on the District Setup screen. The lookup table is located 
under K12.CourseInfo, and the table name is Course Discipline. 

 
Figure 2.22 – Course Discipline Lookup Table 

• Skills Assessment – indicates if the course qualifies for a Carl Perkins Skill 
Assessment. The lookup table is located under K12.CourseInfo, and the table 
name is Cp Skills Test. 

 
Figure 2.23 – CP Skills Test Lookup Table 

• Alt Type – the alternative ID for courses are used to filter and match courses in 
the Student Course History to graduation requirements. The lookup table is 
located under K12.CourseInfo, and the table name is Alt ID Type. 

 
Figure 2.24 – Alt ID Type Lookup Table 

 

  

Reference: For more information about configuring 
Verified Credit for Graduation Requirements, please see 
the Synergy SIS – Course History Administrator Guide. 
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On the Description tab, the lookups are: 
 

  
Figure 2.25 – District Course Screen, Description Tab 

• Subject Area (National Course Classification) – the official list of national 
course subject areas. The lookup table is located under K12.CourseInfo, and 
the table name is SCED Subject Area. This table is a product-owned table and 
cannot be changed. 

 
Figure 2.26 - SCED Subject Area Lookup Table 
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• Course Level (National Course Classification) – the official national list of 
course levels. The lookup table is located under K12.CourseInfo, and the table 
name is SCED Course Level. This table is a product-owned table and cannot 
be changed. 

 
Figure 2.27 - SCED Course Level Lookup Table 

• Course Code – the official list of national course codes. The lookup table is 
located under K12.CourseInfo, and the table name is SCED Course Code. 
This table is a product-owned table and cannot be changed. 

 
Figure 2.28 - SCED Course Code Lookup Table 

• Subject Area (State Course Classification) – the list of subject areas used by 
the state for courses. The lookup table is located under K12.CourseInfo.MN, 
and the table name is MN SCED Subject Area.  

 
Figure 2.29 - MN SCED Subject Area Lookup Table 
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• Course Level (State Course Classification) – the list of course levels used by 
the state. The lookup table is located under K12.CourseInfo.MN, and the table 
name is MN SCED Course Level.  

 
Figure 2.30 - MN SCED Course Level Lookup Table 

• Standard Addressed – the type of standard addressed by the course. The 
lookup table is located under K12.CourseInfo.MN, and the table name is 
Standard Addressed.  

 
Figure 2.31 - Standard Addressed Lookup Table 
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DISTRICT COURSE 
 
The District Course screen lists all of the courses that are taught within the district. These 
records are not school-year specific. The Section screen then captures the individual 
classes held each year for each course. Once the lookup tables have been created as 
outlined in the District Course Setup section in this chapter, courses can be added. To add 
a course: 

1. Go to the District Course screen, found under Synergy SIS > Course and under 
Synergy SIS > Schedule. 

 
Figure 2.32 – District Course Screen 

2. Click the Add button at the top of the screen.
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The Add District Course screen pops-up in a new window. The fields that must be 
completed before saving are highlighted in green. The other information can be 
completed as needed. Many of the fields are state specific, and do not need to be 
completed for other states. The information that can be added is: 

 
Figure 2.33 – District Course Screen, Adding 

• Course ID – the ID code used to identify the course. This can be any sequence 
of numbers and/or letters, but it is limited to 20 characters. 

• Course Title – the complete title of the course 

• Course Short Title – an abbreviated version of the course title that can be used 
in column headings in reports. 
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• Mandatory – to assign the course to all the schools in the district, check the 
Mandatory box. For courses that are not mandatory, schools must “opt-in” to the 
course via the School Course screen before the course can be used at the 
school. For more information about the School Course “opt-in” process, see the 
chapter on School Courses later in this chapter. 

• Inactive – once a course has been used in the Student Course History screen, it 
cannot be deleted. However, a course may be phased out over time and no 
longer used. To remove the course from any course lists without deleting it, 
check the Inactive box. 

• Always Show In Course History Add – displays this course on the Student 
Course History Assignment screen chooser list, even if it is inactive. 

• Course Duration – select the length of the course from the drop-down list, such 
as semester or quarter. These options can be customized for each district by 
modifying the Lookup Table, as explained in the first section of this chapter. 

• Department – select the department at the school or district that oversees this 
course, such as English or Math. These options can be customized for each 
district by modifying the Lookup Table, as explained in the first section of this 
chapter. 

• College Prep – if the course is preparatory for college, check the College Prep 
box. 

• Credit – the numeric amount of credit earned by successfully completing the 
course in the course duration selected. The number can be a maximum of 3 
digits, with 4 decimal places past zero (999.9999). 

• Max Credit – if the student can take the course for credit more than once, the 
maximum amount of credit that can be earned in the course. The number can be 
a maximum of 3 digits, with 4 decimal places past zero (999.9999). For 
example, an independent study course may be taken more than once for .5 
credits but the student can only earn a maximum of 2.0 credits total. 

• Academic Type - the academic level of the course such as honors or regular.  
These values can be customized for each district by modifying the Lookup 
Table, as explained in the first section of this chapter. 

• Teacher Aide – if this course can assign a teacher’s aide, check this box. 

• College Approved – if this course has been approved by a college for college 
admission requirements, check this box. 

• Pass/Fail Only – if this course is a Pass/Fail only course, check this box.  

• Extended Day – if this course is on the extended day calendar, check this box. 

• Distance Learning Course – if this course is part of a distance-learning 
program, check this box. 

• Online Course – if this course is an online course, check this box.  

• Duplicate Request – how to handle a course request when a student has 
requested the same course twice.  Select Schedule all Requests to schedule 
one of the duplicates, or select Reject All Requests to not schedule any of the 
duplicate requests.  This setting can be overridden for all courses using the 
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Duplicate Course Request setting in the School Scheduling Options 
screen or the Schedule Option Set screen for mass scheduling. 

• Schedule Priority – when using mass scheduling, the Core (High) courses are 
scheduled before the Elective (Low) courses. Select the category for the course 
from the Schedule Priority drop-down list.  

• School Name – identifies the primary school teaching this course.   

 

Note – School Name is typically used to identify a virtual school that 
is teaching a particular course.     

• Optimum Size – defines the optimal number of students in the course. 

• Maximum Size – defines the maximum number of students in the course. 

• Status -   Year Start, Year End – indicates the school years in which the course 
is valid. 

• Course Restrictions – if the course can only be taken by students at certain 
grade levels, or if it is restricted to one gender such as a gym class, select the 
Gender, Grade Low, and Grade High from the drop-down lists. 

• Old SIS Course ID – enter the course ID used in the previous student 
information system for this course. This is used during any conversion 
processes to map the information converted from the old system. 

• Category Code – select the code assigned by the state to the course. These 
values can be customized for each district by modifying the Lookup Table, as 
explained in the first section of this chapter. 

• Instructional Level – if the instructional level of the course is non-standard, 
select the code for the instructional level used in the course. These codes are 
generally set by the state, and they can be customized for each district by 
modifying the Lookup Table, as explained in the first section of this chapter. 

• NCLB Core – select the type of core course such as Elementary Core, 
Secondary Core, or Not Core for NCLB reporting. 

• Exclude From State Reporting – if this course should be excluded from state 
reporting, check this box. 

• Exclude From Attendance Letters – if this course should be excluded from 
attendance letters, check this box.  

• Technical Course – if this course meets the state standards for a vocational or 
technical education course, check this box. 

• Exclude from Eligibility Course Count – courses are counted based on term 
code. This option excludes this course from the Eligible Course Count. 

• Exclude from Eligibility Course Count Multiplier – courses are counted 
based on term codes and a multiplier can be assigned. This option excludes this 
course if it would apply to the multiplier based on the term code. 

• Technical Provider – if the course is a vocational & technical education course, 
select the entity providing the instruction (generally a list provided by the state). 
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This list can be customized for each district by modifying the Lookup Table, as 
explained in the first section of this chapter. 

• Provider ID – if the course is taught by a provider other than a district staff 
member, enter their provider ID number. 

• Provider Name– if the course is taught by a provider other than a district staff 
member, enter the provider’s name. 

• Provider Description– if the course is taught by a provider other than a district 
staff member, select a provider description. 

• Voc Ed Type – if the course is a vocational & technical education course, select 
the category for the course (generally a list provided by the state). This list can 
be customized for each district by modifying the Lookup Table, as explained in 
the first section of this chapter. 

• Qualifies for Alternate State Funding – if all students taking this course are 
approved for an alternative source of funding (such as JTED in Arizona), check 
this box. If only individual students taking the course can qualify, do NOT check 
this box, and instead check the Show Qualified Alternate Funding box on the 
Course Request and Walk-In Options tab of the School Scheduling Options 
screen. This will allow individual students to be designated for alternate funding. 

• Funding Source – if the course qualifies for alternate funding, select the source 
of the funding from this drop-down list. This list can be customized for each 
district by modifying the Lookup Table, as explained in the first section of this 
chapter. For California schools and districts, please see Synergy SIS – 
Attendance Administrator Guide for more information regarding the 
Supplemental Instruction attendance & recording setup. 

• Apportionment Category – if the course qualifies for apportionment 
procedures in California, select the category from the drop-down list. Enter the 
Apportionment Category, the Course Type, and the Proficiency Core in the 
corresponding Lookup Tables. The list can be customized from the district 
modified Lookup Table, as explained in the first section of this chapter. 

• Carl Perkins – if this course can be used to meet the requirements of the 
Perkins Act federal grant program, enter the Program Code, the Course Code, 
the Course Length (minutes), and the Skills Assessment. 

• ParentVUE Options – these options are used to control the courses available to 
parent and student course requests through the ParentVUE & StudentVUE 
software. For more information, please see the Synergy SIS – ParentVUE & 
StudentVUE Administrator Guide. 

• Subject Areas – each course can fulfill one or more of the subject areas 
required for high school graduation. Select the primary subject area from the 
Subject Area 1 drop-down list. If that subject area requirement has already been 
fulfilled, the course is applied to the requirement for the Subject Area 2, etc. For 
example, an English class would count for the English subject area 
requirements first (in Subject Area 1), and if that was fulfilled it would count 
towards the student’s Electives subject area requirement (in Subject Area 2). 
This list of subject areas can be customized for each district by modifying the 
Lookup Table, as explained in the first section of this chapter. 
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• College and University Subject Areas – each course can fulfill one or more of 
the subject areas required for college or university admission as well. Select the 
primary subject area from the College Area 1 drop-down list. If that subject area 
requirement has already been fulfilled, the course is applied to the requirement 
for the College Area 2, etc. This list of subject areas can be customized for each 
district by modifying the Lookup Table, as explained in the first section of this 
chapter. 

• Alternate Codes – courses can be excluded or included in the graduation 
requirements calculations by assigning each course an Alternate ID code. Be 
careful when using this feature, as if this filter is activated, every course that 
should be included in the calculations must be assigned an alternate ID. For 
existing course catalogs, this can involve quite a bit of data entry. To add an 
alternate ID, click the Add button in the Alternate Codes section. Select the Alt 
Type from the drop-down list, and enter the code in the Alt Code column. 

• Verified Credit 1 & 2 – courses that qualify for verified credit should be 
specified by selecting the Course Discipline from the drop-down list. To 
associate the course with a Test Group, click on the gray arrow and select the 
test group from the list. 

3. Click the Save button at the top of the screen to save all of the information. 

 

Reference – For more information about the impact of subject 
areas and alternate codes on school graduation requirements, 
and for instructions on configuring Verified Credit, please see the 
Synergy SIS – Course History Administrator Guide for more 
information. 

 
Once a course has been created, most fields can be edited simply by clicking in them and 
making the changes. However, to change the Course ID, Course Title, or Course Short 
Title, and to change the Mandatory or Inactive status of a course: 

1. Click the Menu button at the top of the screen. 

2. Select Edit Course Data. 

 
Figure 2.34 – Menu Options, District Course Screen 

3. The top row of course information turns white and the information can be changed. 

 
Figure 2.35 – Editing the top row of Course Information 

4. Click the Save button at the top of the screen 
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Course descriptions are used in reports to create the course catalog. This tab also records 
the course’s alignment to national and state standards. While the national and state course 
classification was designed for Minnesota reporting, any state can capture this information. 
To add or modify the course description and classification: 

1. Click on the Description tab of the District Course screen. 

  
Figure 2.36 – Description Tab, District Course Screen 

2. Enter or modify the text in the Short Description field.  

3. Enter or modify the text in the Description box. The text may be checked for 
spelling by clicking the Spell Check  button. 

4. Select the Subject Area assigned to this course for national course standards. 

5. Select the Course Level such as honors or remedial for national course standards. 

6. Select the Course Code from the national standards that best meets the content of 
the course. 

7. Enter the Sequence number of the course. If the course is part of a multi-course 
series, such as Theater Arts I, II, and III, the sequence number is the part number of 
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the course. For example, if Theater Arts II was a yearlong course and part of a three 
course series, its sequence number would be two. If it was the first semester of a 
three course series, it would be three (of six parts). 

8. Enter the credit a student can earn by passing this course in the Available Credit 
box. 

9. Select the Subject Area assigned to this course for state course standards. This list 
can be customized by the district. 

10. Select the Course Record Type assigned to this course for state standards.  This 
list can be customized by the district. 

11. Check the Course Levels such as honors or remedial for state course standards. 
This list can be customized by the district. 

12. Select the type of standard addressed by this course from the Standard Addressed 
list, such as national or state. This list can be customized by the district. 

13. If the course is required for graduation, check the Grad Requirement Indicator 
box. 

14. If this is the last course in a series, such as the second semester of a yearlong 
course, check the End of Course Indicator box. 

15. If this course meets the International Baccalaureate qualifications, check the IB 
Indicator box.  

16. If this course qualifies as an Advanced Placement course, check the AP Indicator 
box. 

17. If this course qualifies as an American Institute for Creative Education (AICE) 
course, check the AICE Indicator. 

18. If this course qualifies as an International General Certificate of Secondary 
Education (IGCSE) course, check the IGCSE Indicator. 

19. If this course is a college-level course, enter the code used for the college in the 
College Code box. 

20. Enter the code for the course used by the college in the College Course Code field. 

21. Enter the title for the course used by the college in the College Course Title field. 

22. Enter the number of college credits earned by passing the course in the College 
Course Credits box. 

23. Enter the code for the course used by the state in the State Course Code field. 

24. Enter the code for the course used by the department in the Department Code 
field. 

25. Click the Save button at the top of the screen to save the changes, or click the 
Undo button to cancel the changes. 

  

Reference: For more information about the national course classification 
system, please see the document School Codes for Exchange of Data: a 
Course Classification System, published by the National Center for 
Education Statistics.  
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As graduation requirements and other state requirements change over time, it may be 
necessary to create year-specific requirements for each course. To setup the year-specific 
information for a course: 

1. Click on the Year Override tab of the District Course screen. 

 
Figure 2.37 – Year Override Tab, District Course Screen 

2. To add year-specific subject areas for either high school, college or university 
requirements, click the Add button in the Course Subject Areas section. 

 
Figure 2.38 – Course Subject Areas Section 

3. Enter the starting year for the new subject areas as a 4-digit year in the Start 
column, and the ending year in the End column. 

4. Select the subject areas from the drop-down lists as needed. 

5. To add year-specific alternate codes, click in the Add button in the Alternate Codes 
section. 

 
Figure 2.39 – Alternate Codes Section 

6. Enter the starting year for the new alt code as a 4-digit year in the Start column, and 
the ending year in the End column. 

7. Select the Alt Type from the drop-down list, and enter the Alt Code. 

8. To add year-specific funding source information, click the Add button in the 
Qualifies for Alt State Funding section. 

 
Figure 2.40 – Qualifies for Alt State Funding Section 

9. Enter the starting year for the new funding source as a 4-digit year in the Year Start 
column, and the ending year in the Year End column. 

10. Select the Funding Source from the drop-down list. 

11. To specify a course as a vocational or technical education course for only a set 
period of years, click the Add button in the Technical Course section. 
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Figure 2.41 – Technical Course Section 

12. Enter the starting year for the new funding source as a 4-digit year in the Year Start 
column, and the ending year in the Year End column. 

13. After all of the year-specific information has been added or modified, click the Save 
button at the top of the screen to save the changes, or click Undo to cancel the 
modifications. 

If the course has pre-requisite courses that must be completed successfully before 
enrolling, or it has courses that must be taken at the same time (co-requisites), these 
requirements can be added to the District Course screen. If multiple prerequisites are 
required for a course or if a variety of courses can meet the requirement, a prerequisite 
course group can be created.  The Staff is then notified if the student does not meet these 
requirements before enrolling the student in the course.  
 
To add a corequisite or prerequisite: 

1. Click on the Pre/Corequisite tab of the District Course screen. 

  
Figure 2.42 – Pre/Corequisite Tab, District Course Screen 

2. Either courses can be added as co-requisites one at a time by clicking the Add 
button, or multiple courses can be added at one time by clicking the Chooser 
button.  

3. To add a co-requisite course one at a time, click the Add button in the Corequisite 
section. The Find Course Box pops-up. 

 
Figure 2.43 – Find Course Screen 
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4. Enter all or part of the Course ID and/or Course Title to be found, and click the Find 
button. A list of courses matching the criteria entered is listed in the Search Results 
grid. 

 
Figure 2.44 – Find Course Screen, Find Results 

5. Click on the course to be added and it is highlighted in blue. Then click the Select 
button to add it to the Corequisites section. 

 
Figure 2.45 – Find Course Screen, Course Selected 

6. To add multiple courses at a time, click the Chooser button in the Corequisites 
section. 

 
Figure 2.46 – Corequisites Section 

7. The Chooser screen pops-up. Enter all or part of the Course ID and/or Course Title 
to be found, and click the Find button. A list of courses matching the criteria entered 
is listed in the Search Results grid. 

 
Figure 2.47 – Chooser Screen 
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8. Click on a course to add, and it becomes highlighted in blue. To select multiple 
courses, hold down the Shift button and click on all the courses needed. Once all of 
the courses are selected, click the Add Selected Row(s)> button to add the 
courses to the Selected Items grid. To add all of the courses listed, click the Add All 
Row(s)>> button. 

 
Figure 2.48 – Chooser Screen, Selected Items 

9. Once all of the courses have been selected from the current search results, another 
Find can be conducted by entering different criteria and clicking the Find button. 
This can be repeated until all the needed courses are listed in the Selected Items 
grid. Once all of the courses are listed, click the Select button to add them to the 
Corequisites section. 

  
Figure 2.49 – District Course Screen, Pre/Corequisite Tab, Corequisite Added 

10. As with co-requisites, pre-requisites can be added either one at a time by clicking 
the Add button, or multiple courses can be added at one time by clicking the 
Chooser button. 

11. To add a pre-requisite course one at a time, click the Add button in the Prerequisite 
section. The Find Course Box pops-up. 
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Figure 2.50 – Find Course Screen 

12. Enter all or part of the Course ID and/or Course Title to be found, and click the 
Find button. A list of courses matching the criteria entered is listed in the Search 
Results grid. 

 
Figure 2.51 – Find Course Screen, Find Results 

13. Click on the course to be added and it becomes highlighted in blue. Then click the 
Select button to add it to the Prerequisite section. 

 
Figure 2.52 – Find Course Screen, Selecting 

14. To add multiple courses at a time, click the Chooser button in the Prerequisite 
section. 

 
Figure 2.53 – Prerequisites Section 

15. The Chooser screen pops-up. Enter all or part of the Course ID and/or Course Title 
to be found, and click the Find button. A list of courses matching the criteria entered 
is listed in the Search Results grid. 
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Figure 2.54 – Chooser Screen 

16. Click on a course to add, and it becomes highlighted in blue. To select multiple 
courses, hold down the Shift button and click on all the courses needed. Once all of 
the courses are selected, click the Add Selected Row(s)> button to add the 
courses to the Selected Items grid. To add all of the courses listed, click the Add All 
Row(s)>> button. 

 
Figure 2.55 – Chooser Screen, Selected Items 

17. Once all of the courses have been selected from the current search results, another 
Find can be conducted by entering different criteria and clicking the Find button. 
This can be repeated until all the needed courses are listed in the Selected Items 
grid. Once all of the courses are listed, click the Select button to add them to the 
Prerequisite section. 
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Figure 2.56 – District Course Screen, Pre/Corequisite Tab, Prerequisites Added 

18. Once all of the pre/corequisites have been added, click the Save button at the top of 
the screen to add them to the course. Note the Valid Marks column now says – Any 
creditable mark - . 

  
Figure 2.57 – District Course Screen, Pre/Corequisite Tab, Saved 

19. By default, a pre-requisite is considered met if the student receives a mark in the 
course that receives credit (a “creditable” mark). To modify which marks are 
considered valid for completing a pre-requisite, click the Show Detail button in the 
Prerequisite section. 
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Figure 2.58 – District Course Screen, Pre/Corequisite Tab 

20. Click on the Course to modify on the left-hand side, and it becomes highlighted in 
blue. Then check the Marks that are considered valid for completing the pre-
requisite. 

 
Figure 2.59 – District Course Screen, Pre/Corequisite Tab, Detailed Screen 

21. Click the Save button at the top of the screen to save the changes, and click the 
Hide Detail button. The marks checked off now appear in the Valid Marks column. 
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Figure 2.60 – District Course Screen, Pre/Corequisite Tab, Marks Modified 

 
To create a Prerequisite Group 

1. Navigate to the Prerequisite Course Group screen, found under Synergy SIS > 
Course. 

2. Click on the Add button at to the top of the screen. The Prerequisite Course Group - 
Add screen appears. 

 
Figure 2.61 - Prerequisite Course Group screen 

3. Enter the Group Name. 

 
Figure 2.62 - Prerequisite Course Group (Add) screen 

4. Select a Log ic  Type. When creating the course group, you have the option to 
select a logic type of ‘And’ or ‘Or’. This logic type only applies to the courses 
listed within the Prerequisite Course Group. The same logic type applies to all of 
the courses within a single Prerequisite Course Group. 

5. Click the Save button. You are returned to the Prerequisite Course Group screen.  
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6. On the Prerequisite Course Group screen, click on Add to add a specific course or 
Chooser to select multiple courses from a list. 

 
Figure 2.63 - Prerequisite Course Group screen 

7. Select the appropriate courses and click Save. You are returned to the 
Prerequisite Course Group screen and the courses are listed in the 
Prerequisites grid. 

 
Figure 2.64 - Prerequisite Course Group screen - added prerequisites 

8. Select which marks the student needs to achieve to consider the prerequisite 
fulfilled using the Mark field (optional.) 

9. Highlight the line of the course and click the Show Detail button to view and 
modify the Valid Marks for Pre-Requisite. 

10. Select the appropriate grade that must be achieved or leave all of the 
checkboxes blank if all creditable marks qualify. 

 
Figure 2.65 - Prerequisite Course Group screen - Valid Marks for Pre-Requisite 

11. Click Save. After the prerequisite course groups have been created, they are 
added to the Pre/Corequisite tab of the District Course screen for those 
courses the groups apply to. 
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Figure 2.66 - Prerequisite Course Group screen 

To add a Prerequisite Group to a District course: 
 

 
Figure 2.67 – District Course screen, Pre/Corequisite tab, Prerequisite Group section 

1. As with co-requisites and pre-requisites, Prerequisite Groups can be added either 
one at a time by clicking the Add button, or multiple courses can be added at one 
time by clicking the Chooser button. 

2. To add a pre-requisite course one at a time, click the Add button in the Prerequisite 
section. The Find: PreReqGroup screen appears. 

 
Figure 2.68 – Find PrePreqGroup Screen 

3. Enter all or part of the Group Name to be found, and click the Find button. A list of 
prerequisite groups matching the criteria entered is listed in the Search Results grid. 
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Figure 2.69 – Find Course Screen, Find Results 

4. Click on the group to be added and it becomes highlighted in blue. Then click the 
Select button to add it to the Prerequisite Group section. 

5. To add multiple prerequisite groups at a time, click the Chooser button in the 
Prerequisite Group section. 

6. The Chooser screen opens. Enter all or part of the Group Name to be found, and 
click the Find button. A list of groups matching the criteria entered is listed in the 
Search Results grid. 

 
Figure 2.70 – Chooser Screen 

7. Click on a group to add, and it becomes highlighted in blue. To select multiple 
groups, hold down the Shift button and click on all the courses needed. Once all of 
the groups are selected, click the Add Selected Row(s)> button to add the courses 
to the Selected Items grid. To add the entire group listed, click the Add All 
Row(s)>> button. 

8. Once all of the groups have been selected from the current search results, click the 
Select button to add them to the Prerequisite Groups section. 
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Figure 2.71 – District Course Screen, Pre/Corequisite Tab, Prerequisites Added 

9. Once all of the prerequisite groups have been added, click the Save button at the 
top of the screen to add them to the course. 

 

Note – All of the prerequisites (single courses and course groups) 
behave as ‘OR’s. In the above example, students need to have 
taken MA25 OR the course(s) in the Core group in order to take 
Algebra I. 

 
The Schools Teaching tab of the District Course screen is strictly informational, and 
displays a list of schools that offer the course. 
 

 
Figure 2.72 – District Course Screen, Schools Teaching Tab 
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The Associated Courses tab of the District Course screen enables users to associate 
other courses.  If the Scheduling Options field on the School Setup screen is set to 
Homeroom and Associated Course Enrollments, in an elementary school can associate 
courses that are expected to be taught by the homeroom teacher with a homeroom.  
 

 
Figure 2.73 – District Course Screen, Associated Courses Tab 

 
To associate a course to a district course: 

1. To add associated courses, click the Chooser button 

2. The Chooser screen opens. Enter all or part of the Course ID or the Course Title to 
be found, and click the Find button. A list of courses matching the criteria entered is 
listed in the Search Results grid. 

 
Figure 2.74 – Chooser Screen 

3. Click on a course to add, and it becomes highlighted in blue. To select multiple 
courses, hold down the Shift button and click on all the courses needed. Once all of 
the course are selected, click the Add Selected Row(s)> button to add the courses 
to the Selected Items grid. To add all of the courses listed, click the Add All 
Row(s)>> button. 

4. Once all of the groups have been selected from the current search results, click the 
Select button to add them to the Courses section. 
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Figure 2.75 – District Course Screen, Associated Courses Tab 

5. Once all of the courses have been added, click the Save button at the top of the 
screen to add them to the course. 

The Standards tab of the District Course screen enables to align standards to courses.  
The Course screen now has a Standards tab.  Users can select the standards by Standards 
Type, Subject, and Grade Level. The standards can be weighted within the course, and 
flagged to be included in the students’ report cards.   
 
To add standards to a course: 

 
Figure 1: District Course screen – Standards tab 

1. Select the Chooser button. The Chooser screen displays.  

 
Figure 2: District Course – Chooser screen 

2. Select the standards to associate with this course. 
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3. Click Select. The selected standards display in the Standards grid of the 
Standards tab. 

 
Figure 3: District Course screen – Standards tab 

4. Select which standards to include in report cards by selecting the checkbox in the 
Include In Report Card column.  

5. Set the appropriate weight for the standards in the Weight column. 

6. Click Save.  

The Opt In Option tab of the District Course screen enables users to select the type of 
schools that are allowed to opt in to this course.  Also, individual schools can be allowed to 
or excluded from opting in to the course.  
 

 
Figure 2.76 – District Course Screen, Opt In Options Tab 

To select a school type to allow opting in: 

1. Select the type from the School Types group box. 
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Figure 2.77 – Chooser Screen 

2. Click Save. 

To include or exclude individual schools: 

1. Select the Chooser button. The Chooser screen displays.  

 
Figure 2: District Course – Chooser screen 

2. Select the school to include or exclude from opting into this course. 

3. Click Select. The selected school display in the Opt In Types grid of the Opt In 
Options tab. 
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Figure 3: District Course screen – Opt In Options tab 

4. Select to include or exclude the school in the Include/Exclude column.  

5. Click Save.  

The Course Fees tab of the District Course screen enables users to associate fees with a 
course.  See the Fees Administrator and User Guide for more information on Course Fees.  
 

 
Figure 2.78 – District Course Screen, Course Fees Tab 
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SCHOOL COURSE OPT-IN 
 
Once all of the district courses have been added, each school needs to indicate which 
courses are offered at the school. Courses that have been defined as mandatory are 
already listed for every school. To select courses for each school: 

1. Set the current focus to the school to be modified. The focus is indicated in the top 
right hand corner of the screen.  

 
Figure 2.79 – Checking Current Focus 

2. Go to the School Course Opt-in screen, located under Synergy SIS > Course and 
under Synergy SIS > Schedule. 

 
Figure 2.80 – School Course Opt-in Screen 

3. The courses to be added can be searched for by selecting the course Subject Area 
from the drop-down list, or entering all or part of the Course ID, Course Short Title, 
Course Title, and/or Short Description. Once the criteria have been added, click 
the Search button to list the courses. 

  
Figure 2.81 – School Course Opt-in Screen, List of Courses Matching Criteria 

4. In the list of courses displayed, check the Opt In box for each course to be offered 
by the school in focus. 

  
Figure 2.82 – School Course Opt-in Screen, Opt-In Box 

5. Click the Save button at the top of the screen to save the selections. 

6. Continue searching and opting-in to courses until all of the courses have been 
selected. 

7. Change the focus to another school and repeat the process. Continue until all of the 
schools have been opted-in to the courses offered at the school. 
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At the end of the year after all courses have been scheduled, it may be helpful to remove 
courses from the list of courses offered at a school if no students enrolled in those courses. 
This process removes the OptIn checkmark for the course for the school in focus for the 
school year in focus. To remove these courses: 

1. At the top of the School Course Opt-in screen, click the Remove Unused Opt-In 
Courses button. 

 
Figure 2.83 – School Course Opt-In Screen 

2. A confirmation box pops-up to verify the courses should be removed. Click the Yes 
button to remove the courses, or No to cancel the process 

 
Figure 2.84 – Confirmation Box 

3. Once the Yes button has been clicked, the Removal process is sent to the RT 
Process Server. When it is complete, the Job Status screen pops-up announcing 
the job is complete, and it then quickly closes. 

 
Figure 2.85 – Job Status Screen 
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SCHOOL COURSE 
 
The School Course screen lists all of the courses that are taught at the school. These 
records are school year specific. These district courses have been opted into by the school. 
 

 
Figure 2.86 - School Course screen 

• Course ID – the ID code used to identify the course.  

• Course Title – the complete title of the course 

• Course Short Title – an abbreviated version of the course title that can be used 
in column headings in reports. 

• Course Duration – select the length of the course from the drop-down list, such 
as semester or quarter.  

• Credit – the numeric amount of credit earned by successfully completing the 
course in the course duration selected.  

• Optimum Size – defines the optimal number of students in the course. 

• Maximum Size – defines the maximum number of students in the course. 

• Current Section List – lists all the current sections of this course. Clicking the 
Show Detail button displays all the section information. (This is identical to the 
fields and data displayed on the Section screen. See Chapter 8 for more 
information.) 
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To add optimum and maximum class sizes: 

1. Go to the School Course screen, found under Synergy SIS > Course and under 
Synergy SIS > Schedule. 

 
Figure 2.87 – School Course Screen 

2. Enter the appropriate numbers in the Schedule Options group box fields. 

3. Click the Save button at the top of the screen. 

 
The Description tab of the School Course screen displays the course description based off 
the description entered in the District Course screen.  They are read only. 

 
Figure 2.88 – Description Tab, School Course Screen 

 
The Course Fees tab of the School Course screen enables users to associate school 
specific fees with a course.  See the Fees Administrator and User Guide for more 
information on Course Fees.  
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Figure 2.89 – District Course Screen, School Course Fees tab 
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COURSE GROUP 
 
Course Groups are used to filter the report OSM801 - Course Request Conflict Matrix. To 
create a new course group: 

1. Go to the Course Group screen, found under Synergy SIS > Course. 

 
Figure 2.90 – Course Group Screen 

2. Click on the Add button at the top of the screen 

3. A new Course Group screen pops-up. Enter the Name of the new group, and click 
the Save button.  

 
Figure 2.91 – Course Group Screen, Adding 

4. To add courses to the new group, click the Chooser button and the Chooser screen 
pops-up. 

 
Figure 2.92 – Course Group Screen, New Group Saved 
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5. Enter all or part of the Course ID and/or Course Title to be found, and click the 
Find button. A list of courses matching the criteria entered is listed in the Search 
Results grid. 

 
Figure 2.93 – Chooser Screen, Find Results 

6. Click on a course to add, and it becomes highlighted in blue. To select multiple 
courses, hold down the Shift button and click on all the courses needed. Once all of 
the courses are selected, click the Add Selected Row(s)> button to add the 
courses to the Selected Items grid. To add all of the courses listed, click the Add All 
Row(s)>> button. 

 
Figure 2.94 – Chooser Screen, Selected Items 

7. Once all of the courses have been selected from the current search results, another 
Find can be conducted by entering different criteria and clicking the Find button. 
This can be repeated until all of the courses are listed in the Selected Items grid.  



Chapter Two   Scheduling and Course Guide 
 

Copyright© 2013 Edupoint Educational Systems, LLC 63 

8. Once all of the courses are listed, click the Select button to add them to the group. 

 
Figure 2.95 – Chooser Screen, All Items Selected 

9. The courses are listed in the Group Courses grid. To save this list, click the Save 
button at the top of the screen. 

 
Figure 2.96 – Course Group Screen, Courses Added. 

10. To remove courses from the list, check the box in the X column and click Save. 
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SCHOOL ROOM 
 
Each section of a course is assigned to a room, based on the class size that can be 
accommodated in the room. Room availability and class size can be used in the creation of 
the schedule, so these values must be configured before the schedule can be created. To 
add the available rooms: 

1. Go to the School Room screen, found under Synergy SIS > System > Setup 

 
Figure 2.97 – School Room Screen 

2. To add a room, click on the Add button. A new blank line is added. 

 
Figure 2.98 – School Room Screen Adding 

3. Enter the name or the number of the room in the Room Name column. 

4. Enter the total number of students that can attend a class in the room in the Class 
Size column. 

5. Enter the starting year of the school year in focus as a 4-digit number in the School 
Year column. 

6. Select the Department and Room Type for the room if applicable. The department 
list is the same department lookup table as used by the District Course screen. This 
information is used by both ClassBoard and Master Schedule Builder. 

7. Continue adding rooms by clicking the Add button to add additional lines. 

8. To edit an existing room, simply click in the columns to change the information. To 
delete a room, check the box in the X column. 

9. Click the Save button at the top of the screen to save the changes. To cancel the 
changes, click the Undo button. 
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Chapter Three:
SCHEDULING SETUP 

 
 
 
 
 
 
 
 
 
 
 
 

In this chapter, the following topics are covered: 
 Defining the bell schedule 
 Where to set up a rotating period schedule 
 How to define the number of class period, the terms, and tracks 
 How to setup the school scheduling options 
 What are wheels, and how are they used in scheduling 
 How to set classes to record students as teacher aides 
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CLASS PERIODS 
 
Before scheduling, the number of periods in use at each school needs to be defined. To 
configure the number of periods: 

1. Go to the School Setup screen, found under Synergy SIS > System > Setup. 

 
Figure 3.1 – School Setup Screen 

2. Enter the class periods offered in the Period Definition section. Enter the number 
used for the first period (generally 1 or 0) in the Start Period box, and then enter the 
number for the last period in the End Period box. 

3. If the students are assigned a homeroom, indicate the period in which the 
homeroom is schedule in the Homeroom Period box. If there is not a standard 
homeroom period, this box may be left blank. 

4. If the homeroom is only scheduled for once a week, the day of the homeroom 
should be selected in the Homeroom Meeting Day drop-down. For more 
information about setting up period rotation, please see Chapter 3 in the Synergy 
SIS – Attendance Administrator Guide. 

5. Click the Save button at the top of the screen to save the changes. 

 
For more about assigning homerooms, please see Chapter 8 of this guide. 
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TERM DEFINITION 
 
Terms are the time in the year during which classes are held. A single term may have 
multiple grade reporting periods. The terms generally define when classes start and end, 
but a grade reporting period may indicate a significant milestone in the class such as the 
date of the midterm. Courses are then defined as to which term they are held. Terms must 
be defined every school year at every school. To define the terms: 

1. Go to the School Setup screen, found under Synergy SIS > System > Setup. 

 
Figure 3.2 – School Setup Screen 

2. Click on the Add button in the Term Definition section to add a new blank line where 
the term can be defined. 

  
Figure 3.3 – School Setup Screen, Adding a Term 
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3. Enter the Term Number, the Term Name such as Fall Semester or First Quarter, 
and the Term End Date. The date should be entered in the format MM/DD/YY or 
may be selected by clicking the Calendar  button. Click the Save button at the top 
of the screen, and the Term Begin Dates are automatically entered based on the 
school calendar and the end dates entered. 

  
Figure 3.4 – School Setup Screen, Terms Defined 

4. Next, the valid term codes need to be added to each term. This is done through the 
detailed screen of each term. To access the detailed screen of the term, click the 
Show Detail button. 

5. Click on the term to modify. To add a term code, click on the Add button in the Term 
Codes section. 

  
Figure 3.5 – School Setup Screen, Term Definition Detail 

6. Enter the Term Code Number, which should match the Term Number selected, and 
select the Term Code such as S1 for Semester 1 from the drop–down list. 
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7. Add as many codes as are in use at the school during that term. When finished, 
click the Save button. Note that the terms selected appear in the Current Term 
Codes column. 

  
Figure 3.6 – School Setup Screen, Completed Term Definitions 

 
 
The available term codes may be customized to fit the district’s naming preferences. To 
modify the available term codes: 

1. Go to the Lookup Table Definition screen, found under Synergy SIS > System > 
Setup. 

2. Click on the triangle next to K12.ScheduleInfo to expand the list of tables. 

3. Select the Term Codes table. 

  
Figure 3.7 – Term Codes Lookup Table Screen 

4. Click the Add button to add a new code. 

5. The order in which the values are displayed can be set by entering the order 
number in the ListOrder column. If the numbers in the ListOrder field are the same 
or are all-blank, the Code is used to sort the list and then the Description. 

6. Enter a code for the term in the Code column. This value must be unique since it is 
used internally to link the tables in the database and it is displayed in the drop-down 
list. 

7. Enter the description of the code in the Description column. 
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8. The Other SIS column is used to import data during the conversion process from 
another student records system. Enter the code used in the old system in this 
column. 

9. If appropriate, a start date and end date may be entered for the code in the Status 
column to activate or deactivate the code for a particular year. If a code is inactive, it 
shows in data already entered but is not available for selection for new records. For 
example, if a code is no longer valid for records beginning FY2008, select 2008 for 
the end year. 

10. The State Code, Alt Code 3, and Alt Code SIF are not needed since this 
information is not uploaded to the state. The checkbox at the top of the table Use 
Code as the State Code is not used as well.  

11. Click the Save button at the top to save the changes. 

 
To delete a code, click the box under the X column and click the Save button. 
 
 

BELL SCHEDULE DEFINITION 
 
Once the number of periods has been defined in the School Setup screen, the start and 
stop time for each period needs to be identified in the Bell Schedule Definition. This is also 
outlined in the Synergy SIS – Attendance Administrator Guide. Multiple bell schedules may 
be defined at a school, but only one schedule may be selected as the default schedule. To 
setup the bell schedule: 

1. Go to the Bell Schedule Definition screen, found under Synergy SIS > Schedule > 
Setup. 

 
Figure 3.8 – Bell Schedule Definition Screen 

2. Click on the Add button at the top of the screen, and a new screen pops-up. 
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3. Enter a code for the bell schedule in the Code field, and give the schedule a name 
in the Bell Schedule Name box. For example, the default schedule may use a code 
of DBS and the name of Default Bell Schedule. 

 
Figure 3.9 – Bell Schedule Definition, Code & Name 

4. Click the Save button at the top of the screen to save the new schedule name.  

5. The new schedule appears with a line for each period defined in the School Setup 
screen. The times for each period may be entered manually, or it can automatically 
be filled in using the Bell Schedule Creation Assistant. To see the creation assistant, 
click on the down arrow in the Bell Schedule Creation Assistant section. 

 
Figure 3.10 – Bell Schedule Definition, Created 

6. Enter the time of the first bell in the Start Time of First Period box. The time should 
be entered in standard clock format with AM or PM following (non-military time). 
Enter the Total Minutes Per Period and the Passing Time In-Between Periods in 
the boxes provided, and click the Create Bell Schedule button. 

 
Figure 3.11 – Bell Schedule Creation Assistant 
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7. A schedule is created for each period based on the number entered. Once the 
schedule appears, the numbers can be edited directly in the boxes provided. A 
period may also be deleted from the schedule by clicking on the red X under the 
Delete column. 

 
Figure 3.12 – Bell Schedule Definition, Completed 

8. When the schedule is finished, click the Save button at the top of the screen. 

 
To edit or delete an existing bell schedule: 

1. Use the Find or Scroll buttons to locate the definition. 

 
Figure 3.13 - Bell Schedule Definition screen 

2. Edit the numbers directly in the boxes provided to edit the schedule, and click the 
Save button at the top of the screen. 

3. To delete a schedule, click the Delete button at the top of the screen. 

 
 
Once the bell schedules have been defined, each date in the school calendar needs to be 
assigned a schedule. Only one bell schedule may be assigned to a calendar date. For 
instructions on how to define the school calendar and assign bell schedules, see the 
section on School Calendars in the Synergy SIS – Attendance Administrator Guide. 
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PERIOD ROTATION 
 
At some schools, classes may be taught during different periods on different days, or some 
classes may not meet every day. To configure the schedule to accommodate these 
classes, the period rotation must be setup. To setup the rotating periods: 

1. Go to the School Scheduling Options screen, found under Synergy SIS > System > 
Setup. 

 
Figure 3.14 – School Scheduling Options Screen 

2. In the Meeting Days section, click the Add button for each day in the period rotation. 
For example, if there were 4 days in the rotation, enter four meeting days. 

 
Figure 3.15 - School Scheduling Options screen, Meeting Days section 

3. Enter a Code for each day and a Description. Click the Save button at the top of the 
screen to save the changes. 

4. Next, go to the District Setup screen, found under Synergy SIS > System > Setup.   

5. On the System tab, scroll to the bottom of the Other Options group box. 

6. Select the Do not clear rotation periods when increasing the number of days in 
the cycle and the Do not clear rotation periods when decreasing the number of 
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days in the cycle checkboxes.  This allows the rotation periods to stay in the grid 
and not be deleted if changes are made on the Period Rotation Definition screen. 

7. Click Save. 

8. Go to the Period Rotation Definition screen, found under Synergy SIS > Attendance 
> Setup. 

 
Figure 3.16 – Period Rotation Definition Screen 

9. Enter the number of days used in a full rotation in the Number of Days in Cycle box. 
For example, if the periods change every other day, the number of days would be 
two. Or if the periods change every day until the 5th day is the same as the 1st day, 
the number of days would be four. 

 
Figure 3.17 – Period Rotation Definition Screen, 4 Days in Cycle 

10. Click the Save button at the top of the screen, and the Rotation Definition section is 
automatically filled in with a Day Code for each day in the cycle. 

11. Assign the meeting days created in the School Scheduling Options screen to each 
day in the cycle by selecting it from the Schedule Code drop-down. 

12. Click the Save button at the top of the screen. 

13. To setup the rotation, click on the Rotation Periods tab. 

 
Figure 3.18 – Period Rotation Definition, Rotation Periods Tab 

14. To set a non-rotating schedule where each period is at the same time every day in 
the cycle, click the Set Non-Rotating Default button. 
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Figure 3.19 – Rotation Periods, Non-Rotating Default 

15. To set up a rotating schedule, click the Set Rotating Default button. 

 
Figure 3.20 – Rotation Periods, Rotating Default 

16. Either default distribution can then be manually edited to adjust the rotation. Once 
the schedule is finished, click the Save button at the top of the screen to save the 
changes. 

17. To assign each rotation day a specific date in the school calendar, go to the School 
Calendar screen found under Synergy SIS > Attendance > Setup. 

 
Figure 3.21 – School Calendar Screen 
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18. To have the rotation automatically assigned to the calendar, with the rotation 
skipping over the holidays, click the Fill Rotating Days Skipping Over Holidays 
option and then click the Set Rotation Default button. The meeting day codes from 
the Period Rotation Definition screen are automatically filled in to the Rot column for 
each date. 

 
Figure 3.22 – School Calendar, Rotating Days Skipping Holidays 

 

19. To have the rotation automatically assigned to the calendar, with holidays counting 
as a rotation day, click the Fill Rotating Days Holidays Count As Rotation Day option 
and then click the Set Rotation Default button. The meeting day codes from the 
Period Rotation Definition screen are automatically filled in to the Rot column for 
each date. 

 
Figure 3.23 – School Calendar, Rotating Days Counting Holidays 

20. To set up a different rotation for part of the year, click the Customize the Rotation 
default by date and type button. 
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Figure 3.24 – Set Default Rotation Calendar Screen 

21. Select the date to start the new rotation in the Start Date field. The dates should be 
entered in the format M/D/YY or may be selected by clicking the Calendar  button. 
Select the Rotation Code from the drop-down list to start the rotation, and select the 
Rotation Default. The No Fill option clears the rotation. Click OK to fill in the 
calendar.  

22. Once the rotation has automatically been filled in, it can also be manually edited by 
clicking in the Rot column and selecting the Day code.  

 
Figure 3.25 – School Calendar Screen, Rotation Column 

23. Once all of the rotation days have been filled in, click the Save button at the top of 
the screen to save the changes. 

24. The final step in the process is to assign each section to a period for each rotation 
day. To assign a period to a section, go to the Section screen found under Synergy 
SIS > Schedule or use the Sched Section screen in the Option Set if using Mass 
Scheduling. 

 
Figure 3.26 – Section Screen, Meeting Days Tab 
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25. Click on the Meeting Days tab. For each Day Code from the Period Definition 
screen, select the period assigned to the section. 

26. Click the Save button at the top of the page to save the changes. The periods must 
be assigned for each section in the rotation. 

 

STAFF 
 
Each section of a course is assigned to a staff member.  Therefore, staff must be added to 
Synergy SIS and assigned to the appropriate schools prior to the creation of the schedule. 
For grouping and reporting in ClassBoard, or for use with Master Schedule Builder, it is also 
helpful to assign departments to staff. Instructions on how to add and update staff 
assignments are found in the Synergy SIS – System Administrator Guide. 
 
The assignment of staff to a section of a course can also be tracked historically by checking 
the box Enable Historical Tracking of Staff in Sections on the System tab of the District 
Setup screen, found under Synergy SIS > System > Setup. 
 
 

 
Figure 3.27 – District Setup screen, System Tab 
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TRACKS 
 
If students at the same school have different school calendars, this is referred to as a multi-
track school. Each track represents a different school calendar. This is commonly used to 
juggle limited space in school facilities. To configure tracks, please refer to the section on 
Tracks in the Synergy SIS – Attendance Administrator Guide. 
 
Once the tracks have been setup, each class section must be assigned to a specific track in 
multi-track schools. Tracks are assigned manually using the Section screen, found under 
Synergy SIS > Scheduling, or may be assigned automatically through the Mass Scheduling 
process. For more information about creating sections through the Mass Scheduling 
process, please see the section on Schedule Control in this guide. 
 

 
Figure 3.28 – Assigning Tracks to Sections 

 
Each student is also assigned to a specific track through the enrollment process. Each 
enrollment can only be assigned to one track. Student enrollments are entered through the 
Student screen, found under Synergy SIS > Student. For more information about the 
student enrollment process, see the Synergy SIS - Student Information Administrator Guide 
and Synergy SIS - Student Information User Guide. Students may also be mass assigned a 
track using the Mass Assign Track screen. Instructions on this screen can be found in 
Chapter 8 of this guide. 
 

 
Figure 3.29 – Assigning Students to Tracks 
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CLASS SIZE LIMIT 
 
Using either the Sched Section screen during Mass Scheduling or the Section screen 
during Scheduling, a maximum number of seats in the class is entered for each class. 
However, there may be times when it becomes necessary to exceed these class size limits. 
For example, a counselor may add a new student to a class before withdrawing other 
students that are known to be dropping the class. To allow the class to be overridden: 

1. At the district level, this is controlled using the System tab of the District Setup 
screen, found under Synergy SIS > System > Setup. Check the box Allow Negative 
Seat Totals to allow the class size limits to be exceeded. 

 

 
Figure 3.30 – District Setup screen, System Tab 

2. At the school level, the class size limit is regulated on the School Scheduling 
Options screen, found under Synergy SIS > Mass Scheduling > Setup. From the 
Class Size Limit drop-down, select either Add Student, No Message to allow the 
student to be added without a warning message, Add Student, with Message to 
allow the student to be added but with a warning message, Don’t Add Student to 
not allow students to be added to classes when the limit is reached, or Require 
Password to require a password to add a student once the class limit is reached.  
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Figure 3.31 – School Scheduling Options screen 

 

The override can also be limited to certain users or user groups. On the Security 
Settings tab of either the User or User Groups screen, found under Synergy SIS > 
System > User.  In the for Allow Override of Max Students in Class field, select 
either Add Student, No Message to allow the student to be added without a 
warning message, Add Student, with Message to allow the student to be added 
but with a warning message, Don’t Add Student to not allow students to be added 
to classes when the limit is reached, or Require Password to require a password to 
add a student once the class limit is reached.  

 

 
Figure 3.32 - User Groups screen - Security Settings tab 
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Class size limits can also be overridden in Mass Scheduling during a scheduling and that is 
covered in Chapter 6.  

 
The School Scheduling Options screen defines the school-wide options for class sections. It 
also sets up the rules applied to student course requests and the Walk-In Schedule 
process. The options for the Walk-In Schedule process are mostly the same as those 
available for the Mass Scheduling process, as defined in the Schedule Control screen. 
Finally, the houses and teams used for the school schedule are also defined in this screen. 
 
To setup the options for the class sections:  

1. Go to the School Scheduling Options screen, found under Synergy SIS > Mass 
Scheduling > Setup. 

 
     Figure 3.33 – School Scheduling Options Screen 

2. When the maximum number of students allowed in a section has been reached, as 
defined by the Max number of students in the Student Seat Totals, the option 
selected from the Class Size Limit drop-down determines if the student can be 
added to the section anyway. If the student should not be added, select Don’t Add 
Student. If the student should be added, select Add Student, No Message, or Add 
Student, with Message. If the With Message option is selected, a pop-up appears 
that notifies the staff member that the class limit has been reached. This option 
works in conjunction with setting in the User or User Groups screen and at the 
district level, as explained in the previous section in this chapter. 

3. To set the number of characters that are used when creating the ID for each 
section, enter the number of characters in the Section ID Width box. This also limits 
the number of characters possible if manually creating the sections. 

4. If the sections will be created using the Mass Scheduling process, select how the 
section ID will be created by selecting the option to be used from the Auto 
Sequence drop-down list. If Manual is selected, the section ID will not be 
automatically created and must be manually entered. If Period and Counter is 
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selected, the section ID will start with the period number of the section followed by a 
sequential number based on the order in which the sections are created. If Course 
and Period is selected, the section ID will start with the Course ID followed by the 
period of the section. This option is only appropriate if there will never be two 
sections of a course taught in the same period. If Counter is selected, each section 
is assigned a sequential number starting with one for the first section created. If 
Course and Period and Counter is selected, the section ID will start with the 
Course ID, followed by the period of the section, followed by a sequential number 
starting with one for the first section created.  If Course and Counter is selected, 
the section ID matches the same sequence as the Master Schedule Builder.  The 
Section ID field is populated with the ID created during the Master Schedule Builder 
build process.  If Course and Manual is selected, the system generates a Course 
ID.  Then the user creates the Section ID and the generated Course ID is appended 
to it. 

5. When sections are deleted from a student’s schedule (instead of the student being 
withdrawn from the section), these sections are automatically deleted from the 
student’s record. If these sections should be retained for reporting purposes, check 
the Track Class Deletions for Add/Drop Report box. These classes will then be 
added to the Student Classes Deleted screen, and will be included in reports. 

6. To pop-up a warning if a manually entered section ID does not meet the character 
width requirements, check the Enable Section ID Validation Warnings box. This 
also produces a warning if the number of characters entered is not enough for the 
automatically calculated section ID option. 

7. If students will only receive grades for their homeroom class, check the Only Create 
Grade Records for Homeroom Section box. This is primarily used by elementary 
schools that want to track student participation in other classes, but have all grades 
issued by the homeroom teacher. 

8. The Include in Grading Option section of this screen determines when a class will 
be available for marks to be entered. For more information, please see the Synergy 
SIS – Grading Administrator Guide. 

9. The Meeting Days section of the screen sets up the number of different schedule 
days when using Period Rotation. For more information, please see the section on 
Period Rotation earlier in this chapter. 

10. When all of the options have been selected, click the Save button at the top of the 
screen to save the changes. 

  



Scheduling and Course Guide   Chapter Four 
 

84 Copyright© 2013 Edupoint Educational Systems, LLC 

The Course Requests & Walk-In Options apply to student requests entered in both 
the Schedule Request screen in Synergy SIS and the Course Request page in the 
PARENTVUE & STUDENTVUE software. These options also only apply to the Walk-In 
Schedule screen, and do not change the options used when mass scheduling students. 
To setup the options to be used for Course Requests and Walk-In Scheduling: 

1. Click on the Course Request and Walk-In Options tab of the School Scheduling 
Options screen, found under Synergy SIS > Mass Scheduling > Setup. 

 
Figure 3.34 – School Scheduling Options Screen, Course Request and Walk-In Options 

2. To allow the student to select a preferred teacher for a course, check the Show 
Teacher Preference box. The Use Teacher Preferences box under the Enforce 
the following rules section of the screen should also be selected to apply the 
preferences to the schedule. There are two options to select from when enforcing 
teacher preferences, Try and Must Have. 

3. If the student can select an alternate course to be used in case their primary course 
request cannot be scheduled, check the Show Alternate Course box. The Allow 
Alternate Course box under the Enforce the following rules section of the screen 
should also be selected to apply the preferences to the schedule. Only one alternate 
course can be selected for each course requested.  

4. If the student can be assigned to a house, check the Show House box. A House 
Option should also be selected under the Enforce the following rules section of the 
screen if this is checked. Select Automatic House Enforcement to assign students 
to sections with the same house assigned to both student and section. Selecting 
Match Sections with Houses tries to assign sections for each house that match 
each house’s course requests. If No House Enforcement is selected, houses are 
not used during the walk-in scheduling process, even if houses are assigned to 
students or sections. 

5. If the student can be assigned to a team, check the Show Team box. A Team 
Option should also be selected under the Enforce the following rules section of the 
screen. Select Automatic Team Enforcement to assign students to sections with 
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the same team assigned to both student and section. Selecting Match Sections 
with Teams tries to assign sections for each house that match each house’s course 
requests. If No Team Enforcement is selected, teams are not used during the walk-
in scheduling process, even if teams are assigned to students or sections. 

6. If the student can select a preferred term for each course, check the Show Term 
Preference box. The Check Term Preference box under the Enforce the following 
rules section of the screen should also be selected to apply the preferences to the 
schedule.  There are two options to select from when enforcing term preferences, 
Try and Must Have. 

7. If wheel definitions are used during the scheduling process, check the box labeled 
Using Wheels. 

8. To specify which students in a specific section qualify for alternate funding such as 
JTED in Arizona, check the Show Qualified Alternate Funding box. This adds an 
additional column to the Classes tab in Student screen, the Section screen, and the 
Student Classes screen where each student can be checked off as participating in 
an alternative funding program 

9. Enter the last date on which walk-in schedules may be created in the Walk-In Cut 
Off box. The date must be entered in the MM/DD/YY format, or it can be selected by 
clicking the Calendar  button. This is strictly for informational purposes and does 
not disable the Walk In Scheduling screen. 

10. Each course is assigned to a Term in the District Course screen, and some courses 
may not be offered every term. To allow student course request to override the 
default term assigned to the course and select a different term for the course, check 
the Show Term Override box. The term codes that can be used during the override 
process must also be added by clicking the Add button in the Override Term Codes 
section. Enter a number to indicate the order in which the code is displayed in the 
Term Code drop-down in the Screen Order column, and select the term code from 
the Override Term drop-down. The Check Term Override box under the Enforce 
the following rules section of the screen should also be selected to apply the 
preferences to the schedule. 

11. The Use Teacher Preferences box applies any teacher preferences indicated in 
student course requests to the schedule. Show Teacher Preference must be 
enabled as well.  There are two options to select from when enforcing teacher 
preferences, Try and Must Have 

12. To enforce the co-requisite requirements defined for each course in the District 
Course screen, check the Check Corequisites box. If the co-requisite course is not 
requested, the main course is not scheduled. 

13. Select how the pre-requisites defined for each course in the District Course screen 
will be checked from the Prerequisite Option drop-down list. To disregard the pre-
requisites during scheduling, select No Enforcement. If Full Enforcement (checks 
CHS) is selected, the student’s course history will be checked to verify the student 
has completed the pre-requisites successfully and does not schedule the course 
unless the pre-requisites are met. If Schedule Requests in Prereq Order is 
selected, course requests that are a pre-requisite for another request will be 
scheduled in the first term of the schedule. This option is useful when creating 
student schedules for an entire year or if student grades have not yet been posted 
to the student’s course history. For example, if both Pre-Algebra and Algebra are 
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requested and Pre-Algebra is a pre-requisite of Algebra, Pre-Algebra would be 
scheduled for the first semester and Algebra would be scheduled for semester 2. 

14. The Allow Alternate Course box applies any alternate course preferences to the 
schedule. Only one alternate course can be selected for each course requested. 
This takes the one-to-one course alternate, and does not affect the alternates for 
electives. Show Alternate Course should also be enabled for course requests. 

15. To limit the number of students that can be assigned to a section based on the 
capacity of the room assigned to the section (as entered in the School Room 
screen) instead of the seat limit assigned directly to the section, check the Use 
Room Seat Limit box. This is rarely used, since the class size for the section gives 
more flexibility to adjust class size based on the course or teacher. 

16. To include any term override options selected in course requests, Check Term 
Override should be enabled. Also, enable Show Term Override for course 
requests. 

17. To use a student’s term preference for a course in the schedule, enable Check 
Term Preference. Also, enable Show Term Preference for course requests.  
There are two options to select from when enforcing term preferences, Try and 
Must Have 

18. If some students should not be scheduled into the same class, a student restriction 
can be created in the Student Schedule screen covered in Chapter 5. To use these 
restrictions in scheduling, enable Check Student Restrictions. 

19. If a student should not be scheduled in a particular teacher’s class, a teacher 
restriction can also be setup in the Student Schedule screen covered in Chapter 5. 
To use this restriction in scheduling, enable Check Teacher Restrictions. 

20. A House Option should also be selected under the Enforce the following rules 
section of the screen if this is checked. Select Automatic House Enforcement to 
assign students to sections with the same house assigned to both student and 
section. Selecting Match Sections with Houses tries to assign sections for each 
house that match each house’s course requests. If No House Enforcement is 
selected, houses are not used during the walk-in scheduling process, even if houses 
are assigned to students or sections. 

21. A Team Option should also be selected under the Enforce the following rules 
section of the screen. Select Automatic Team Enforcement to assign students to 
sections with the same team assigned to both student and section. Selecting Match 
Sections with Teams tries to assign sections for each house that match each 
house’s course requests. If No Team Enforcement is selected, teams are not used 
during the walk-in scheduling process, even if teams are assigned to students or 
sections. 

22. If a student has requested a course twice, select how these duplicate requests will 
be handled from the Duplicate Course Request drop-down list. If Reject All 
Duplicates is selected, none of the duplicate course requests will be schedules. 
Selecting Schedule All of the Duplicates will schedule all duplicate courses, and 
selecting Schedule 1 of the Duplicates will schedule only one of the duplicate 
requests. This setting overrides the Duplicate Course Request setting for each 
course set in the District Course screen. 
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23. Max Time to Spend Per Student sets the maximum amount of time the scheduling 
process tries different scheduling options for each student. The amount entered is in 
seconds, and the default is .1 second. This should only be increased if a schedule 
conflict indicates that max time was the reason a student was not scheduled, and it 
should only be increased by .025 increments. 

24. When course requests are scheduled, the Course Request Sequence sets the 
order by which the requests are processed. Selecting By Course Request Priority 
and By Difficulty will schedule courses first by the Schedule Priority (Core or 
Elective) defined in the District Course screen and then by the difficulty of 
scheduling the section. By Difficulty only schedules courses in the order of 
difficulty. The difficulty is determined by the number of sections available for the 
course and the number of periods in which the course is offered. 

25. When assigning students to a section, the scheduling process can try to balance the 
demographics of the students in each section to create a diverse group of students 
in each section based on the Balance Option selected. The students in a section 
may be balanced by one of the following: Balance Property, Ethnicity, Gender, 
Gender and Balance Property, Gender and Ethnicity, or Total Students. The 
Balance Property is the district-defined set of values used for balancing students in 
classes in addition to the options pre-defined in Synergy SIS. This may be one or 
more values such as ELL or SPED or Home Language. The Balance Property is 
setup in the Lookup Table K12.MassScheduleInfo.User Balance. All of the options 
entered in this lookup table are used when the Balance Property is selected. The 
students are assigned the corresponding Balance Code in the Schedule Request 
screen. 

26. You can decide how pre-schedules should be handled when the course request has 
already been scheduled using the When a student is added to a Section and a 
Course Request exists but is already being used. Perform the following action 
field.  The options are Prompt with error, which is the default, Use existing 
Course Request that replaces the new request, or Create New Course Request.  

27. Click the Save button at the top of the screen to save the changes. 
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The House/Team/Exclusion options create the houses and teams that can be used in the 
scheduling process. For complete instructions on setting up houses and teams, see the 
chapter in this guide on Houses & Teams. These options also setup the Term Exclusions 
Codes. The Term Exclusion Codes are used to define a group of courses so that only one 
of the courses in the group may be taken in a term. For example, a school may have a rule 
that only one art course may be taken in a term. All of the Art course sections would then 
be assigned the same Term Exclusion Code so that only one of the Art courses would be 
scheduled in a given term. To setup a term exclusion for a group of courses: 

1. Click on the House/Team/Exclusion tab. 

 
Figure 3.35 – School Scheduling Options Screen, House/Team/Exclusion tab 

2. Click the Add button in the Term Exclusion Codes section of the screen. 

 
Figure 3.36 – Term Exclusion Codes Section 

3. Enter a Code for the group of courses, and enter a Description of the group. 

4. To add another group, click on the Add button again. To delete a group, check the 
box in the X column. 

5. Click the Save button at the top of the screen to save the changes. 
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After the code for the group of courses has been defined, the sections to be grouped need 
to be assigned the code. To assign the code for the section: 

1. Go to the Sched Section screen of an option set in Mass Scheduling. 

 
Figure 3.37 – Sched Section Screen 

2. Select the group code from the Term Exclusion drop-down list. 

3. Click the Save button at the top of the screen to save the changes. 
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SCHEDULE OVERLAP 
 
Another option can be set to determine how to check to see if a student’s course schedule 
is structured so that different sections overlap in the same period. This validation can be set 
at both the district level and the school level. To setup the schedule overlap validation at the 
district level: 

1. Go to the District Setup screen, found under Synergy SIS > System > Setup, and 
click on the System tab. 

 
Figure 3.38 – District Setup Screen 

2. Scroll to the bottom of the screen to the Other Options section. 

3. From the Validate Student Classes drop-down, select either Do Not Validate 
Student Classes to ignore any schedule overlap, Show Error and Do Not Allow 
Data to be Saved if Student Classes Overlap, or Show Warning and Allow Data 
to be Saved if Student Classes Overlap. 

4. Click the Save button at the top of the screen to save the changes. 
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To check for class overlap setting at the school level: 

1. Go to the School Setup screen, found under Synergy SIS > System > Setup. 

 
Figure 3.39 – School Setup Screen 

2. From the Validate Student Classes drop-down, select either Do Not Validate 
Student Classes to ignore any schedule overlap, Show Error and Do Not Allow 
Data to be Saved if Student Classes Overlap, or Show Warning and Allow Data 
to be Saved if Student Classes Overlap. 

3. Select the desired scheduling method from the Scheduling Options drop-down: 

• Traditional Schedule Tracking (default) – a section created for each 
course/period a teacher instructs and school office staff enrolls students in the 
appropriate sections manually or through mass scheduling. 

• Homeroom and Associated Course Enrollments – courses defined with 
associated courses (those courses expected to be taught by the homeroom 
teacher) in the District Course screen. Sections are created for homeroom and 
courses not taught by the homeroom teacher. School office staff enrolls 
students in the appropriate sections, manually or through mass scheduling. 
When the extract is generated, enrollment records are created for the sections 
in a student’s schedule as well as for those courses associated with the 
homeroom course. 

• Linked Sections – a section created for each course/period a teacher 
instructs and the Linked Teacher field is populated with the homeroom 
teacher name. When a student is enrolled in the homeroom section, an 
enrollment record is automatically created in all linked sections. 
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Note: When Linked Sections is selected, 
the Exclude From Link Section Process 
check box displays on the Section screen. 
If checked, the section will not be 
automatically added to a student's schedule 
when the homeroom section is added. 

 

4. Click the Save button at the top of the screen to save the changes. 

5. Change the focus and switch to another school in the district, and repeat the steps 
above. The validation must be set for each school in the district, or the district-level 
setting is applied. 
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ELEMENTARY SCHEDULING OPTIONS 
Depending on the type of scheduling option selected on the School Setup screen, 
additional setup may be required to properly assign and track homerooms and linked 
classes. 
 
To configure Homeroom and Associated Course Enrollments: 

1. Navigate to Synergy SIS > Course > District Course screen.  

2. On the Associated Courses tab, find the desired homeroom course record. 

 
3. Using the chooser, add the courses associated with this homeroom course. The 

homeroom teacher will be the teacher of record for these courses each time the 
extract is generated.  

4. Create sections for homeroom classes and any courses not taught by the 
homeroom teacher such as Physical Education or Music. (Please see Chapter 8 
for detailed instructions on creating sections.) 

5. Enroll students in the section for each course. (Please see Chapter 8 for 
detailed instructions on enrolling students in sections.)  

To configure Linked Sections: 

1. Navigate to Synergy SIS > Schedule > Section screen. 

2. Create sections for homeroom classes and leave the Linked Staff Name field blank. 
(Please see the Synergy SIS Scheduling Guide for detailed instructions on creating 
sections.) 

  

Note: Homeroom sections must be set to the period of the day as 
the Homeroom defined on the School Setup screen. 

  

3. Create sections for additional subjects taught. 

4. In each new section, enter the homeroom teacher name in the Linked Staff Name 
field by clicking on the arrow next to the field label. 
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Note: If the teacher of record will be the same as the homeroom 
teacher, leave the Linked Staff Name field blank. 

 

 
 

5. Enroll students in homeroom sections. (Please see Chapter 6 and Chapter 8 for 
detailed instructions on enrolling students in sections.) When the record is saved, 
an enrollment record will be created for each student in each of the linked classes 
with the same enrollment date as the homeroom record. 

 

 
 

  

Note: When Linked Sections is selected, the Exclude From 
Link Section Process check box displays on the Section 
screen. If checked, the section will not be automatically added 
to a student's schedule when the homeroom section is added. 
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WHEELS 
 
Wheels are used to define sets of courses that should be scheduled during the same year. 
For example, if sophomores should be scheduled for Algebra II, the wheel definition would 
include both the first semester and second semester courses for Algebra II. Or if a middle 
school wanted to schedule multiple electives for all the students in 7th grade, they might 
create a wheel that would include all of the electives. 
 
The wheels created in the Wheel Definition screen are used for both the Mass Scheduling 
process and the Walk-In Scheduling process. For walk-in scheduling, sections may also be 
mapped to each of the courses in the definition using the Walk-In Scheduling Wheel Def 
screen. To create a wheel definition: 

1. Go to the Wheel Definition screen, found under Synergy SIS > Scheduling > Setup. 

 
Figure 3.40 – Wheel Definition Screen 

2. Click the Add button at the top of the screen, and a new screen pops-up. 

 
Figure 3.41 – Adding a Wheel Definition 

3. Enter an abbreviation for the wheel in the Wheel ID box, and enter the full 
description of the wheel in the Name box. 

4. Click the Save button to save the new wheel. 

5. After the definition has been created, the courses associated with the wheel need to 
be added. To add the courses to the wheel, click the Chooser button. 

 
Figure 3.42 – Adding Courses to a Wheel 

6. The Chooser screen pops-up. Enter all or part of the Course ID and/or Course Title 
to be found, and click the Find button. A list of courses matching the criteria entered 
is listed in the Search Results grid. 
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Figure 3.43 – Chooser Screen, Find Results 

7. Click on a course to add, and it becomes highlighted in blue. To select multiple 
courses, hold down the Shift button and click on all the courses needed. Once all of 
the courses are selected, click the Add Selected Row(s)> button to add the 
courses to the Selected Items grid. To add all of the courses listed, click the Add All 
Row(s)>> button. 

 
Figure 3.44 – Chooser Screen, Selected Items 

8. Once all of the courses have been selected from the current search results, another 
Find can be conducted by entering different criteria and clicking the Find button. 
This can be repeated until all of the courses are listed in the Selected Items grid.  

9. Once all of the courses are listed, click the Select button to add them to the wheel. 

 
Figure 3.45 – Chooser Screen, All Items Selected 

10. The courses are added to the definition. To save the added courses to the definition, 
click the Save button at the top of the screen. 
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Figure 3.46 – Courses Added to the Wheel Definition 

11. To delete a course from the definition, click in the X column next to the course, and 
click the Save button at the top of the screen. 

 
 
To edit the Wheel ID or Name of an existing Wheel Definition: 

1. Click on the Menu button at the top of the screen. 

 
Figure 3.47 – Menu Options, Wheel Definition Screen 

2. Click on the Edit CourseWheel Data option. 

3. The Wheel ID and Name fields turn white and the text can then be edited. Make any 
changes and click the Save button at the top of the screen. 

 
 
To associate sections with the courses in a wheel to be used during Walk-In Scheduling: 

1. Go to the Walk-In Scheduling Wheel Def screen, found under Synergy SIS > 
Schedule > Setup. 

 
Figure 3.48 – Walk-In Scheduling Wheel Def Screen 

2. Find the wheel definition to edit using either the Scroll buttons or Find mode. 

3. Once the definition is found, click the Add button in the Option Grid to show the 
courses in the existing wheel definition. 

 
      Figure 3.49 – Walk-In Scheduling Wheel Def Screen, Wheel Definition 
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4. Enter a name to define the sections that will be assigned to the courses in the 
Option Name field, such as period 1. Multiple sets of sections may be defined as 
options for each wheel. 

 
Figure 3.50 – Walk-In Scheduling Wheel Def Screen, Option Added 

5. Click the Save button at the top of the screen to save the option. 

6. Click on the Show Detail button to screen the courses attached to the wheel. The 
courses display for the first option. To edit a different option, click on the Option 
Name in the left-hand side of the screen. The currently selected option is highlighted 
in blue. 

 
Figure 3.51 – Walk-In Scheduling Wheel Def Screen, Detailed Screen 

7. Click on the gray arrow in the Section ID column next to the course and the Find: 
Section screen pops-up. 

 
               Figure 3.52 – Find Section Screen 

8. Enter the criteria to be used to find the section in the fields in the Find Criteria 
section, and click the Find button at the top of the screen. The sections matching 
the criteria entered are listed in the Find Result section. Sections can be searched 
by Section ID, Begin Period, Term Code, Room Number, Max Students, Grade 
Range High, and/or Grade Range Low. 

 
Figure 3.53 – Find Section Screen, Find Results 
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9. Click on the section to be assigned to the course, and click the Select button at the 
top of the screen. The section ID displays in the Section ID column. 

 
Figure 3.54 – Walk-In Scheduling Wheel Def Screen, Sections Added 

10. Save the section assignments for the highlighted option by clicking on the Save 
button at the top of the screen. To return to the main screen of the screen, click the 
Hide Detail button. 

11. To delete a set of section assignments, click in the box in the X column next to the 
option name and click the Save button at the top of the screen. 

 
Figure 3.55 – Walk-In Scheduling Wheel Def Screen, Deleting 
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TEACHER AIDES 
 
If students will be teacher aides in courses, the best way to record teacher aide 
participation is by creating a generic teacher aide district course. By using this generic 
course, it is not necessary to create a duplicate section for every course that has a teacher 
aide, but it will still record the student’s participation as a teacher aide in the student’s 
grading record and course history. 
 
To setup a generic Teacher Aide course: 

1. Create a District Course using the instructions in the District Course section in this 
chapter. Be sure to check the option Teacher Aide. 

 
Figure 3.56 – District Course Screen, Teacher Aide Course 

2. The schools offering teacher aide positions must opt-in to the Teacher Aide course, 
as outlined in the School Course Opt-In section in this chapter. 

 
Figure 3.57 – School Course Screen, Teacher Aide Course 

3. In the School Setup screen, add the course created as the generic Teacher Aide 
course for the school by clicking on the gray arrow next to Course ID. 
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Figure 3.58 – School Setup Screen, Generic Teacher Aide Course 

4. Select the amount of credit the student will earn as a teacher’s aide from the Credit 
Given drop-down. They can either earn the credit assigned to the section in which 
they are a TA (From Section Credit), a percentage of this credit (Percent of 
Section Credit), or a fixed amount (Fixed Credit Value). If percentage is selected, 
enter the Percent in whole number (20 instead of .20). If a fixed amount is selected, 
enter the Credit amount to be assigned. 

5. Assign the student to the regular course section of the class in which they will be a 
teacher aide, using either the Sched Section screen in Mass Scheduling or the 
Section screen during regular scheduling. Check the Teacher Aide box to indicate 
that the student is a teacher aide. This removes the student from the Student Seat 
Totals. Also, add the number of teacher aides for the course in the Max box in the 
Teacher Aide Totals section. 
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Figure 3.59 – Section Screen, Section with Teacher Aide 

 
If the student has been designated as a teacher’s aide, the Student Classes and Student 
Grades screen display the section number for the course in which the student is an aide but 
the Course ID and Course Name display the id and name of the Teacher Aide course. The 
grade transferred to Student Course History will also be for the Teacher Aide course. 

 
                                Figure 3.60 – Student Classes Screen 

  

Note: This is only for teacher aides in a specific course. Separate 
courses must be setup for other types of aides such as office 
aides that are not associated with a course. 
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AUDIT CLASSES 
 
If students at your school or district have the option to take a class without receiving course 
credits or having the grades count towards their GPA, they can be flagged as audited 
classes.  When the ability to audit classes is set up, a checkbox to indicate the student is 
auditing a class displays on the Student Classes screen, the Student screen, the Student 
Course History screen, and the Section screen. After tagging the student class record as 
audited the regular processes for scheduling, grading, updating course history, and printing 
transcripts. 
 
To allow audited classes: 

1. Go to the District Setup screen, found under Synergy SIS > Schedule > Setup. 

 
Figure 3.61 – District Course Screen, Teacher Aide Course 

2. On the System tab, select the Allow student classes to be flagged as audited 
checkbox to enable the audit class functionality.   

3. Enter the code that will print on reports next to the audited classes in the Audit 
Symbol filed. The symbol can be up to four characters long. 

4. Select where to show the audit symbol in the Show Audit Symbol After field.  The 
selections are Course ID or Course Title.  

5. Click Save. 
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SECTION LOCK 
Sections are locked by default one the term has started.  Users cannot change the term 
code, period begin or end dates, course ID, or meeting days after the term has started.  
This feature an be disengaged on the District Setup screen. 
 

 

Caution – Edupoint does not recommend turning off the section lock 
feature.  Turning off this feature can cause duplications when running the 
Update Grade process, and generate various errors with the Update Grades 
and Update Course History Proceses. 

 

1. Go to the District Setup screen, found under Synergy SIS > Schedule > Setup. 

 
Figure 3.62 – District Course Screen, Other Options 

2. On the System tab, select the Disable Section Locking checkbox allow changes to 
the section after the term has started.   

3. Click Save. 
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Chapter Four:
HOUSES & TEAMS 

 
 
 
 
 
 
 
 
 
 
 
 

In this chapter, the following topics are covered: 
 What are Houses & Teams 
 How to create Houses & Teams 
 How to assign Houses & Teams to students 
 How to assign Houses & Teams to sections 
 How to define period restrictions for a house or team 
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WHAT ARE HOUSES & TEAMS? 
 
Houses and teams are used to keep groups of students together in the same sections or 
keep sections assigned the same teacher or period. Houses are used to group students 
together so they can be scheduled in the same sections. This is helpful for students that 
have scheduling constraints such as ROTC or sports team members, or it can be used to 
keep students together that have similar academic schedules such as AP. Teams are used 
to assign sections to the same teacher, room, or period throughout the academic year. 
 
Both students and sections can be assigned to teams and houses. Each student and each 
section may only have one house and one team. Teams and houses must be evenly 
matched, meaning that they must have the same number of sections assigned and the 
same number of seats in each section throughout the academic year.  
 
Students may be mass assigned to houses and teams using the Mass Assign House and 
Team screen, or they may be individually assigned to houses and teams using either the 
Schedule Request screen or the Walk-In Schedule screen. Once a student has been 
assigned to a house and/or a team, course requests may be assigned to students in bulk 
using these house and team assignments. 
 
Sections may be assigned to teams within the Schedule Section screen from the selected 
Option Set in the Schedule Control screen. All sections assigned to a house must be 
assigned to the same house. 
 
When houses are used during the scheduling process, they can be processed by one of the 
following methods. The method used is selected in the option set in the Schedule Control 
screen, or on the Course Request and Walk-In Options tab of the School Scheduling 
Options screen for walk-in scheduling. 

• Automatic House Enforcement - Students may or may not have been 
assigned a Team in the Student Schedule. If a student is manually assigned to a 
house in Student Schedule, houses are exactly matched with the student 
assigned house.  If a house is not manually assigned to a student in Student 
Schedule, the schedule tries different house assignments until a positive 100% 
schedule is reached for the student to a section-defined house. If a section does 
not have a house assignment, then the student can be placed into that section. 

• Match Sections with Houses - This option matches sections with the House 
that is assigned to students within Student Schedule, and is best used when 
students have been assigned a House in the Student Schedule.  Houses are not 
assigned to students during a schedule run. Any course that is requested that 
has any section with a house assigned in that section then forces a house match 
from the student to a matching section. If none are found, the reject type will be 
house restriction. 

• No House Enforcement - Students may be assigned to a House and sections 
may be assigned to a House, but the scheduling process does not use the 
house assignments when calculating the schedule. 

When teams are used during the scheduling process, they can be processed by one of the 
following methods. The method used is selected in the option set in the Schedule Control 
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screen, or on the Course Request and Walk-In Options tab of the School Scheduling 
Options screen for walk-in scheduling. 

• Automatic Team Enforcement - Students may or may not have been assigned 
a Team in the Student Schedule. If a student is manually assigned to a team in 
Student Schedule, teams are exactly matched with the student assigned team. If 
a team is not manually assigned to a student in Student Schedule, the schedule 
tries different team assignments until a positive 100% schedule is reached for 
the student to a section-defined team. If a section does not have a team 
assignment then the student can be placed into that section 

• Match Sections with Teams - All Team Logic is used. This actively enforces 
assigning sections with the same Team code that is assigned to a student. 
Students may be scheduled into multiple teams. All sections of the teamed 
courses must be assigned a team code. Students will be scheduled into the first 
team available for their schedule if they are not assigned to a team in Schedule 
Request. Students who are assigned to a team (through their Schedule 
Request) will be scheduled into that team. 

• No Team Enforcement - Teams will not be considered during the scheduling 
run. Any team assignments will not be used. 

 
Students assigned to a team are scheduled in that team depending upon availability. 
Students not assigned a team are scheduled in the first team available for their schedule.  
 
Possible Schedule Rejections for Teams:  

• Full - Other students are scheduled in the sections, or the seat count or max 
total is not even for all the sections within the team. 

• Team – Sections are not evenly teamed, teams are not defined correctly, or, 
depending upon the team option selected, the teams may not be defined evenly 
by teacher, room, and period. 

Students may be scheduled in one section of the team and not the other if sections are not 
available for the other course within the team or if sections are not evenly created for all 
courses within the team. 
 
 

  



Scheduling and Course Guide   Chapter Four 
 

108 Copyright© 2013 Edupoint Educational Systems, LLC 

CREATING HOUSES AND TEAMS 
 
Teams and Houses are defined for each school in the School Scheduling Options screen. 
To create houses and teams: 

1. Go to the School Scheduling Options screen, found under Synergy SIS > Mass 
Scheduling > Setup. 

2. Click on the House/Team/Exclusion tab. 

 
Figure 4.1 – School Scheduling Options Screen 

3. To create a new house, click on the Add button in the House Codes section. 

 
Figure 4.2 – School Scheduling Options Screen, Adding a House Code 

4. Enter a Code for the house, and enter the full name for the house in the 
Description column. 

5. To remove a house code, click the box in the X column next to the code. 

6. To save the changes to the house codes, click the Save button. 

7. To create a new team, click the Add button in the Team Codes section. 

 
Figure 4.3 – School Scheduling Options Screen, Adding a Team 

8. Enter a Code for the Team, and enter the full name for the team in the Description 
column. 

9. Select the option to be used for the team from the Option drop-down list. Teams can 
Keep Same Period, Keep Same Room, Keep Same Teacher, or Keep Same 
Period and Teacher. 
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Figure 4.4 – School Scheduling Options Screen, Team & House Codes 

10. To remove a team code, click the box in the X column next to the code. 

11. To save the changes to the team codes, click the Save button. 
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INDIVIDUALLY ASSIGN HOUSE AND TEAM 
 
To assign a house or a team to a student using the Schedule Request screen: 

1. Go to the Schedule Request screen, found under Synergy SIS > Mass Scheduling. 

2. Click on the Options tab. 

 
Figure 4.5 - Schedule Request Screen, Options Tab 

3. Select the House from the Schedule House drop-down list, and select the Team 
from the Schedule Team drop-down list. 

4. To not use the house or team assignment during the scheduling process for this 
student, check the boxes for either Exempt House or Exempt Team. 

5. Click the Save button at the top of the screen to save the changes. 

 
To assign a house or a team to a student using the Walk-In Schedule screen: 

1. Go to the Walk In Schedule screen, found under Synergy SIS > Mass Scheduling. 

 
Figure 4.6 – Walk In Schedule Screen 
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2. On the Request tab, scroll to the bottom of the screen. Select the House from the 
Schedule House drop-down list, and select the Team from the Schedule Team 
drop-down list. 

3. To not use the house or team assignment during the scheduling process for this 
student, check the boxes for either Student Exempt from House Restriction or 
Student Exempt from Team Restriction. 

4. Click the Save button at the top of the screen to save the changes. 
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MASS ASSIGN HOUSE AND TEAM 
 
To assign students to a house or team by groups of students: 

1. Go to the Mass Assign House and Team screen, found under Synergy SIS > Mass 
Scheduling. 

 
Figure 4.7 – Mass Assign House And Team Screen 

2. Select either the House or Team to assign from the drop-down lists. Each house 
and team should be processed separately. To clear all current assignments, select 
the Clear All option. 

3. To only update students who have not been assigned a house or team, check the 
box by House or Team labeled Modify Only if Blank. To override the existing 
assignments, leave these boxes blank. 

4. Period restrictions can restrict the mass scheduling process from scheduling 
students during certain periods. For more information about period restrictions, 
please refer to the section in this chapter on Period Restrictions. 

5. The house or team can be assigned by grade level using the Grade Filter. To select 
which grades to assign to the house, check the boxes next to the Grades or use the 
Check All  boxes to check/uncheck all of the grades. Click the Include option 
to include the selected grades in the assignment, or click the Exclude option to 
assign the house or team to all grades except those selected. If grades will not be 
used to filter the assignment, click Not Used. 

6. The assignments can also be filtered by gender. Select the gender of the students 
to be assigned from the Gender drop-down. 

7. Specific students can also be selected for assignment by clicking the Chooser 
button in the Students section. 

8. The Chooser screen pops-up. Enter the information known about the students to be 
assigned in the Find Criteria section, and click the Find button at the top of the 
screen. The students may be found using any part of the criteria, including last 
name, first name, middle name, perm ID, grade or gender. Partial information may 
be used as well, such as the first letters of a last name or first name. 
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Figure 4.8 – Chooser Screen, Results 

9. Once the Find button is clicked, a list of students that match the criteria appears in 
the Search Results section. Click on the name or names of the student(s) to add 
and click the Add Selected Row(s) button to add the student(s) to the Selected 
Items section. Multiple searches may be made until all students have been found 
and added to the Selected Items section. Multiple rows may be selected by holding 
down the Ctrl key and clicking on all the students needed. To remove a student from 
the Selected Items section, click the box under X column. To add all of the students 
found in the Search Results list to the Selected Items section, click the Add All 
Row(s) button. 

 
Figure 4.9 – Chooser Screen, Selected Items Section 

 

10. Once all of the students to be assigned have been selected, click the Select button 
at the top of the screen to add them to the assignment. 
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Figure 4.10 – Mass Assign House and Team, Students Added 

11. Student assignments can also be further refined using custom filters by clicking on 
the Additional Filters tab. 

 
Figure 4.11 – Mass Assign House And Team, Additional Filters Tab 

12. To add another filter, click on the Add button. 

13. Select the Property to be used to filter the assignments. Properties are student 
values such as city or birth date. 

14. The Not and Operator fields work together. Select how to evaluate the value from 
the Operator field. It can be Contains, Ends With, Equal To, Greater or Equal, 
Greater Than, In List, Less Than, Less Than or Equal, or Starts With. If Not is 
select, it excludes all the records that match the selected operator. For example, if 
the condition is that all records must contain the value entered, when not is selected 
the filter will use all records that do NOT contain the value entered. 

15. Enter the value to be compared against the records in the Property in the Value 
column. For example, if the filter is assigning a house to all students from a specific 
city, the Property would be set to City, the Operator would be set to Contains (in 
case of inexact data entry), and the Value would be the city name. 

16. Once all of the criteria for assignment have been entered into the screen, click the 
Assign button at the top of the screen to assign the house or team to the students. 

 
Figure 4.12 – Mass Assign House and Team Screen 
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ASSIGNING HOUSES & TEAMS TO SECTIONS 
 
Before Houses & Teams can be assigned to sections, the Option Set must be run as 
outlined in Chapter 6. To assign Houses & Teams to sections: 

1. Go to the Schedule Control screen, found under Synergy SIS > Mass Scheduling. 

2. Click on the icon for the Option Set to be used. 

 
Figure 4.13 – Schedule Control Screen 

 

Note – If another user has checked out the option set, you cannot edit 
sections unless the Allow unchecked out users to edit sections check 
box is selected. 

 

3. Click on the Open Schedule Section link. 

 
Figure 4.14 – Schedule Option Set Screen 
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4. In the Sched Section screen that pops-up, find the sections to be assigned using 
either the Scroll buttons or Find mode.  

 
Figure 4.15 – Sched Section Screen 

5. Once the section to be assigned is found, select the House and/or Team from the 
drop-down lists. 

 
Figure 4.16 – Sched Section Screen, Adding House & Team 

6. Click the Save button to save the assignment. Repeat these steps for every section 
that needs to be assigned a house and/or a team. 
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PERIOD RESTRICTIONS 
 
Occasionally, there may be students or a group of students that cannot be scheduled 
during certain periods. For example, perhaps students participating in a work-study 
program may need to have the afternoons off to participate in their work program. To 
restrict the mass scheduling process from assigning classes to those students during those 
periods, period restrictions can be assigned to these students. 
 
To set the period restriction for a group of students or for all students: 

1. Go to the Mass Assign House and Team screen, found under Synergy SIS > Mass 
Scheduling. 

 
Figure 4.17 – Mass Assign House And Team Screen 

2. In the Period Restrictions section, select the earliest period in which the students 
can be scheduled from the Low Period drop-down list. 

3. Select the latest period in which the students can be scheduled from the High 
Period drop-down list. 

4. To only update students who have not been assigned a house or team, check the 
box by House or Team labeled Modify Only if Blank. To override the existing 
assignments, leave these boxes blank. 

5. The restrictions can be assigned by grade level using the Grade Filter. To select 
which grades to restrict, check the boxes next to the Grades or use the Check All 

 boxes to check/uncheck all of the grades. Click the Include option to include 
the selected grades in the restrictions, or click the Exclude option to assign the 
restrictions to all grades except those selected. If grades will not be used to filter the 
restrictions, click Not Used. 

6. The restrictions can also be filtered by gender. Select the gender of the students 
from the Gender drop-down. 
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Figure 4.18 – Mass Assign House And Team Screen 

7. Specific students can also be selected by clicking the Chooser button in the 
Students section. 

8. The Chooser screen pops-up. Enter the information known about the students in the 
Find Criteria section, and click the Find button at the top of the screen. The students 
may be found using any part of the criteria, including last name, first name, middle 
name, perm ID, grade or gender. Partial information may be used as well, such as 
the first letters of a last name or first name. 

 
Figure 4.19 – Chooser Screen, Results 

9. Once the Find button clicked, a list of students that match the criteria appears in the 
Search Results section. Click on the name or names of the student(s) to add and 
click the Add Selected Row(s) button to add the student(s) to the Selected Items 
section. Multiple searches may be made until all students have been found and 
added to the Selected Items section. Multiple rows may be selected by holding 
down the Ctrl key and clicking on all the students needed. To remove a student from 
the Selected Items section, click the box under X column. To add all of the students 
found in the Search Results list to the Selected Items section, click the Add All 
Row(s) button. 
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Figure 4.20 – Chooser Screen, Selected Items Section 

10. Once all of the students have been added to the Selected Items section, click the 
Select button at the top of the screen. 

 
Figure 4.21 – Mass Assign House and Team, Students Added 

11. The process can also be further refined using custom filters by clicking on the 
Additional Filters tab. 

 
Figure 4.22 – Mass Assign House And Team, Additional Filters Tab 

12. To add another filter, click on the Add button. 

13. Select the Property to be used to filter the assignments. Properties are student 
values such as city or birth date. 

14. The Not and Operator fields work together. Select how to evaluate the value from 
the Operator field. It can be Contains, Ends With, Equal To, Greater or Equal, 
Greater Than, In List, Less Than, Less Than or Equal, or Starts With. If Not is 
select, it excludes all the records that match the selected operator. For example, if 
the condition is that all records must contain the value entered, when not is selected 
the filter will use all records that do NOT contain the value entered. 
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15. Enter the value to be compared against the records in the Property in the Value 
column. For example, if the filter is assigning a house to all students from a specific 
city, the Property would be set to City, the Operator would be set to Contains (in 
case of inexact data entry), and the Value would be the city name. 

16. Once all of the criteria for the students have been entered into the screen, click the 
Assign button at the top of the screen to assign the period restrictions to the 
students. 

 
Figure 4.23 – Mass Assign House and Team Screen 

 
 
To set the period restrictions for an individual student using the Schedule Request screen: 

1. Go to the Schedule Request screen, found under Synergy SIS > Mass Scheduling. 

2. Click on the Options tab. 

 
Figure 4.24 - Schedule Request Screen, Options Tab 

3. Select the earliest period in which the student can be scheduled from the Low 
Period drop-down list. 

4. Select the latest period in which the student can be scheduled from the High Period 
drop-down list. 

5. Click the Save button at the top of the screen to save the changes. 
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To set the period restrictions for an individual student using the Walk-In Schedule screen: 

1. Go to the Walk In Schedule screen, found under Synergy SIS > Mass Scheduling. 

  
Figure 4.25 – Walk In Schedule Screen 

2. On the Request tab, scroll to the bottom of the screen. Select the earliest period in 
which the student can be scheduled from the Low Period drop-down list. 

3. Select the latest period in which the student can be scheduled from the High Period 
drop-down list. 

4. Click the Save button at the top of the screen to save the changes. 
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Chapter Five:
COURSE REQUESTS 

 
 
 
 
 
 
 
 
 
 
 
 

In this chapter, the following topics are covered: 
 The three methods for entering course requests 
 How to mass assign course requests 
 How to individually assign course requests 
 How students and parents can make their own course requests 

 



Chapter Five   Scheduling and Course Guide 
 

Copyright© 2013 Edupoint Educational Systems, LLC 123 

Course requests can be entered into Synergy SIS three ways. They can be assigned to 
students in bulk based on a student’s gender, grade level, house, or team using the Mass 
Assign Course Requests screen. Requests can also be entered individually for each 
student using the Schedule Request screen. Finally, students and parents can make course 
requests using the PARENTVUE & STUDENTVUE software. 
 
Mass assignment is generally used when the majority of students in a grade are required to 
take a set of core courses. It can also be used to assign a set of courses to a group of 
students based on grade, gender, house, or team. If a course is discontinued in the midst of 
the scheduling process or replaced by a different course offering, the mass assignment 
function can quickly correct all requests for the discontinued or changed course. 
 
Entering requests for an individual student is helpful when students are allowed a choice of 
required or elective courses. Editing course requests is also most easily done on an 
individual student basis. 
 
If the school or district is using the PARENTVUE & STUDENTVUE software, students can 
enter their selection of electives themselves, which can increase data accuracy and reduce 
the data entry required by staff. 
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MASS ASSIGN COURSE REQUESTS 
 
To mass assign course requests: 

1. Go to the Mass Assign Course Requests screen, found under Synergy SIS > Mass 
Scheduling. 

 
              Figure 5.1 – Mass Assign Course Requests Screen 

2. Click the Add button to define a group of courses that can be assigned to students. 
These groups are available for every school year and can be re-used each year. 

3. A new Mass Assign Course Requests screen pops-up. Enter a Name for the group 
of courses. 

 
Figure 5.2 – Mass Assign Course Requests Screen, Adding 

4. To also define this group of courses as a Quick Assign Group, check the box 
labeled Include in Quick Assign Groups. Quick Assign Groups can be used with 
the Schedule Request, Schedule Student, and Walk-In Schedule views to quickly 
assign a group of courses to an individual student.  
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5. The Allow Duplicate Course Requests box allows this group to assign duplicates 
The log notes which duplicates have been assigned. 

 

Note – The duplicate course request comparison is based on what 
courses the student is currently assigned. Duplicate course requests 
can still be assigned to students at one time without selecting this 
option if the student does not have the course to add as an existing 
request. 

 

6. Click the Save button to save the new group. 

7. To add the courses, click the Chooser button in the Courses To Add section. 

8. To search for the course by the course ID or the course title, enter this information in 
the appropriate fields of the Find Criteria section and click the Find button. 

9. All courses matching the search criteria entered appear in the Find Result grid. 

 
Figure 5.3 – Chooser Screen, Find Result Grid 

10. If the desired course is not shown in the first grid, click a page number at the bottom 
of the Find Result grid to display the next page of courses. 

11. Click the Line number of the row containing the desired course. The course is 
highlighted. 

12. Click the Add Selected Row(s)> button. 

13. The course is moved from the Find Result grid to the Selected Items grid. Multiple 
courses may be selected by continuing to highlight the courses and clicking the Add 
Selected Rows button. To select multiple courses, on the same page, at the same 
time, hold down the Ctrl key while clicking and highlighting the courses. To add all 
courses listed, click the Add All Row(s)>> button. 
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Figure 5.4 – Chooser Screen, Selected Items Grid 

14. When all of the courses have been added to the Selected Items grid, click the 
Select button at the top of the screen and the courses will be added to the group. 

 
Figure 5.5 – Mass Assign Course Requests Screen, Courses Added 

15. To select a specific term for which the course should be assigned, select it from the 
Preferred Term drop-down list. 

16. To lock the courses so that students or parents cannot remove the course from the 
request list in the ParentVUE & StudentVUE software, check the Lock box. 

17. If the pre-requisite courses defined in the District Course screen for each course 
should not be enforced, check the box Pre-req Not Required. 

18. Click the Save button at the top of the screen to save the course group. 

19. To delete a course from the list, check the box in the X column and click the Save 
button at the top of the screen. To delete an entire group, first delete all of the 
courses then click the Delete button at the top of the screen. 
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Once the group of courses has been created, the next step is to select the criteria used to 
assign the courses to students. Students may be selected by gender, grade, house, or 
team, or individual students may be selected. All selected filters are added together, so the 
students assigned must match all criteria entered. To select the filter options: 

1. On the Mass Assign tab of the screen, courses may be assigned by Gender by 
selecting the student’s gender from the drop-down list.  

2. To assign courses by grade level, check the boxes next to the Grades or use the 
Check All  boxes to check/uncheck all of the grades. Click the Include option 
to include the selected grades in the assignment, or click the Exclude option to 
assign the house or team to all grades except those selected. If grades will not be 
used to filter the assignment, click Not Used. 

3. To assign courses by house, check the boxes next to the House or use the Check 
All  boxes to check/uncheck all of the houses. Click the Include option to 
include the selected houses in the assignment, or click the Exclude option to assign 
the course to all houses except those selected. If houses will not be used to filter the 
assignment, click Not Used. 

4. To assign courses by team, check the boxes next to the Team or use the Check All 
 boxes to check/uncheck all of the teams. Click the Include option to include 

the selected teams in the assignment, or click the Exclude option to assign the 
course to all teams except those selected. If teams will not be used to filter the 
assignment, click Not Used. 

5. To assign courses by ELL Status, check the boxes next to the ELL_Level or use 
the Check All  boxes to check/uncheck all of the ELL Levels. Click the Include 
option to include the selected ELL Levels in the assignment, or click the Exclude 
option to assign the course to all ELL Levels except those selected. If ELL Levels 
will not be used to filter the assignment, click Not Used. 

6. To assign courses by Gate Status, check the boxes next to the Gate Code or use 
the Check All  boxes to check/uncheck all of the Gate Codes. Click the 
Include option to include the selected Gate Codes in the assignment, or click the 
Exclude option to assign the course to all Gate Codes except those selected. If 
Gate Codes will not be used to filter the assignment, click Not Used. 

7. To assign courses by Student Group, check the boxes next to the Student Group 
or use the Check All  boxes to check/uncheck all of the Student Groups. Click 
the Include option to include the selected Student Groups in the assignment, or 
click the Exclude option to assign the course to all Student Groups except those 
selected. If Student Groups will not be used to filter the assignment, click Not Used. 

8. To assign courses by Special Ed Student Services, check the boxes next to the 
Special Ed Student Services or use the Check All  boxes to check/uncheck 
all of the Special Ed Student Services. Click the Include option to include the 
selected Special Ed Student Services in the assignment, or click the Exclude option 
to assign the course to all Special Ed Student Services except those selected. If 
Special Ed Student Services will not be used to filter the assignment, click Not 
Used. 

9. Click the Save button at the top of the screen to save the changes. The filter options 
entered are not used when using the Quick Assign Groups function in other views. 
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10. To assign the group of courses to specific students, click on the Selected Students 
tab. 

 
Figure 5.6 – Mass Assign Course Requests Screen, Selected Students Tab 

11. Click the Chooser button to select the students, and the Chooser screen pops-up. 

12. Enter the information known about the students in the Find Criteria section, and click 
the Find button at the top of the screen. The students may be found using any part 
of the criteria, including last name, first name, middle name, perm ID, grade or 
gender. Partial information may be used as well, such as the first letters of a last 
name or first name. 

 
Figure 5.7 – Chooser Screen, Results 

13. Once the Find button clicked, a list of students that match the criteria appears in the 
Search Results section. Click on the name or names of the student(s) to add and 
click the Add Selected Row(s) button to add the student(s) to the Selected Items 
section. Multiple searches may be made until all students have been found and 
added to the Selected Items section. Multiple rows may be selected by holding 
down the Ctrl key and clicking on all the students needed. To remove a student from 
the Selected Items section, click the box under X column. To add all of the students 
found in the Search Results list to the Selected Items section, click the Add All 
Row(s) button. 
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Figure 5.8 – Chooser Screen, Selected Items Section 

14. To add a student condition filter, click Add on the Student Condition Filter grid. A 
new line is added to the grid. 

 
Figure 5.9 – Mass Assign Course Requests Screen, Student Condition Filter grid 

15. Select a Property Name, an Operator, and a Value in the new row. 

16. Click Save.   

 

Note – The selections made in the Student Condition Filter grid are 
applied in addition to any filters and conditions set on the Mass 
Assign tab of the Mass Assign Course Requests screen. The filters 
and conditions set on the Mass Assign tab are applied first, and the 
filter set in the Student Condition Filter is applied to the results. 

 

17. Once all of the students to be assigned have been selected, click the Select button 
at the top of the screen to add them to the Selected Students section.  
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Figure 5.10 – Mass Assign Course Requests Screen, Selected Students Tab 

18. Click the Save button at the top of the screen to save the students. To remove a 
student from the list, check the box in the X column. 

19. To run the assignment once all of the filter options have been selected, click the 
Replace Courses button at the top of the screen. 

 
Figure 5.11 – Mass Assign Course Requests Screen 

 
 
To include a description of the course grouping to help others understand the purpose of 
the group: 

1. Click on the Other Info tab. 

 
Figure 5.12 – Mass Assign Course Requests Screen, Other Info Tab 



Chapter Five   Scheduling and Course Guide 
 

Copyright© 2013 Edupoint Educational Systems, LLC 131 

2. Enter a description of the group in the Description box. The description may also 
be checked for spelling by clicking the Spell Check  button. 

3. Click the Save button at the top of the screen to save the changes. 

To replace an existing course request with a new course: 

1. Create a new course request group as outlined above. 

2. Select the new course using the Chooser screen in the Courses to Add section. 

 
Figure 5.13 – Mass Assign Course Requests Screen, Replacing Courses 

3. Select the course to be removed using the Chooser screen in the Courses To Find 
and Replace section. 

4. Click the Replace Courses button at the top of the screen. 
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INDIVIDUALLY ASSIGN COURSE REQUESTS 
 
Courses can be assigned for individual students in several locations: the Schedule Request 
screen, the Student Schedule screen with the option set in the Schedule Control screen, 
and the Walk-In Schedule screen. The options available for course assignment in these 
views are based on the configuration selected on the Course Request and Walk In Options 
tab of the School Scheduling Options screen. For more information about the School 
Scheduling Options screen, please refer to the section in Chapter 3 of this guide.  
 
To modify an individual student’s course requests using the Schedule Request screen: 

1. Go to the Schedule Request screen, found under Synergy SIS > Mass Scheduling. 

  
Figure 5.14 – Schedule Request Screen 

2. To assign the student all of the courses included in a Quick Assign Group, select the 
group name from the Add By Group drop-down list. 

3. To add courses manually, click the Chooser button. 

4. To search for the course by the course ID or the course title, enter this information in 
the appropriate fields of the Find Criteria section and click the Find button. 

5. All courses matching the search criteria entered appear in the Find Result grid. 
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Figure 5.15 – Chooser Screen, Find Result Grid 

6. If the desired course is not shown in the first grid, click a page number at the 
bottom of the Find Result grid to display the next page of courses. 

7. Click the Line number of the row containing the desired course. The course is 
highlighted in blue. 

8. Click the Add Selected Row(s)> button. 

9. The course is moved from the Find Result grid to the Selected Items grid. Multiple 
courses may be selected by continuing to highlight the courses and clicking the Add 
Selected Rows button. To select multiple courses at a time, hold down the Ctrl key 
while clicking and highlighting the courses. To add all courses listed, click the Add 
All Row(s)>> button. 

 
Figure 5.16 – Chooser Screen, Selected Items Grid 

10. When all of the courses have been added to the Selected Items grid, click the 
Select button at the top of the screen and the courses are added to the Course 
Requests grid. 
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Figure 5.17 – Schedule Request Screen 

11. If the student can select in which term they would like to take the course, select the 
Preferred Term from the drop-down list. 

12. To allow the student to attend the class for a term other than the one indicated in the 
sections created in the master schedule, select the term from the Term Override 
drop-down list. 

13. If the student is repeating the course, select the reason they need to repeat it from 
the Repeat Tag drop-down list. 

14. If a teacher preference can be indicated, click on the gray arrow in the Teacher 
column and select a teacher using the Find Staff screen. 

15. To select a course to be used in the schedule if the selected course will fit the 
student’s schedule, click on the gray arrow in the Alternate Course column and 
select a course using the Find Course screen. 

16. If the pre-requisite courses defined in the District Course screen for each course 
should not be enforced, check the box in the Pre-Req Not Required column. 

17. To prevent the student or parent from changing the requested course in the 
PARENTVUE & STUDENTVUE software, check the box in the Course Request Lock 
column. 

18. Several courses may also be added to the Alternates for Electives section using 
the Chooser screen as outlined above. 

 
Figure 5.18 – Alternates for Electives 
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19. Once the Alternate courses have been added, indicate the order in which the 
courses should be used in the Preferred Priority column. 

20. Click the Save button at the top of the screen to save the changes. 

21. Additional options may be set on the Options tab of the Schedule Request screen. 

 
Figure 5.19 – Schedule Request Screen, Options Tab 

22. The Low Period and the High Period indicates the Period Restrictions to be used 
when scheduling the student. The Schedule House and Schedule Team options, 
as well as the Exempt House and Exempt Team boxes, control the house and 
team options used. For more information about these options, please see Chapter 4 
in this guide. 

23. The Balance Code is the district-defined set of values used for balancing students 
in classes in addition to the options pre-defined in Synergy SIS. This may be one or 
more values such as ELL or SPED or Home Language. The Balance Code is setup 
in the Lookup Table K12.MassScheduleInfo.User Balance. Select which code 
should be assigned to this student, balancing the sections. 

24. The PXP Information section controls the status of the student requests submitted 
through the PARENTVUE & STUDENTVUE software. For more information on 
managing these requests, please see the Synergy SIS - PARENTVUE & 
STUDENTVUE Administrator Guide. 

25. Click the Save button at the top of the screen to save the changes. 

 

Note – Students may not be pre-scheduled using the Schedule 
Request screen. When a student is pre-scheduled, a section is 
manually assigned to the student course request and the request is 
exempt from the Mass Scheduling process. 
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To modify an individual student’s course requests using the Schedule Control screen: 

1. Go to the Schedule Control screen, found under Synergy SIS > Mass Scheduling. 

2. Click on the icon for the Option Set to be used. 

 
Figure 5.20 – Schedule Control Screen 

3. Click on the Open Student Schedule link. 

 
Figure 5.21 – Schedule Option Set Screen 

4. Requests can be added and modified on the Requests tab of the Schedule Student 
screen in just the same fashion as through the Schedule Requests screen outlined 
above. However, note that courses may also be assigned a pre-scheduled section 
in this screen once the option set has been run. 

 
Figure 5.22 – Schedule Student Screen 

5. Click the Save button at the top of the screen to save the changes. 
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To modify an individual student’s course requests using the Request tab on the Walk In 
Schedule screen: 

1. Go to the Walk In Schedule screen, found under Synergy SIS > Mass Scheduling 
or Synergy SIS > Schedule. 

 
Figure 5.23 – Walk In Schedule Screen 

2. Requests can be added and modified on the Requests tab of the Schedule Student 
screen in just the same fashion as through the Schedule Requests screen outlined 
above. However, note that courses may also be assigned a pre-scheduled section 
in this screen once the option set has been run. 

3. Click the Save button at the top of the screen to save the changes. 
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To modify an individual student’s course requests using the Quick Placement tab on the 
Walk In Schedule screen:  
 
The Quick Placement tab offers a simplified version of the walk in scheduling process. 

1. Go to the Walk In Schedule screen, found under Synergy SIS > Mass Scheduling 
or Synergy SIS > Schedule. 

 

   
• Print Schedule – click to print the STU202-Student Schedule report for the 

student. 

• Schedule - click to run the Walk In Scheduler. 
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• Quick Add - enter any combination of Section IDs and Course IDs (separated 
by a comma) to have added to the student’s schedule. 

• Add - click to add the Section IDs and Course IDs entered into the Quick Add 
field. 

• Drop Date - enter the date the student should be dropped from the section. 

• Enter Date - enter the date the student should be enrolled in the section. 

• Class - select or deselect a class section by clicking in this checkbox. 

• Legend - explains the various indicators on the screen. 
 

 

• Show Info - select where the options that can be selected below will be viewed. 
The options in the dropdown are In Cell, In Cell and Mouse Over, Mouse Over 
and None. 

 

Note – Selecting None will override any checkboxes 
selected and no information will show in cell or mouse 
over. 

• Sort/Group by - select how the courses should be sorted on the screen. The 
options in the dropdown are Course Id and Term and Period. 

• Show Class Max Size - the max class size from the section will display. 

• Show Totals By Gender - totals will display for both Male and Female students 
enrolled in the section. 

• Show Open Seats - the number of open seats in the section will display. 

• Show Room - the room assigned to the section will display. 

• Show Section ID - the Section ID of the class in the cell will display. 

• Show Teacher - the teacher assigned to the section will display. 

• Show Labels - labels to identify the display options will display. 

• Show Multiclass Indicator - an * (asterisk) displays in the cell indicating there 
is more than one section of the course that meets during that period and term. 
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• Show Schedule Summary by Term - schedule will be separated by terms as 
defined in the Term Definitions (Synergy SIS > System > School Setup). 

 

Note – When the Show Schedule Summary by 
Term option is selected, the ability to search all 
available sections for the selected period/term 
becomes available.   
 

 
 
The search icon is listed for each period, term, and 
meeting day. The icon opens a list of sections that 
meet during a particular term, period, and meeting 
day. 

 
 
You can narrow the results in the Section Availability 
screen by clicking in one or both of the checkboxes at 
the top of the screen. 
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• Show only classes with open seats option will 
remove those sections that are full (zero open seats) 
from the list. 

 

• Show only classes for requested courses option will 
remove any sections that do not correspond to the 
course requests the student has listed on the Walk In 
Schedule screen. 

Selecting both options will display a list of sections 
with open sets only that correspond to the student’s 
course requests on the Walk In Schedule screen. 
 

 
 
You can then select one of the sections to add to the 
student’s schedule by clicking on the Add button. 
 

 
 
The system adds the section to the student’s schedule 
immediately after the user selects it from the Section 
Availability screen. A student schedule can then be 
printed to reflect the change. 
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To enter course requests in the Quick Add field and allow the scheduler to place the 
student into sections: 

1. Enter the Course ID into the Quick Add field, the enter date into the Enter Date 
field and press the Add button to add it to the list of course requests. The course 
request will show at the bottom of the list with the available sections showing in the 
darker color. 

2. Click in the Class checkbox to select which section to enroll the student in, enter the 
Enter Date, and save the changes. The student is now enrolled in the section. 

:To enter Section IDs in the Quick Add field: 

• Enter the Section ID into the Quick Add field, the enter date into the Enter Date 
field, and press the Add button to add it to the list of course requests. The section 
will be added to the student’s schedule.  

To select which sections the student should be enrolled in using the list of existing course 
requests: 

1. From the list of course requests, click in the Class checkbox of the section to 
schedule. 

2. Enter the enter date in the Enter Date field. 

3. Save the changes. The student is scheduled into the section. 

To drop a class: 

1. Deselect the section to drop by clicking in the Class checkbox. 

2. Enter the drop date in the Drop Date field. 

3. Save the changes. The class is dropped from the student’s schedule.  

 
Note – The course request will remain in the list.  

 

 

Tips: 

• Refer to the legend at the bottom of the screen for an explanation of the 
blocks’ color-coding. The student’s current scheduled sections are 
indicated by gray blocks. 

• When there is more than one section available, the section that displays 
in the grid is the one with the best availability for balancing. This is the 
section the scheduler would have placed the student in for that period. 

• Clicking on the course link on this screen opens District Course. 

• Sections that meet on several different days will show all periods in the 
zero period column, regardless of the section-meeting period. 

• The Quick Placement screen settings are defined in the Class Size Limit 
field on the School Scheduling Options screen. 
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PARENTVUE & STUDENTVUE COURSE 
REQUESTS 
 
Students and parents can enter course requests for the student on the Course Request 
page of the PARENTVUE and STUDENTVUE software. Requests here can be limited to the 
type of course (Core, Elective, or Non-Core) and the number of courses that can be 
selected. The student can also be restricted to entering requests during a defined date 
range. For more information about the Course Request function, please see the Synergy 
SIS – PARENTVUE & STUDENTVUE Administrator Guide. 
 

 
Figure 5.24 – PARENTVUE and STUDENTVUE, Course Requests 
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To allows parents and students in the district to request courses online: 

1. Navigate to Synergy SIS > System > ParentVUE and StudentVUE Configuration.  
This screen controls the ParentVUE and StudentVUE configuration at the district 
level. 

 
Figure 5.25 ParentVUE and StudentVUE Configuration screen 

 

2. On the PVUE Configuration tab, select the Course Request check box in the Parent 
Active Modules to enable course requests in ParentVUE. 

3. Select to make the course request editable or view-only in ParentVUE from the 
Course Request Edit Option field. 

4. Select the Course Request check box in the Student Active Modules to enable 
course requests in StudentVUE. 

5. Select to make the course request editable or view-only in the Course Request Edit 
Option field. 

6. Click Save. 
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If your district allows students to begin entering course requests and return at another time 
to finish, enable the Hide Lock Course Request Button from online course requests.  
 
To hide the Lock Course Request button on the ParentVUE and StudentVUE screens 
 

1. Navigate to Synergy SIS > System > ParentVUE and StudentVUE Configuration, 
and go to the Course Requests tab. 

 
Figure 5.26 ParentVUE and StudentVUE Configuration screen 

 

2. Select the Hide Course Request Button check box. 

3. Click Save. 
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To allows parents and students at your school to request courses online: 

1. Navigate to Synergy SIS > System > ParentVUE and StudentVUE School 
Configuration.  This screen controls the ParentVUE and StudentVUE configuration 
at the school. 

 
Figure 5.27 ParentVUE and StudentVUE Configuration screen 

 

2. On the PVUE Configuration tab, ensure the Course Request check box is not 
selected in the Disabled Parent Modules to enable course requests in ParentVUE. 

3. Ensure the Course Request check box is not selected in the Disabled Student 
Modules to enable course requests in StudentVUE. 

4. Click Save. 
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If your school allows students to begin entering course requests and return at another time 
to finish, enable the Hide Lock Course Request Button from online course requests.  
 
To hide the Lock Course Request button on the ParentVUE and StudentVUE screens 
 

1. Navigate to Synergy SIS > System > ParentVUE and StudentVUE School 
Configuration, and go to the Course Requests tab. 

 
Figure 5.28 ParentVUE and StudentVUE School Configuration screen 

 

2. Select the Hide Course Request Button check box. 

3. Click Save. 
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STUDENT SCHEDULE & REQUEST ANALYSIS 
The Student Schedule & Request Analysis screen enables users to find students who are 
either not scheduled into a class or is missing specific course requests. The user creates 
student and course filters to identify which students or group is missing a course request or 
a schedule course.  
 
To create and run a filter: 

1. Navigate to Synergy SIS > Schedule > Student Schedule & Request Analysis.  The 
Student Schedule & Request Analysis screen displays. 

 
Figure 1: Student Schedule & Request Analysis screen - Add 

2. Click Add. The Student Schedule & Request Analysis add screen displays. 

 
Figure 2: Student Schedule & Request Analysis add screen 

3. Enter a Filter Name and Filter Type. 

4. Click Save.  You are returned to the Student Schedule & Request Analysis screen. 
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Figure 3: Step 1: Student Filter screen 

5. On the Step 1: Student Filter tab, select the appropriate student filters. 

6. Click Save. 

 
Figure 4: Step 2: Course Filter 

7. On the Step 2: Course Filter tab, select the appropriate course filters.  

8. Click Save. 
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Figure 5: Step 3: Results 

9. On the Step 3: Results tab, click Search.  The students who meet the selected 
criteria are listed in the Results grid.    
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Chapter Six: 
MASS SCHEDULING 

 
 
 
 
 
 
 
 
 
 
 
 

In this chapter, the following topics are covered: 
 Where to analyze the overall number of course requests 
 How to setup and test possible schedules 
 How to finalize the schedule 
 How to change sections after they are assigned in bulk 
 How to handle scheduling after the master schedule has been 

set 
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COURSE REQUEST ANALYSIS 
 
Once all of the student course requests have been entered, various schedules can be 
tested to see what options will accommodate the majority of students using the Schedule 
Control. However, before possible schedules are tested, the overall course request totals 
should be reviewed to see if any course offerings should be modified. For example, by 
examining the totals the school may decide to discontinue a course due to low enrollment, 
or they may decide to add additional teachers to accommodate an increase in the requests 
for a particular course. 
 
To screen and analyze the overall course requests: 

1. Go to the Course Request Analysis screen, found under Synergy SIS > Mass 
Scheduling. 

2. Courses can be viewed by Department, Course ID, Course Title, or by the status 
of the PXP Locked and PXP Verified fields. Less Than Requests displays any 
courses that have a fewer number of requests than the number entered. Once the 
criteria have been entered, click the Filter button. 

 
Figure 6.1 – Course Request Analysis Screen 

3. Once the filter is applied, the list of courses match the criteria entered is listed. For 
each course, the total number of requests by grade level and gender are displayed, 
and the total number of times the course was requested as an alternate course 
request. 

 
Figure 6.2 – Course Request Analysis Screen, Filter Results 

4. To modify course requests, click on the Course Name to screen the students who 
have requested the course. For example, if only one student has requested a 
course it will probably not be offered, and the students requesting that course 
should be reassigned a different course. 
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5. The School Course Detail screen appears, listing the students who requested the 
course. 

 
Figure 6.3 – School Course Detail Screen 

6. To remove the student request, click in the box in the X column and click the Save 
button at the top of the screen. 

7. To transfer the student’s request to another course, click on the gray arrow next to 
Destination Course and select the substitute course using the Find Course screen. 

8. Once the course is selected, click the Transfer button to switch the student to the 
new course. 

9. To further filter the list of requests to show the students who requested this course 
and other courses, select other courses by clicking the gray arrows next to Course 
One, Course Two, and/or Course Three and click the Filter button. This can be 
helpful to see where the overlap is between singleton or doubleton course requests. 

10. To screen students who selected this course as an alternative course, click the 
Alternate Course Request tab. 

 
Figure 6.4 – School Course Detail Screen, Alternate Course Request Tab 

11. To remove the alternate student requests, click in the box in the X column and click 
the Save button at the top of the screen. 

 
After completion of the analysis, the course offerings and student requests should be 
adjusted prior to starting the schedule testing process. The number of students requesting 
each course can also guide the determination of the number of sections to create for each 
course. 
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To further check the course requests for accuracy and validity, it is recommended that the 
following reports be printed: 

• OSM409 Student Course Request Verification Listing – when running this 
report, change the focus to show both active and inactive students. This report 
lists students and their course requests. The report should be checked for 
inactive students with course requests, and those course requests should be 
deleted. Inactive students are listed in parenthesis on the report. 

• OSM601 Course Request Totals – when running this report, change the focus 
to only show active students. This report lists each course available within the 
school and the total number of students requesting each course. The totals for 
each course are broken down by gender and grade level. 

• OSM602 Student Request Exception – when running this report, change the 
focus to only show active students. This report lists students who have 
requested fewer courses than specified in the report. These students’ requests 
should be modified to make sure they have requested a full course load. 

For more information about each of these reports, please refer to Chapter 9 of this guide. 
 
 

DEFINING & TESTING SCHEDULES 
 
Once all of the student requests and courses offered are finalized, different schedules can 
be tested to see which option will fit the majority of student requests. To test possible 
schedules: 

1. Go to the Schedule Control screen, found under Synergy SIS > Mass Scheduling. 

 
Figure 6.5 – Schedule Control Screen 

2. Each test of possible schedules is referred to as an Option Set. To create a new 
Option Set, click the Create/Copy Option Set button. 

 
Figure 6.6 – Add New Option Set Screen 

3. Enter a Name for the option set, and a Description. The description can be 
checked for spelling by clicking the Spell Check  button. 
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4. Select a Copy Option from the drop-down list. Select Blank to create a new option 
set with no options selected. The option is mostly used for schools new to Synergy 
SIS or when the scheduling options have drastically changed. For most schools, the 
first set created to begin creating a new year’s schedule will be Copy Last Year’s 
Schedule, which copies last year’s master schedule. To copy any option set from 
any year, select Copy Existing Option Set. To copy the existing master schedule 
for the current school and year, select Copy Current Master Schedule. The option 
is generally only used to readjust the schedule mid-year. 

5. If Blank is selected, no additional options are needed.  

 
Figure 6.7 – Create Options, Blank Copy Option 

6. If Copy Last Year’s Schedule is selected, choose the last school year from the 
Year drop-down list.  

 
Figure 6.8 – Create Options, Copy Last Year’s Schedule Copy Option 

7. If Copy Existing Option Set is selected, choose the Year and Scheduling Option 
Set to be copied from the drop-down lists. To copy the student schedules that 
resulted from the existing option set, check the box Copy Student Results.  

 
Figure 6.9 – Create Options, Copy Existing Option Set Copy Option 

8. If Copy Current Master Schedule is selected, choose the Term to Schedule from 
the drop-down list. The option removes all existing course requests, and replaces 
them with the current student schedules. To preserve the current student schedules 
as prescheduled classes, select which classes to preserve from the Preschedule 
Current Student Classes drop-down list. Classes that can be prescheduled are All 
Classes, Year-Long Classes Only, or No Classes. 

 
Figure 6.10 – Create Options, Copy Current Master Schedule Copy Option 

9. Once all of the options have been selected, click the Add button to create the new 
Option Set. 
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An unlimited number of option sets may be created to test different scheduling scenarios. 
The list of option sets created is displayed on the Schedule Control screen. For each 
option set, it lists the success of the last test with the percentage of students scheduled by 
the set, the total number of students, and the total number of students schedule by the set. 

 
Figure 6.11 – Schedule Control Screen 

To delete an option set, check the box in the X column and click the Save button at the top 
of the screen. 

 
To edit the options used by an Option Set or to test the scheduling results: 

1. Click on the icon next to the Option Set Name. 

 
Figure 6.12 – Schedule Control Screen 

2. The Schedule Option Set pops-up. When an option set is first created, the options 
cannot be edited as the Option Set is “checked in” or locked for editing. To edit, or 
“check out” the Option Set to modify the options used, click on the Check Out 
button. 

 
Figure 6.13 – Schedule Option Set Screen 
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3. The options in the Option Set can then be edited. When checked out, no one else 
can edit the set except the user listed. To unlock it again, click the Check In button. 

 
Figure 6.14 – Schedule Option Set, Edit Mode 

4. To save modifications to the options, click the Save button at the top of the screen. 
Each of the options available is outlined in the following sections of this guide. 

Basic Information 
 
In the Basic Information section, the name of the option set and the description can be 
modified in the Run Name and Run Description fields. 
 

 
Figure 6.15 – Schedule Option Set Screen, Basic Information 

 
If the option set was created as a copy of the current master schedule, the Term to 
Reschedule can be selected from the drop-down list. If this is left blank, the entire year will 
be rescheduled. 
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The Schedule Now button runs the option set to see what student schedules would be 
created by this option set. It does not make any changes to the student schedule views 
found in the Scheduling module. The test schedule can only be viewed from within the 
Option Set. 

Enforce the Following Rules 
 
In the Enforce the Following Rules section, many options can be set for the scheduling 
process as follows: 

 
Figure 6.16 – Schedule Option Set Screen, Enforce the Following Rules 

• To use the student’s selection of a preferred teacher for a course during the 
scheduling process, check the Use Teacher Preferences box. 

• To enforce the co-requisite requirements defined for each course in the District 
Course screen, check the Check Corequisites box. If the co-requisite course is 
not requested, the main course is not scheduled. 

• Select how the pre-requisites defined for each course in the District Course 
screen will be checked from the Prerequisite Option drop-down list. To 
disregard the pre-requisites during scheduling, select No Enforcement. If Full 
Enforcement (checks CHS) is selected, the student’s course history will be 
checked to verify the student has completed the pre-requisites successfully and 
does not schedule the course unless the pre-requisites are met. If Schedule 
Requests in Prereq Order is selected, course requests that are a pre-requisite 
for another request will be scheduled in the first term of the schedule. This 
option is useful when creating student schedules for an entire year or if student 
grades have not yet been posted to the student’s course history. For example, if 
both Pre-Algebra and Algebra are requested and Pre-Algebra is a pre-requisite 
of Algebra, Pre-Algebra would be scheduled for the first semester and Algebra 
would be scheduled for semester 2. 

• To use the alternate courses selected in case the primary course request cannot 
be scheduled, check the Allow Alternate Course box. 
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• To use the alternate courses selected for any electives, check the Allow Global 
Alternate Courses box. 

• To limit the number of students that can be assigned to a section based on the 
capacity of the room assigned to the section (as entered in the School Room 
screen), check the Use Room Seat Limit box. 

• Each course is assigned to a Term in the District Course screen and section, and 
some courses may not be offered every term. To allow student course request to 
override the default term assigned to the section and select a different term for the 
course, check the Check Term Override box. 

• To use the student’s selection of a preferred term for each course during the 
scheduling process, check the Check Term Preference box. 

• Select how houses will be used in the schedule from the House Option drop-down 
list. Select Automatic House Enforcement to assign students to sections with the 
same house assigned to both student and section. Selecting Match Sections with 
Houses will try to assign sections for each house that match each house’s course 
requests. If No House Enforcement is selected, houses will not be used during the 
scheduling process, even if houses are assigned to students or sections. 

• Select how teams will be used in the schedule from the Team Option drop-down 
list. Select Automatic Team Enforcement to assign students to sections with the 
same team assigned to both student and section. Selecting Match Sections with 
Teams will try to assign sections for each house that match each house’s course 
requests. If No Team Enforcement is selected, teams will not be used during the 
scheduling process, even if teams are assigned to students or sections. 

• If a student has requested a course twice, select how these duplicate requests will 
be handled from the Duplicate Course Request drop-down list. If Reject All 
Duplicates is selected, none of the duplicate course requests will be scheduled. 
Selecting Schedule All of the Duplicates will schedule all duplicate courses, and 
selecting Schedule One of the Duplicates will schedule only one of the duplicate 
requests. This setting overrides the Duplicate Course Request setting for each 
course set in the District Course screen. 

• To allow the scheduling process to schedule more students in classes than set in 
the Max Class Size field for the section, enter the percentage by which the size can 
be exceeded for the CORE, ELECTIVE, and OTHER courses in the Exceed Max 
Class Size for XXX classes by this % boxes. 

• Two special options are also available from the Special Run Option drop-down list.  
Select Ignore Max Class Size to test the schedule to see if there are any inherent 
conflicts in the schedule not due to the class size. This option is recommended for 
the first few runs of the schedule to resolve any issues not due to class size. Once 
all students are scheduled with this option turned on, it can be turned off so size 
issues can then be addressed. The other option available is Perform Schedule 
Optimization. When selected, the scheduling process removes previously 
scheduled students out of a section to open up a seat for a student that had a 
scheduling conflict to see if the conflict can be resolved. While this option can fix 
many scheduling issues, it can be very time consuming as well. However, the 
optimization process will not try to resolve a course scheduling issue that cannot be 
resolved. 
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• Max Time to Spend Per Student sets the maximum amount of time the scheduling 
process tries different scheduling options for each student. The amount entered is in 
seconds, and the default is .1 second. Only adjust this when the reason for not 
scheduling a course appears as Max Time Exceeded, and adjust in increments of 
.025. It is not recommended to exceed .5. 

Once all the rules have been adjusted, be sure to save the changes by clicking the Save 
button at the top of the screen. 

Balance and Sequence Options 
The Balance and Sequence Options control which courses and grades are processed first, 
and how students are placed in a section to maintain a diverse student population. 

 
Figure 6.17 – Schedule Option Set Screen, Balance and Sequence Options 

To select the order in which students are processed by grade level, choose the option from 
the Grade Order drop-down. Students can be processed by either High Grade to Low 
Grade, Low Grade to High Grade, or Not Used. 

The Sequence By option also controls the order in which students are processed. The 
order can be set to Alpha A to Z (by last name), Alpha Z to A (by last name), Difficulty 
(by the number of sections and periods available for the student course requests), or 
Random (no specific order). 

When course requests are scheduled, the Course Request Sequence sets the order by 
which the requests are processed. Selecting By Course Schedule Priority and Difficulty 
will schedule courses first by the Schedule Priority (Core or Elective) defined in the District 
Course screen and then by the difficulty of scheduling the section. By Difficulty only 
schedules courses in the order of difficulty. The difficulty is determined by the number of 
sections available for the course and the number of periods in which the course is offered. 

When assigning students to a section, the scheduling process can try to balance the 
demographics of the students in each section to create a diverse group of students in each 
section based on the Balance Option selected. The students in a section may be balanced 
by one of the following: Balance Property, Ethnicity, Gender, Gender and Balance 
Property, Gender and Ethnicity, or Total Students. The Balance Property is the district-
defined set of values used for balancing students in classes in addition to the options pre-
defined in Synergy SIS. This may be one or more values such as ELL or SPED or Home 
Language. The Balance Property is setup in the Lookup Table 
K12.MassScheduleInfo.User Balance. All of the options entered in this lookup table are 
used when the Balance Property is selected. The students are assigned the corresponding 
Balance Code in the Schedule Request screen. 

 

Tip – For the best scheduling results, set the Course Request 
Sequence to By Difficulty so that the most difficult courses to 
schedule are scheduled first. 
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Exclude the Following Students 
 
Occasionally it may be necessary to exclude students from the scheduling process. For 
example, perhaps all of the students in a grade, house, or team already have a schedule 
and there are just a few miscellaneous students missing a schedule. The process can then 
be run for just the remaining students and the students with a schedule in place can be 
preserved to save processing time. To exclude students from the process: 

 
Figure 6.18 – Schedule Option Set Screen, Exclude the Following Students 

• To exclude students by Grade Level, check the boxes for the grades to exclude. 
Use the Check All  boxes to check or uncheck all grades. 

• To exclude students by House, check the boxes for the houses to exclude. Use 
the Check All  boxes to check or uncheck all houses. 

• To exclude students by Team, check the boxes for the teams to exclude. Use 
the Check All  boxes to check or uncheck all teams. 

To keep the schedules for students that are excluded, check the box Lock Schedule for 
Skipped Students. If this box is not checked, the class schedules will be removed from 
students that are excluded during the scheduling run. 
 
To save processing time, check the box to Do Not Process Fully Scheduled Students. 
Students that have a complete schedule will not be processed. 
 
 

Clear All Results & Debug 
 
To remove all schedules previously created when this option set was processed, click the 
Clear All Schedule Results button. Pre-scheduled students will be retained. 
 

 
Figure 6.19 – Schedule Option Set Screen, Clear All Results & Debug 

 
When the Verbose Messages checkbox in the Debug section is checked, more detailed 
error messages are logged for the scheduling process. This is for use by the Edupoint 
Development team only. 
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Quick Links 
 
The Quick Links section of the option set provides links to the following views: 

• Open Student Schedule – the Schedule Student screen, which is only 
available through an Option Set. It provides the same functionality as the 
Schedule Request screen. 

• Open Schedule Section – the Schedule Section screen, which is only available 
through an Option Set. It provides the same functionality as the Section screen. 

• Allow unchecked out users to edit sections – if a user has checked out the 
option set, other users are still able to edit sections. 

• Open School Options – the School Scheduling Options screen 

• Open Option Set Wheel – the Option Set Wheel screen, which is only available 
through an Option Set. It uses the same wheels defined in the Wheel Definition 
screen, but can assign specific sections to the courses in the wheel. 

• Open Class Board – the ClassBoard screen provides a graphical screen of the 
schedule, and it is outlined in Chapter Seven of this guide. 

 

 
Figure 6.20 – Schedule Option Set Screen, Quick Links 
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Schedule Student 
 
The students’ course requests can be modified directly from the Option Set through the 
Schedule Student screen, as outlined in the section on individually assigning course 
requests in Chapter 5. This screen can also pre-schedule students into sections as outlined 
in the section on Pre-Scheduling Students later in this chapter. 
 

 
Figure 6.21 – Schedule Student Screen, Requests Tab 

 
Individual students may be scheduled through this screen by clicking on the Schedule 
button found on each tab of the screen. The student’s schedule will be processed according 
to the options saved for the open Option Set. 
 
To quickly identify student schedules that have conflicts, click the Conflicts buttons at the 
top of the screen to scroll back and forth to the next student schedule that has a conflict. 
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The Analysis tab of the Schedule Student screen lists the student’s schedule results and 
shows the reason why a course was not scheduled. For each course, it shows the periods 
in which a section for that course is scheduled. A indicates the section is available, F 
indicates the section is full, and if a number appears the student is scheduled for that 
section for the period number. 
 

 
Figure 6.22 – Schedule Student Screen, Analysis Tab 

 
The Schedule tab of the Student Schedule shows the scheduled and unscheduled course 
requests similar to the Analysis tab, but without the details. It can be filtered by the Term by 
selecting the term from the drop-down list and clicking the Filter button. 
 

 
Figure 6.23 – Schedule Student Screen, Schedule Tab 
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Schedule Section 
Before the Option Set can be run for testing, the sections that will be in use at the school 
must be added to the Schedule Section screen. Each Option Set can have a different list of 
sections. To reduce data entry, it is recommended to add the sections to the first option set 
created each year. Then copy this first option set for subsequent option sets so that it will 
not be necessary to enter the full list of sections again. 

1. To add a new section for the given Option Set, open the Schedule Section link. 

 
Figure 6.24 – Sched Section Screen 

2. Click the Add button at the top of the screen. A new Sched Section screen pops-up. 
The fields highlighted in green are mandatory and must be entered. 

 
Figure 6.25 – Section Screen, Adding 

3. If the Section ID is set to automatically generate by the option in the School 
Scheduling Options screen, it does not need to be entered. Otherwise, enter a 
unique Section ID. See page 82 for Auto Sequencing options. 

4. The MSB Section ID is populated during the Load Simulation process with the 
Section ID created during the Master Schedule Builder build process.  
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5. Select the Course ID by clicking on the gray arrow next to Course ID and selecting 
the course by using the Find Course screen. 

6. The Course Title automatically populates based on the Course ID. 

7. Select the Staff Name by clicking on the gray arrow next to Staff Name and 
selecting the course by using the Find Staff screen. 

8. Select the Room Name by clicking on the gray arrow next to Room Name and 
selecting the course by using the Find School Room screen. 

9. Select the starting and ending period for the section from the Begin Period & End 
Period drop-down list. 

10. Select the Term Code assigned to the section from the drop-down list. 

11. Select how the section will be handled in the attendance and grading views from the 
Exclude Attendance and Exclude Grading drop-down lists. Attendance may be 
set to Include in Attendance, Include in Attendance – No Scan Sheet, or 
Exclude from Attendance. Grading may be set to Include in Grading, Include in 
Grading – No Scan Sheet, or Exclude from Grading. 

12. To override the number of instructional minutes assigned to this section by the Bell 
Schedule, enter the number of minutes to be used in the Instructional Minutes 
Override box. This may be needed for sections that meet over the lunch period. For 
example, if Period 4 in the bell schedule includes 30 minutes for lunch and 60 
minutes for the section, the section instructional minutes should be set to only 60. 

13. Select the type of Instructional Method this course uses.  The types of 
Instructional Methods available are controlled by the 
K12.ScheduleInfo.InstructionalMethod lookup table. 

14. When Using Elementary Minutes is checked, the number of minutes submitted to 
the state for the section can be customized for each day of the week. A new section 
will appear on the Section screen above the Students grid with spaces to indicate 
the number of minutes for each weekday. 

 
Figure 6.26 – Elementary Minutes Section 

15. Select the College Credit for this course.  The college credit options are controlled 
by the K12.ScheduleInfo.College_Credit lookup table. 

16. Select the Staff Contributions Responsibility and Amount. The responsibilities 
are controlled by the K12.ScheduleInfo.Staff_Responsibility lookup table. 

17. Enter the maximum number of students that can enroll in the class in the Max field 
in the Student Seat Totals section. Also indicate the maximum number of teacher 
aides for the class in the Max field in the Teacher Aide Seats section. 

18. To restrict the section to students in a certain grade range, select the Grade Range 
Low and Grade Range High from the drop-down list. 

19. To restrict the class to a particular gender (such as a physical education section), 
select the gender from the Gender Restriction drop-down list. 

20. To override the credit assigned to the course in the District Course screen, enter the 
number of credits for the section in the Credit field. 
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21. To assign the section to a House and/or Team, select the values from the drop-
down list. For more information about Houses and Teams, see Chapter Four in this 
guide. 

22. Select the Term Exclusion from the drop-down list to assign the section to a Term 
Exclusion group. For more information about Term Exclusions, see Chapter Four in 
this guide. 

23. To prevent students from enrolling in the section during a term other than what is 
assigned to the section, check the No Term Override box. 

24. If this section should not be included in the mass scheduling process, check the box 
Exclude from Mass Scheduling. 

25. Click the Save button at the top of the screen to save the new section. 

 
The Meeting Days tab is used for school with rotating schedules. For instructions on how 
to configure a section for a rotating schedule, please see Chapter Three. 
 

Option Set Wheel 
 
The Option Set Wheel defines the sections assigned to the courses in each wheel 
definition. To define a wheel option: 

1. Find the wheel definition to edit using either the Scroll buttons or Find mode. 

 
Figure 6.27 – Option Set Wheel screen 

2. Once the definition is found, click the Add button in the Option Grid to show the 
courses in the existing wheel definition. 

 
Figure 6.28 – Option Set Wheel Screen, Wheel Definition 

3. Enter a name to define the sections that will be assigned to the courses in the 
Option Name field, such as period 1. Multiple sets of sections may be defined as 
options for each wheel. 
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Figure 6.29 – Option Set Wheel Screen, Option Added 

4. Click the Save button at the top of the screen to save the option. 

5. Click on the Show Detail button to screen the courses attached to the wheel. The 
courses display for the first option. To edit a different option, click on the Option 
Name in the left-hand side of the screen. The currently selected option is highlighted 
in blue. 

 
Figure 6.30 – Option Set Wheel Screen, Detailed Screen 

6. Click on the gray arrow in the Section ID column next to the course and the 
Find:SchedSection screen pops-up. 

 
Figure 6.31 – Find Section Screen 

7. Enter the criteria to be used to find the section in the fields in the Find Criteria 
section, and click the Find button at the top of the screen. The sections matching 
the criteria entered are listed in the Find Result section. Sections can be searched 
by Section ID, Period Begin, Period End, Term Code, Room Simple (Number), Max 
Students, Grade Range High and/or Grade Range Low. 

 
Figure 6.32 – Find Section Screen, Find Results 

8. Click on the section to be assigned to the course, and click the Select button at the 
top of the screen. The section ID displays in the Section ID column. 
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Figure 6.33 – Option Set Wheel Screen, Sections Added 

9. Save the section assignments for the highlighted option by clicking on the Save 
button at the top of the screen. To return to the main screen of the screen, click the 
Hide Detail button. 

10. To delete a set of section assignments, click in the box in the X column next to the 
option name and click the Save button at the top of the screen. 

 
Figure 6.34 – Option Set Wheel Screen, Deleting 

Fill Open Periods 
 
Filling open periods will schedule the same course, such as a study hall or homeroom 
course, for all students who do not have a course scheduled during a selected period or 
periods. To fill a student’s open periods: 

1. Click on the Fill Open Periods tab of the Schedule Option Set screen. 

 
Figure 6.35 – Schedule Option Set Screen, Fill Open Periods Tab 

2. Select the term to fill from the drop-down list. 
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3. Select the course to be used by clicking on the gray arrow. 

4. Select the period range from the drop-down lists. 

5. Click the Save button at the top of the screen. 

6. Once the selections have been saved, click the Fill Open Periods button to 
complete the process. Note that this process cannot be reversed! 

 

Pre-Scheduling Students 
 
Pre-scheduling students reserves a seat for a student in a specific section. Students who 
have been pre-scheduled in a section will not be re-assigned to another section for that 
course by the mass scheduling process, and this section assignment can only be manually 
changed. Note that pre-scheduling students can limit the options available to the mass 
scheduling process when scheduling the rest of the student’s classes. 
 
Students may be pre-scheduled in a section using either the Sched Section screen or 
Schedule Student screen in the Option Set, or by using the Walk In Schedule screen. 
 
To pre-schedule students in the Sched Section screen: 

1. Find the section to pre-schedule using the Scroll buttons or Find Mode. 

 
Figure 6.36 – Sched Section Screen 

2. Check the box in the Pre-Schedule column next to the student’s name. 

3. Click the Save button at the top of the screen. 
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To pre-schedule students in the Schedule Student screen: 

1. To add a prescheduled section, click on the green + sign.  

 
Figure 6.37 – Schedule Student screen 

2. The Schedule Section screen pops-up with a list of all of the sections available for 
the course. Click on the section to schedule, and then click the Select Section 
button. 

 
Figure 6.38 – Schedule Section Screen 

3. Click Save at the top of the Schedule Student screen to save the prescheduled 
section. 

4. To delete a prescheduled section, click on the red X next to the section. 
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To pre-schedule students in the Walk In Schedule screen: 

1. To add a prescheduled section, click on the green + sign.  

 

 
Figure 6.39 – Walk In Schedule Screen 

2. The Schedule Section screen pops-up with a list of all of the sections available for 
the course. Click on the section to schedule, and then click the Select Section 
button. 

 
Figure 6.40 – Schedule Section Screen 

3. Click Save at the top of the Walk In Schedule screen to save the prescheduled 
section. 

4. To delete a prescheduled section, click on the red X next to the section. 
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FINALIZING THE SCHEDULE 
Once the best schedule has been identified using the Schedule Control screen, the 
selected schedule, or option set, needs to be run for a final time to copy the sections and 
student schedules to the Schedule Module. This is the final step in creating the master 
schedule for the new school year. Once the Update Schedule process has been run for a 
school, all other changes to the student’s schedule should be made using the views 
outlined in Chapter Eight in this guide. 
 
Before finalizing the schedule, make a copy of the selected Option Set and name it 
something to indicate that it was the option set used to create this year’s schedule. To 
create the final option set: 

1. Go to the Schedule Control screen, found under Synergy SIS > Mass Scheduling. 

2. Click the Create/Copy Option Set button. 

 
Figure 6.41 – Schedule Control Screen 

3. The Add New Option Set screen pops-up. For the Name and Description of the 
set, enter a name and description that indicate that it is the master schedule. 

 
Figure 6.42 – Add New Option Set Screen 

4. Select Copy existing Option Set from the Copy Option drop-down list, and select 
the Year and the final Scheduling Option Set. 

5. Check the boxes to Copy Student Results and to Add All Missing Staff, Course 
and Rooms. 

6. Click the Add button at the top of the screen to save the final Option Set. 

 

Tip – To prevent anyone from making changes to the Mass Scheduling views after the 
schedule has been finalized, it is recommend that Synergy SIS security be modified to 
remove the entire Mass Scheduling folder from the Navigation (PAD) Tree for most users. 
For instructions on how to modify PAD security, please see the Synergy SIS - Security 
Administrator Guide. 
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To run the final option set and create the master schedule: 

1. Go to the Update Schedule screen, found under Synergy SIS > Mass Scheduling. 

 
Figure 6.43 – Update Schedule Screen 

2. Select the option set to be used from the Select Option Set drop-down list. 

3. Click the Initiate Update Schedule Process button. 

  

Caution: The Update Schedule process deletes all existing 
sections and student schedules before it creates the sections 
for the master schedule and assigns students to the sections. 

 
After the Update Schedule process is complete, all further schedule changes should be 
made using the views in the Schedule module. 
 
 

MASS ASSIGNING SECTIONS 
 
The Mass Assign Sections screen allows schools to make global changes to student 
schedules in the Options Sets, replace sections, and to pre-schedule multiple students at 
one time. This does not change the section assignments in the final student schedule. 
 
To assign a list of sections to a group of students: 

1. Go to the Mass Assign Sections screen, found under Synergy SIS > Mass 
Scheduling. 

 
Figure 6.44 – Mass Assign Sections Screen 

2. Click the Add button to create a new mass assign definition. A new screen pops-up/ 
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Figure 6.45 – Mass Assign Sections, Adding 

3. Enter a name for the definition in the Name box, and select the option set to which 
the mass assignment will be applied from the Option Set drop-down list. 

4. To restrict the assignment to a specific grade or grades, check the Grade levels to 
which the definition will apply. 

5. Click the Save button at the top of the screen to save the definition. 

 
Each definition can add sections in three ways: 

• Add – the section is added to all students that match the options, gender, grade 
or selected students in the definition. 

• Replace – the section is added to all students that match all of the other criteria 
and that are scheduled for the section to be replaced. The section that is 
replaced is removed from the student schedules. 

• Keep - the section is added to all students that match all of the other criteria and 
that are scheduled for the section to be replaced. The section that is replaced is 
kept in the student schedules. 

 
To define how sections are added: 

1. To select which sections should be added to the student schedules, click the Add 
button to add a single section or click the Chooser button to add multiple sections. 

 
Figure 6.46 – Mass Assign Sections Screen 

2. When adding a single section, the Find SchedSection screen pops-up. Enter the 
criteria to be used to find the section and click the Find button. 
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Figure 6.47 – Find SchedSection Screen 

3. All sections matching the criteria entered will be listed. Click on the section to add 
and click Select. 

4. When adding multiple sections, the Chooser screen pops-up. Enter all or part of the 
Section ID and click Find to list the matching sections. 

 
Figure 6.48 – Chooser Screen 

5. Click on a section and click the Add Selected Row(s)> button to add the section to 
the Selected Items grid. To select multiple sections, hold down the CTRL key while 
clicking. To add all the sections in the Find Result section, click the Add All Row(s) 
> button. To find a different range of section ID, enter a new ID and click Find again. 
The items in the Selected Items section will remain. To remove a section from the 
Selected Items grid, check the box in the X column. 

 
Figure 6.49 – Chooser Screen 

6. Once all of the sections are listed in the Selected Items grid, click the Select button 
at the top of the screen and the sections will be added to the Sections to Add 
section. 
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Figure 6.50 – Mass Assign Sections Screen, Section Added 

7. If this definition will only add sections, leave the Sections To Find and Replace 
empty. To replace existing sections, add the existing sections by clicking the Add 
button to add a single section or click the Chooser button to add multiple sections  

 
Figure 6.51 – Sections Added 

8. Once the sections have been added, select how the existing sections should be 
treated from the Action drop-down list. To remove the existing section, select 
Replace Section. To retain the existing section, select Keep. To remove the course 
request associated with the section in addition to removing the section (for courses 
no longer offering sections for the term), select Remove Course Request. 

9. If the section should only be added to the student schedule if the student has a 
course requests for the section, select Only replace sections if a student has 
matching requests from the Course Requests drop-down list. 

10. To add the section as a pre-schedule section, select the option Preschedule 
student into the section(s) from the Prescheduled drop-down list. 

11. To restrict the students receiving the new section to one gender, select the Gender 
from the drop-down list. 

12. The students may also be filtered by Grade by checking the grade levels to receive 
the new section. 

13. Click the Save button at the top of the screen to save the complete definition.  

14. To assign the section(s) to specific students, click on the Student Selection tab. 

 
Figure 6.52 – Mass Assign Sections Screen, Student Selection Tab 

15. To select which students should have the section added to their schedules, click the 
Add button to add a single student or click the Chooser button to add multiple 
student. 

16. Click the Save button at the top of the screen to save the selections. 
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17. To run the definition and assign the section(s) to the students in the option set, click 
the Assign Sections button at the top of the screen. 

 
Figure 6.53 – Mass Assign Sections Screen 

 
 

HANDLING WALK-IN REQUESTS 
 
Once the master schedule has been finalized, and the sections and student schedules 
have been created, any new student schedules are created using the Walk In Schedule 
screen. This screen will be used for new students that enroll after the start of the school 
year, for example. To create walk-in schedules: 

1. Go to the Walk In Schedule screen, found under either Synergy SIS > Mass 
Scheduling or under Synergy SIS > Schedule. 

 
Figure 6.54 – Walk In Schedule Screen 

2. To change the list of course requests displayed, select the Term Start and Term 
End from the Filter section and click the Filter button. 
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3. To select which term to schedule, select the option from the Term to Schedule 
drop-down list. The screen can show All Terms, Current Term Forward, or 
Current Term Only. 

4. To set the leave and enter date used for all sections in the schedule, enter the dates 
in MM/DD/YY format in the Drop Date field and Enter Date field. The dates can 
also be selected using the Calendar button. 

5. To quickly add a standard group of courses, select a quick assign group as defined 
in the Mass Assign Course Requests screen from the Add By Group drop-down 
list. 

6. Course can be locked so that students and parents cannot modify the requests in 
the PARENTVUE & STUDENTVUE software. To lock or unlock all the course requests, 
click the Lock All Courses button or the Unlock All Courses button. To lock or 
unlock individual courses, check or uncheck the box in the Lock column next to the 
course request. 

7. To select the term in which the student wants to take the course, select the 
Preferred Term from the drop-down list. To override the term assigned to the 
section and allow the student to take the course in a non-standard term, select the 
correct semester to assign to the course from the Term Override drop-down. 

8. If the student prefers to take the course from a specific teacher, the teacher can be 
selected by clicking on the gray arrow in the Preferred Staff column and selecting 
the staff name from the Find Staff screen. 

9. To assign an Alternative Course request in case the primary course cannot be 
scheduled, click on the gray arrow in either the Course ID or Course Title columns 
and select the course using the Find Course screen. 

10. If the pre-requisite courses defined in the District Course screen for each course 
should not be enforced, check the box in the Pre-Req Not Required column. 

11. The period restriction, house and team can be set at the bottom of the screen in the 
Scheduling Options section as outlined in Chapter 4 of this guide. 

12. Once all of the requests and options have been identified, the student can be 
scheduled by clicking the Schedule button towards the top of the screen. 

 
Figure 6.55 – Walk In Schedule Screen, Schedule Button 

To see the results of the schedule, click on the Analysis tab. This tab lists the student’s 
schedule results and shows the reason why a course was not scheduled. For each 
course, it shows the periods in which a section for that course is scheduled. A indicates 
the section is available, F indicates the section is full, and if a number appears the 
student is scheduled for that section for the period number. Course requests can also 
be added and deleted from this tab using the Chooser button or by clicking in the box in 
the X column. 
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Figure 6.56 – Walk In Schedule Screen, Analysis Tab 

13. Continue adjusting the course requests and clicking the Schedule button until the 
student has a complete schedule 

The Schedule tab of the Walk In Schedule screen shows the scheduled and unscheduled 
course requests similar to the Analysis tab, but without the details. It can be filtered by the 
Term by selecting the terms from the drop-down lists and clicking the Filter button. 
 

 
Figure 6.57 – Walk In Schedule Screen, Schedule Tab 
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Once the student’s schedule is complete, course requests that were not scheduled may be 
removed from the course request list by clicking the Delete Non Scheduled Course 
Requests button on the Requests tab of the Walk In Schedule screen. 
 

 
Figure 6.58 – Walk In Schedule Screen, Delete Non-Scheduled Course Requests Button 

 
 
The current Student Schedule report for the student may also be printed from this screen 
by clicking on the Menu button, selecting Reports, and clicking on the Student Schedule 
report. The report pops-up as a PDF in a separate window. 
 

 
Figure 6.59 – Walk In Schedule, Menu Options 
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Chapter Seven:
 CLASSBOARD 

 
 
 
 
 
 
 
 
 
 
 
 

In this chapter, the following topics are covered: 
 How to setup ClassBoard 
 How to adjust the ClassBoard display 
 How to edit the schedule within ClassBoard 
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OVERVIEW OF CLASSBOARD 
 
ClassBoard is a tool to graphically display and update a schedule created by an Option Set. 
ClassBoard is available for Option Sets in the Scheduler. In ClassBoard, sections can be 
modified, added, deleted, or moved between periods. The simulation or option set can then 
be run from within ClassBoard to see the effects of the modifications to the sections. 
However, student schedules cannot be individually modified within ClassBoard. 
 

 
Figure 7.1 - ClassBoard 

 
 

CLASSBOARD SETUP 
 
ClassBoard uses Microsoft’s Silverlight viewer. To work with ClassBoard, the Silverlight 
viewer must be installed on the desktop or laptop that will be using ClassBoard. The 
Silverlight installation can be started from the following website: 
 

http://www.microsoft.com/silverlight/get-started/install/default.aspx 
 
In addition, each Synergy SIS web site that will be using ClassBoard must have the SSL 
setting for the site defined using the DBTools utility. To modify the SSL setting: 

1. Start DBTools. This tool is installed by default on the web server, or it can be 
installed on any server. The shortcut is placed in the Edupoint folder in the All 
Programs menu. Multiple sites can be accessed and maintained from one 
installation of DBTools. 

2. If needed, add the configuration for each website to DBTools using the Add New 
Web.Config/Database Access option from the Databases menu.  

3. Modify the SSL Setting for each website by using the Edit Web.Config/Database 
Access option from the Databases menu. 

http://www.microsoft.com/silverlight/get-started/install/default.aspx
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• Select SSL Only for sites that are setup to use SSL exclusively. 

• Select Both Non-SSL & SSL for sites that are setup to use both SSL and non-
SSL. 

• Select Non-SSL Only for sites that are not setup to use SSL. 

 
Figure 7.2 - DBTools 

4. Save the changes by clicking OK, and then click OK again to modify the web.config 
file when prompted. 
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STARTING CLASSBOARD 
Once Silverlight has been installed and the SSL setting configured, ClassBoard can be 
accessed by: 

1. Open the Schedule Control screen, found under Synergy SIS > Mass Scheduling. 

 
Figure 7.3 - Schedule Control 

2. Open the option set to be used with ClassBoard by clicking on the Option Set icon. 

 

Note – If another user has checked out the option set that you have 
selected, ClassBoard opens in view-only mode.  You are only able to 
view information in ClassBoard, not edit it. 

 

3. If needed, check out the Option Set by clicking on the Check Out button. 

 
Figure 7.4 - Schedule Option Set 

4. Click on the Open ClassBoard link in the Quick Links section.  

  

Note: When working with ClassBoard, the entire schedule from the Option Set 
is copied to the local hard drive of the computer using ClassBoard. Changes 
made using ClassBoard are not copied back to the Option Set until the changes 
are saved from within ClassBoard. Any changes made to the schedule using 
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other links such as Open Student Schedule or Open Schedule Section while the 
option set is open in ClassBoard will be overridden when the schedule is saved 
from ClassBoard. 

 

CHANGING THE DISPLAY 
 
Once in ClassBoard, the name of the school and Option Set is displayed at the top of the 
screen as well as the name of the user who has checked out the option set. The current 
percentage of students scheduled as well as the number of students scheduled over 
the number of students requesting courses is displayed in the top left hand corner. 
 

 
Figure 7.5 - Default ClassBoard Display 

 
At the top of each section (which may be changed using the screen as explained below), 
the total number of spaces available is shown with the total number of students scheduled 
in those spaces. For example, in the screenshot above, 1 student has been scheduled in 
the 118 available spaces for 1st Semester Period 3 for the classes in the department of 
American History. 
 

  

Note: Since the courses and staff displayed in ClassBoard are aggregated by 
their assigned department, it is helpful to ensure all courses and staff is 
assigned to their current department before using ClassBoard. 
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Views 
 
Sections can be displayed in ClassBoard in a number of different ways. By default, sections 
are sorted by Department, then Course name, from top to bottom and by Term, then 
Period, from left to right. This view is called the Left: Dept/Course Top: Term/Period 
view. To select a different view, click on the View: drop-down at the top of the screen and 
select one of the available views. 
 

 
Figure 7.6 - Selecting a Screen using the Drop-Down 

Views may also be selected from the menu by clicking on the View menu and choosing the 
View Selector. 
 

 
Figure 7.7 – Selecting a Screen using the Menu 

 
Generally, the sections can be sorted by teacher, course or room and then by term, period 
or meeting day. 

  

Note: When sorting sections by either teacher or room, a row or 
column displays all the sections that do not have either a teacher 
or room assigned. 
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Scroll Bars 
 
To scroll through the display, use the scroll bars on the right and bottom of the main 
display. Click on the dark blue arrow, drag it along the bar, and release it at the new point in 
the list of sections to be focused upon. 
 

 
Figure 7.8 – Scroll Bars 

 
As the scroll bars are dragged, a pop-up box displays the location of the scroll bar within 
the list of sections. When the mouse is released, the display will move to that location. 
 

 
Figure 7.9 – Scroll Bars, Pop-Up List 
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Note: If Real-Time Scroll is enabled under the Preferences options, the 
display will scroll as well as the list of locations. To access the 
Preferences, click on the Screen menu and choose Preferences or click 
the Preferences button on the toolbar. 
 

 
 

Figure 7.10 - Preferences, Real Time Scroll 
 

 
 

Minimize & Maximize 
 
To minimize the number of sections displayed at the top or left, click on the minus sign 
next to each section. For example, in the screenshot below click on the minus sign next to 
the department of Agricultural Science to only display the department name and to not list 
the courses and sections within the department. 
 

 
Figure 7.11 - Minimizing Areas 

 
To maximize the display for the section again, click on the plus sign next to the section. 
The sections at the top can be minimized and maximized as well as the sections to the left. 
 

 
Figure 7.12 – Maximizing Areas 
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Section Display 
 
In the main grid of the ClassBoard display, each section created in the Option Set is 
displayed by a colored bar. In each bar, it displays the last name of the teacher, the number 
of students scheduled in the section, and the number of maximum seats for the section.  

 
Figure 7.13 – Section Display 

 
Each bar is also color-coded to indicate the status of the section such as empty or full. The 
default colors are: 

 Over Maximum Size 

 Full 

 Students are scheduled in the section, but 
seats are available 

 Empty 

 
The color-coding for each section is referred to as Rules. Each rule, or color-coding, can be 
turned on and off by clicking on the down arrow in the bar above the section grid. Click on 
the name of the rule to toggle them off. 
 

 
Figure 7.14 – Controlling Rules Using the Toolbar 

 
The rules can also be turned on and off by clicking on the Screen menu and clicking on 
each rule under the Rules sub-menu. Click on each rule to toggle them on or off. 
 

 
Figure 7.15 – Controlling Rules Using the Menu 
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To change the colors of the rules or the section information displayed in each bar: 

1. Click on the Preferences button, or select Preferences from the Screen menu. 

 

 
Figure 7.16 – Preferences Button 

 

 
Figure 7.17 – Preferences from the Screen Menu 

 

2. The Preferences box pops-up. To select which information is displayed in each 
section bar, check the boxes in the Section area of the Preferences box. By default, 
each section bar shows the Teacher, Class size, and Total students enrolled. 

 
Figure 7.18 - Preferences Box 

3. Other options are Course ID, Course Title,  Room, Period, Term, Department, 
and Available Enrollments.  



Scheduling and Course Guide   Chapter Seven 
 

192 Copyright© 2013 Edupoint Educational Systems, LLC 

4. To modify the color selected for a rule, select how the sections are color-coded from 
the Color code sections by drop-down field. The options are Enrollment, House, 
and Team. 

5. Select the rule from the Select Rule and Color grid. 

6. To remove the color, click in the box labeled Remove Color From Rule. 

7. To assign a new color, click on the box for the new color under Select Color. 
8. To save the changes to the preferences, click the Save button at the top of the 

Preferences box. 

 

Windows/Docking Panes 
 
Four additional windows, or docking panes, can be displayed on the ClassBoard screen to 
show more details about a section or the ClassBoard. To turn these windows on and off 

1. Click on the Screen menu, and select the window to turn on or off under the 
Windows sub-menu. 

 
Figure 7.19 – Windows Sub-Menu 

2. Alternatively, the windows can also be turned on and off from the Preferences box 
by checking and unchecking them under the Docking Panes area. 

 
Figure 7.20 - Preferences Box, Docking Panes 
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The Section Details window shows the details of the section selected in the main grid. If no 
section is selected, the window will be blank. These are all of the same details available in 
the Sched Section screen of the option set.  
 

 
Figure 7.21 - Section Details Window 

 
The Section Rules window lists the three section rules (Empty, Full, Over) and shows the 
currently assigned color for each rule. The rules can also be turned on and off from the 
window by checking and unchecking the box in the Active column. 
 

 
Figure 7.22 - Section Rules Window 
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The Section Statistics window lists the total number of requests for the section selected 
on the main grid, and the total number of students scheduled for the section. 
 

 
Figure 7.23 - Section Statistics Window 

 
The Section Students window lists all of the students scheduled for the section selected in 
the main grid. Each student can be marked as a Teacher Aide or Pre-Scheduled for the 
section from this window as well by checking the appropriate box. 
 

 
Figure 7.24 - Section Students Window 

 
Each of these four windows can either be displayed as a Dockable window, a Floating 
window, a Tabbed Document, or an Auto Hide window. Each window’s display is set 
individually for each window. To change a window’s display: 

1. Click on the downward-pointing triangle in the upper-right hand corner of the 
window. 

 

 
Figure 7.25 - Changing the Window Position 

 

2. From the drop-down menu, select Floating, Dockable, Tabbed Document or Auto 
Hide. 
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In Floating window mode, each window appears as a small box over the main ClassBoard 
screen. The window can be dragged and dropped to place it on the screen, and the window 
can be adjusted in size by dragging and dropping the edges of the window. To close the 
window, click on the red X in the top right-hand corner of the window. 
 

 
Figure 7.26 – Floating Window 

 
In dockable window mode, the windows can be dragged and dropped to various positions 
on the right-hand side of the main grid. They can be stacked on top of each other with tabs 
appearing at the bottom. Or they can be stacked up and down, or from left to right. To 
remove a window, click on the X in the top right-hand corner of the window. 
 

 
Figure 7.27 - Dockable Window 

 

  

Note: Clicking on the Pin icon in the top of each window turns 
the window on Auto-Hide, as described on the next page. 

 
                      Figure 7.28 - Pin Icon 
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In Tabbed Document mode, each window appears as a tab in the main section grid. 
 

 
Figure 7.29 - Tabbed Document Windows 

 
In Auto-Hide mode, each window appears as a small box on the right-hand side of the 
main grid. When the mouse hovers over each box, the window slides out to the left. 
 

 
Figure 7.30 – Auto-Hide Mode 

 
Clicking on the Pin icon changes the window back to a regular Dockable window. 
 

 
Figure 7.31 – Pin Icon 

 
For all windows in any mode, clicking on the Hide option closes the window. 
 

 
Figure 7.32 - The Hide Option 
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MODIFYING THE SCHEDULE 
 
Once the display has been adjusted to a user’s preferences, the work of modifying the 
schedule can commence. 
 

Viewing Section Details 
 
ClassBoard can display all of the same details of a section as shown in the Sched Section 
screen in an Option Set. To screen the details of an existing section: 

1. Double-click on a section in the grid. 

 
Figure 7.33 – Double-Click to Screen Section Details 

2. OR right-click on a section in the grid and choose Screen Section Details. 

 
Figure 7.34 – Right-Click to Screen Section Details 

3. The Section Details box pops-up. 

 
Figure 7.35 – The Section Details Box 

To see the meeting days, click on the Meeting Days tab. To see the students 
scheduled, click on the Students tab. Close the box by clicking the Close button. 
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Editing a Section 
 
To edit a section: 

1. Open the section details by either right-clicking or choosing Screen Section 
Details or by double-clicking a section. These details can also be seen in the 
Section Details window if displayed. 

 
Figure 7.36 – Right-Click to Screen Section Details 

2. Click on the Edit button at the top of the box. 

 
Figure 7.37 – Editing Section Details 

3. Make any changes to the section on the Section Details tab. 

4. Change the meeting days on the Meeting Days tab. 

 
Figure 7.38 - Meeting Days Tab 
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5. Remove students from the section by clicking on the Students tab and clicking the 
Drop button next to the student. 

 
Figure 7.39 - Students Tab 

6. Students can also be marked as a Teacher Aide or Pre-Scheduled for the section 
by checking the appropriate box on the Students tab. 

7. Click the Save button at the top of the box to save any changes, or click the Cancel 
button to cancel the changes.  

 
The easiest way to modify the schedule and see the impact of the change is to drag and 
drop the sections between periods. To change the period the section meets in, click on 
the section bar in the main grid and drag it to the new period. Release the mouse when the 
section bar appears in the correct period. 
 

 
Figure 7.40 - Dragging and Dropping Sections 

 
Once a section has been moved, sections that have been impacted by the move are 
marked with a dark blue outline in the grid. 
 

 

Note: Classboard also allows you to drag and drop sections 
between terms. 
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To prompt to confirm a section’s change when dragging and dropping sections in the grid, 
go to the Preferences box (found under the Screen menu by clicking on Preferences) and 
check the Confirm Changes box. To turn off dragging and dropping completely, check the 
Disable Drag’n Drop box. 

 
Figure 7.41 – Preferences, Confirm Changes 

 
When Confirm Changes is turned on, a box pops-up after a section is moved to confirm if 
the section should be moved or if the change should be cancelled. 
 

 
Figure 7.42 - Confirm Changes Box 

 
Another way to edit section details is by using the Section Details window. To edit a section: 

1. Turn on the Section Details window using the Preferences box or the Screen 
menu. 

2. Click on the section to edit in the main grid, and the details of the section appear in 
the Section Details window. 

 
Figure 7.43 - The Edit Button in Section Details 



Chapter Seven   Scheduling and Course Guide 
 

Copyright© 2013 Edupoint Educational Systems, LLC 201 

3. Click the Edit button from with the Section Details window. 

4. When the section is in Edit mode, any detail can be changed in the windows by 
clicking in the boxes or drop-downs. Scroll down to see all of the details that can be 
changed. 

 
Figure 7.44 – Editing the Section Details 

5. To save the changes and stop editing, click the Exit Edit Mode button. To cancel 
the changes and stop editing, click the Revert Changes button. 

 

 

Tip – If a section is displayed in the Section Details window, and the main grid has 
been scrolled away from the section so that it is no longer displayed in the main grid, 
the section can quickly be brought into screen again by clicking the Go To button in 
the Section Details window. 

 
Figure 7.45 – Go To Button 
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Adding & Deleting Sections 
 
To add a section to a course: 

1. Right-click in any space on the line for the course in the main grid, and choose 
Add Class. 

 
       Figure 7.46 – Right-Click, Add Class 

2. OR click on the Edit menu and choose Add Class. 

 
Figure 7.47 – Edit Menu, Add Class 

3. The Add a New Class box pops-up. Enter all of the information for the section, and 
click the Save button. 

 
                          Figure 7.48 – Adding a New Class 

 
 
 
 
 

  

Caution: Even if the section ID is set to be auto-generated within Synergy 
SIS, section ID must be manually assigned within ClassBoard since the 
data set is stored on the local computer and is no longer connected to 
Synergy SIS. 
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To delete a section: 

1. Right-click on the section and choose Delete Class. 

 
Figure 7.49 – Right-Click, Delete Class 

2. OR with the class selected, click on the Edit menu and choose Delete Class. 

 
Figure 7.50 – Edit Menu, Delete Class 

3. The confirmation box pops-up. Click the Delete button to confirm the deletion of the 
section. 

 
                          Figure 7.51 – Confirmation Box 
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Class Builder 
 
Class Builder can modify student course requests, and manually assign students to a 
specific section of a course. To start Class Builder: 

1. Right-click anywhere in the main grid, and choose Open Class Builder. It will 
default to the course that was clicked on in the grid, but any course can be seen by 
modifying the drop-down list. 

 
Figure 7.52 – Right-Click, Open Class Builder 

2. The Class Builder box pops-up. 

 
Figure 7.53 - Class Builder 

3. The left-most box, the Enrolled Students box, shows all students enrolled at the 
school, and lists their Grade (Grd), Gender (Gen), Name, EL, SP, GT, and the total 
number of course requests (Reqs). 

 
Figure 7.54 - Enrolled Students Box 



Chapter Seven   Scheduling and Course Guide 
 

Copyright© 2013 Edupoint Educational Systems, LLC 205 

4. To sort by a column, click on the column. To reverse the sort, click on the column 
again. A triangle displays the direction of the sort. To remove the sort, click on the 
triangle. 

 
Figure 7.55 - Sorting 

5. To filter the list of students by one or more of the column values, click on the funnel 
icon in the column. Check the values to display from the list of values. To show all 
values, check the Select All box. To specify one or two custom values, select an 
option from the drop-downs under Show Rows With Value That and enter the value 
in the blank white box. Click the Filter button to apply the filter. Click the Clear Filter 
button to remove a filter. 

 
Figure 7.56 - Filtering 

6. The middle box, the Course Request box, shows all of the course requests for the 
selected department and course. The Total number of requests is displayed as well 
as the number of Available Seats. All students who have requested the course are 
listed, and if the student has been scheduled for the course, a Y appears in the 
Sched column. 
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Figure 7.57 – Course Request 

7. All of the other columns are the same as in the Enrolled Students box, and the 
columns have the same sorting and filtering options as outlined previously. 

8. To remove a student course request, click on the student in the Course Request 
list and then click on the button with the double-arrows pointing towards the Enrolled 
Students box. To add a course request, click on the student in the Enrolled 
Students list and click on the button with the double-arrows pointing towards the 
Course Request box. 

 
Figure 7.58 - Adding & Removing Course Requests 

9. To screen a different course, change the department and course in the drop-
downs at the top of the Course Request box. 

10. To manually edit an existing section’s roster, select the section from the drop-down 
at the top of the Section Roster box, the right-most box in the Class Builder. 
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Figure 7.59 – Section Roster 

11. A list of students currently enrolled in the section displays below. If a student has 
been pre-scheduled for the section, a Y will appear in the PreSched column. 

12. All of the other columns are the same as in the Enrolled Students box, and the 
columns have the same sorting and filtering options as outlined previously. 

13. To remove a student from a section, click on the student in the Section Roster list 
and then click on the button with the double-arrows pointing towards the Course 
Request box. To add a student to a section, click on the student in the Course 
Request list and click on the button with the double-arrows pointing towards the 
Section Roster box. 

 
Figure 7.60 - Modifying Section Rosters 

14. To close the Class Builder and save the changes, click the red X in the top right-
hand corner of the Class Builder box. 
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Finalizing the Schedule 
Before re-running the schedule based on the changes made in ClassBoard, it may be 
necessary to adjust the school scheduling options. These are the same options found in the 
School Scheduling Options screen in Synergy SIS. To modify the School Scheduling 
Options: 

1. Click the Schedule Options button on the toolbar. 

 
Figure 7.61 – Schedule Options Button 

2. OR click on the Screen menu and select Schedule Options. 

  
Figure 7.62 – Schedule Options from the Screen Menu 

3. The Schedule Options box pops-up. Modify the settings as needed. 

 
Figure 7.63 – Schedule Options 

4. Click the Save button at the top of the box to save the changes. These changes 
are saved back to the option set. 
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To reverse any change within ClassBoard, click the Undo button or click on the File menu 
and select Undo. The Undo function will reverse any changes within ClassBoard from most 
recent all the way back to the first settings available upon opening ClassBoard. This can 
reverse anything from section changes to student enrollment changes. 
 

 
Figure 7.64 – Undo Button 

 

 
Figure 7.65 – File Menu, Undo 

 
Since changes to a section will only reschedule the students directly impacted by the 
change, the schedule should be completely re-run to screen the total impact of any 
ClassBoard changes. To completely re-schedule all students in the ClassBoard option set, 
click the Reschedule button or choose Reschedule from the File menu. 
 

 
                     Figure 7.66 – Reschedule Button 

 

 
      Figure 7.67 – File Menu, Reschedule 

 
Since the Reschedule process can take some time, a box pops-up to confirm the 
reschedule before processing. 
 

 
  Figure 7.68 - Reschedule Confirmation Box 

 
To finalize any changes in the ClassBoard and save them back to the option set, click the 
Save button or select Save from the File menu. 
 

 
Figure 7.69 – Save Button 
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      Figure 7.70 – File Menu, Save 

 
While the save is processed, a Job Queue Status window displays the progress of the 
save. 

 
     Figure 7.71 – Saving, Job Queue Status 
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Chapter Eight: 
MANUAL 

SCHEDULING 
 
 
 
 
 
 
 
 
 
 
 
 

In this chapter, the following topics are covered: 
 How to setup sections & assign students to sections 
 How to make changes to the student’s schedule in bulk 
 How to assign classes to students individually 
 How to assign a track to students in bulk 
 Where to see classes that have been deleted 
 How to enter the date for the end of the term 
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The Scheduling screens are either used to modify a student’s schedule after the completion 
of the mass scheduling process or used to create student schedules when the mass 
scheduling process is not used. For smaller districts, the manual scheduling process may 
be easier to use. To use the Scheduling screens to create student schedules, first create 
the sections using the Section screen. Once the course sections have been created, 
students can be assigned to sections using several different screens. 
 

CREATING SECTIONS 
 
To add a section to the school: 

1. Go to the Section screen, found under Synergy SIS > Schedule.  

 
Figure 8.1 – Section Screen 

2. Click the Add button at the top of the screen. A new Section screen pops-up. The 
fields highlighted in green are mandatory and must be entered. 
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Figure 8.2 – Section Screen, Adding 

3. If the Section ID is set to automatically generate by the option in the School 
Scheduling Options screen, it does not need to be entered. Otherwise, enter a 
unique Section ID. 

4. Select the Course ID by clicking on the gray arrow next to Course ID and selecting 
the course by using the Find Course screen. 

5. The Course Title populates based on the Course ID selected.  

6. Select the Staff Name by clicking on the gray arrow next to Staff Name and 
selecting the course by using the Find Staff screen. 

7. Select the Room Name by clicking on the gray arrow next to Room Name and 
selecting the course by using the Find School Room screen. 

8. If using tracks, select the Track assigned to the Section. 

9. Select the starting and ending period for the section from the Begin Period & End 
Period drop-down list. 

10. Select the Term Code assigned to the section from the drop-down list. 

11. Select how the section will be handled in the attendance and grading views from the 
Exclude Attendance and Exclude Grading drop-down lists. Attendance may be 
set to Include in Attendance, Include in Attendance – No Scan Sheet, or 
Exclude from Attendance. Grading may be set to Include in Grading, Include in 
Grading – No Scan Sheet, or Exclude from Grading. 

12. For schools taking daily attendance, the section can be designated as either a 
morning or afternoon section by selecting it from the AM PM drop-down list. It can 
be set to AM, PM or Both. 
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13. For schools taking positive attendance such as for Supplemental Funding or Area 
Learning Centers (ALC), select Positive from the Attendance Type. 

14. If the section is used for supplemental funding, select the funding category from the 
Supplemental Funding Category drop-down list. 

15. To override the number of instructional minutes assigned to this section by the Bell 
Schedule, enter the number of minutes to be used in the Instructional Minutes 
Override box. This may be needed for sections that meet over the lunch period. For 
example, if Period 4 in the bell schedule includes 30 minutes for lunch and 60 
minutes for the section, the section instructional minutes should be set to only 60. 

16. When Using Elementary Minutes is checked, the number of minutes submitted to 
the state for the section can be customized for each day of the week. A new section 
will appear on the Section screen above the Students grid with spaces to indicate 
the number of minutes for each weekday. 

 
Figure 8.3 – Elementary Minutes Section 

17. Select the Section Record Type to be used from the drop-down list.   
18. Select the Instructional Strategy to be used in the section from the drop-down list. 

These values can be customized by district in the Lookup Table Definition screen. 
19. Select the Instructional Method to be used in the section from the drop-down list. 

These values can be customized by district in the Lookup Table Definition screen. 
20. To override the category assigned to the district course, select the category from the 

Category Code Override drop-down list. 
21. Check the boxes to indicate if the section is a Distance Learning or Independent 

Study class. 
22. Select the College Credit to be used in the section from the drop-down list. These 

values can be customized by district in the Lookup Table Definition screen. 
23. To override the online course designation assigned to the district course, select the 

Online Course Override drop-down list. 
24. To override the state course, select the gray arrow next to the State Course 

Override field. 
25. Enter the Instructional Unit ID. 
26. Enter the Local Master Schedule ID. 
27. Enter the maximum number of students that can enroll in the class in the Max field 

in the Student Seat Totals section. Also indicate the maximum number of teacher 
aides for the class in the Max field in the Teacher Aide Seats section.  

28. To assign a Grade Book Specialist Group to the course, click the gray arrow next to 
the Grade Book Specialist Group field and select the appropriate group. 

29. To exclude the course from state reporting, select the Course Excluded From State 
Reporting checkbox.  To exclude or include just this section from State reporting, 
select yes or no from the Exclude From State Reporting drop-down.  

30. Select To restrict the section to students in a certain grade range, select the Grade 
Range Low and Grade Range High from the drop-down list. 
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31. To restrict the class to a particular gender (such as a physical education section), 
select the gender from the Gender Restriction drop-down list. 

32. To override the credit assigned to the course in the District Course screen, enter the 
number of credits for the section in the Credit field. 

33. To assign the section to a House and/or Team, select the values from the drop-
down list. For more information about Houses and Teams, see Chapter Four in this 
guide. 

34. Select the Term Exclusion from the drop-down list to assign the section to a Term 
Exclusion group. For more information about Term Exclusions, see Chapter Four in 
this guide. 

35. To prevent students from enrolling in the section during a term other than what is 
assigned to the section, check the No Term Override box. 

36. If this section should not be included in the mass scheduling process, check the box 
Exclude from Mass Scheduling. 

37. Select the staff member’s responsibility from the Responsibility drop-down and 
they Amount of time they spend in that role for this section. 

38. Select the attendance security to assign to the primary teacher and additional staff 
in the TeacherVUE Security section. For more information, please see the Synergy 
SIS - TEACHERVUE Administrator Guide. 

39. Click the Save button at the top of the screen to save the new section. 

Once the section has been created and students scheduled, the students currently enrolled 
in the section will be listed at the bottom of the Current Students tab. 
 

  

Note: If the course for which you created a section is an online or 
virtual course taught at a virtual or other school, select the virtual 
school and section in the Primary Section drop-down field on the 
Section screen and click Save.  This links both sections at the 
Home school and the Virtual school.  When a student adds or 
drops the class, both sections are updated.   
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Figure 8.4 – Section Screen, Students Added 

From here, the students can be withdrawn by entering a Leave Date and clicking the Save 
button at the top of the screen. The entire section can be deleted from the student’s 
schedule by clicking the box in the X column next to the student’s name and clicking the 
Save button. Students can also be assigned as the Teacher Aide by checking the box, or 
the student can audit this class by selecting Audit Class checkbox. A Term Override may 
be assigned to a student. Student who Qualifies for Alt Funding can be selected. 
Students may also be added to the section by clicking on the Chooser button and selecting 
the students using the Chooser screen. 
 
To add students to a section using the Section screen: 

1. Go to the Section screen, found under Synergy SIS > Schedule. 

2. Find the section using either the Scroll buttons or Find mode. 

3. Once the section is shown, scroll to the bottom of the screen and click on the 
Chooser button. 
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Figure 8.5 – Section Screen, Chooser Button 

4. The Chooser screen pops-up in a separate window. Enter the criteria to be used to 
select the students in the Find Criteria section and click the Find button. 

 
Figure 8.6 – Chooser Screen 

5. The students matching the criteria entered are then listed in the Find Result grid. 
Click on a student name to select them, and then click the Add Selected Row(s)> 
button. To add multiple students at a time, hold the CTRL button down while clicking 
on multiple student names to select them. To add all the students matching the 
criteria, click the Add All Row(s)>> button. 
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6. The student names are moved to the Selected Items grid. To remove a student from 
the Selected Items grid, click the box in the X column. When all the students needed 
are in the Selected Items grid, click the Select button to add them to the Students 
grid. 

7. Click the Save button at the top of the Section screen to save the added students. 

 
To see a list of students that have withdrawn from the section, click on the Student 
Enrollment History tab. Students that have been withdrawn from school are enclosed in 
parenthesis. 

 
Figure 8.7 – Section Screen, Student Enrollment History Tab 

 
Students can be permanently deleted from the section by clicking in the box in the X 
column and clicking the Save button at the top of the screen. To re-enroll the student in the 
section, delete the Leave Date and click the Save button at the top of the screen. 
 
If the school uses a rotating schedule and the section does not meet every day, the meeting 
days can be set on the Meeting Days tab. For more information about rotating schedules, 
please see the section on Period Rotation in Chapter Three. 

 
       Figure 8.8 – Section Screen, Meetings Days Tab 
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To set other section options and assign additional staff to the section: 

1. Click on the Additional Staff tab. 

 
                           Figure 8.9 – Section Screen, Additional Staff Tab 

2. Select the primary language used in the section from the Primary EL Language 
drop-down list. 

3. If more than one teacher shares the responsibility for teaching the class, the type of 
Team Teaching can be selected from the drop-down list. It can be set to either Job 
Share or Team Teaching. 

4. Select the grading security to assign to the primary teacher and additional staff in 
the TeacherVUE Security section. For more information, please see the Synergy 
SIS – TEACHERVUE Administrator Guide. 

5. To add additional staff to the section, click on the Chooser button and select the 
Staff to add using the Chooser screen. 

6. Once the staff has been added, the staff’s Class Role, Start Date, End Date, EL 
Language, Responsibility, Amount,  and TeacherVUE Security can be selected 
from the drop-down lists. To prevent the staff from being included in the state data 
upload, check the box Exclude from State Reporting. 

 
Figure 8.10 – Section Screen, Additional Staff 

7. To save the changes, click the Save button at the top of the screen. 

8. To remove a staff from this section, check the box in the X column and click the 
Save button at the top of the screen. 
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Additional staff (such as a substitute teacher) can be added to multiple sections at the same 
time. To add additional staff to multiple sections at the same time: 

1. Go to the Assign Additional Staff screen, found under Synergy SIS > Schedule. 

2. In the Step 1 group box, select the teacher who needs the substitute or additional 
staff assigned to their sections by clicking the gray arrow next to the Staff Name 
field. When a teacher is selected, the sections they teach populate the Select 
Sections Assignments grid. 

3. Enter a Start Date and End Date for which the teacher will need an additional staff 
member assigned.  A Start Date is required. 

4. In the step 2 group box, select the additional staff member by clicking the grey arrow 
next to the Staff Name field, which opens the Find: Staff screen. 

  

Note: If the staff member selected does not have a TeacherVUE 
user account, a message will display under the Staff Name field. 
If you would like the additional staff member to have access to 
the primary teacher’s TeacherVUE account, you will need to 
create an account for them in Synergy SIS. 

5. In the step 3 group box, you can assign the additional staff member a specific Class 
Role, indicates their EL Language, and/or give the additional staff member access 
to view or enter grades and attendance using TeacherVUE in the TXP Attendance 
and TXP Grades fields.  

  

Note: The items in step 3 are not required to complete the 
additional staff assignment. 

6. In the step 4 group box, select the sections the additional staff member will be 
assigned to in the Select Sections Assignments grid.  

7. Click the Assign Additional Staff button at the top of the screen. A notification 
appears informing the user that the selected additional staff member was added to 
the number of selected sections.  The additional staff member appears on the 
Additional Staff tab of the Section screen. 

 
  



Chapter Eight   Scheduling and Course Guide 
 

Copyright© 2013 Edupoint Educational Systems, LLC 221 

To see a list of staff members and additional staff members that have been assigned to the 
section, click on the Staff History tab. 
 

 
Figure 8.11 – Section Screen, Staff History Tab 

 
Staff members can be permanently deleted from the section by clicking in the box in the X 
column and clicking the Save button at the top of the screen. To re-assign the staff member 
to the section, delete the End Date and click the Save button at the top of the screen. 
 
To delete a section: 

1. Delete all students from both the Current Students and Student Enrollment 
History tab. 

2. Delete all the staff from the Additional Staff tab. 

3. Click the Delete button at the top of the screen. 

 
Figure 8.12 – Deleting a Section 

 
To edit the Section ID: 

1. Click on the Menu button at the top of the screen, and choose Edit Section Data. 

  
Figure 8.13 – Menu Options 

2. The Section ID box will turn white, and the information can be edited. 

 
Figure 8.14 – Section Screen, Editing Section ID 

3. Click the Save button at the top of the screen to save the changes. 
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The Class Student report for the student may also be printed from this screen by clicking 
on the Menu button, selecting Reports, and clicking on the Class Student report. The 
report pops-up as a PDF in a separate window. 
 

  
Figure 8.15 – Section Screen, Menu Options 

 
To update the totals in the Student Seat Totals and Teacher Aide Seats for the section: 

 

 
Figure 8.16 – Section Screen, Student Seat Totals & Teacher Aide Seats 

1. Click on the Menu button at the top of the page. 

 
Figure 8.17 - Menu Options 

2. Select Synchronize Section Totals to update the totals for the section in focus, or 
select Synchronize All Section Totals to update all sections at the school in focus. 
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If the section meeting days have been updated in the Section screen for schools with 
rotating periods, they need to be synchronized with the periods. To update the section 
meeting day periods: 

1. Click on the Menu button at the top of the page. 

 
Figure 8.18 - Menu Options 

2. Select Synchronize Section Meeting Day Periods. 

3. The Synchronize Section Meeting Day Period Options screen pops-up. Select from 
the Synchronize Option drop-down list to either Update All Sections or just 
Update Sections Without Meeting Days for those sections no longer using 
meeting days. 

 
Figure 8.19 – Synchronize Section Meeting Day Period Options Screen 

4. Click the Synchronize button to run the process. 

 
 
To quickly create a section with all of the same options as the section in focus 

1. Click on the Menu button at the top of the page. 

 
Figure 8.20 - Menu Options 

2. Select Duplicate Section. A new section windows pops-up with all of the same data 
as the section in focus. 
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Figure 8.21 – Duplicate Section 

3. Edit the section information as needed. To also duplicate the student enrollments, 
click the Load Student Enrollments from Duplicated Section button.  

4. Click the Save button at the top of the screen to save the new section. 

 
If the section’s staff members or additional staff members have been updated in the Section 
screen, the staff history can be synchronized for the current school in focus or across the 
entire district. To update the staff history: 

1. Click on the Menu button at the top of the page. 

 
Figure 8.22 - Menu Options 

2. Select Synchronize Staff History. 

3. The Synchronize Staff History Options screen opens. Select from the Synchronize 
all sections across the entire district checkbox to update all staff history in the 
district. 

  
Figure 8.23 – Synchronize Staff History Options Screen 

4. Click the Synchronize button to run the process. 
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If your school uses Grade Book, you can synchronize any changes that you have made to 
the section, so they also appear in Grade Book. To update class section in Grade Book with 
the changes made on the Section screen: 

 

1. Click on the Menu button at the top of the page. 

 
Figure 8.24 - Menu Options 

2. Select Synchronize Gradebook Class to update the class in Grade Book with the 
changes. 
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ASSIGN MULTIPLE STUDENTS TO SECTIONS 
Two screens can be used to assign sections to multiple students at a time. One is the 
Assign Students to Sections screen. The other is the Class Assignment screen. To assign 
sections, or classes, to multiple students at a time using the Assign Multiple Students to 
Sections screen: 

1. Go to the Assign Students To Sections screen, found under Synergy SIS > 
Schedule. 

2. To assign one section to a group of students, use the By Student tab. Select the 
section to be assigned by clicking on the gray arrow next to Section ID. 

 
Figure 8.25 – Mass Assign Sections Screen 

3. The Find Section screen pops-up. Enter some or all of the criteria at the top of the 
screen and click the Find button to find all the sections that meet the criteria 
entered. 

 
Figure 8.26 – Find Section Screen 

4. Click on the section to schedule in the Find Results list, and click the Select button. 
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Figure 8.27 – Find Section Screen, Find Results 

5. Enter the Start Date to be entered for the section in the students’ schedules. The 
date can be entered in MM/DD/YY format or it can be selected by clicking on the 
Calendar  button. 

 
Figure 8.28 – Assign Students To Sections Screen 

6. To prevent scheduling conflicts, check the box labeled Don’t Allow Overlapping 
Sections. 

7. Select the students to be assigned to the section by clicking the Chooser button. 

8. The Chooser screen pops-up. Enter the information known about the students to be 
assigned in the Find Criteria section, and click the Find button at the top of the 
screen. The students may be found using any part of the criteria, including last 
name, first name, middle name, perm ID, grade or gender. Partial information may 
be used as well, such as the first letters of a last name or first name. 
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Figure 8.29 – Chooser Screen, Results 

9. Once the Find button clicked, a list of students that match the criteria appears in the 
Search Results section. Click on the name or names of the student(s) to add and 
click the Add Selected Row(s) button to add the student(s) to the Selected Items 
section. Multiple searches may be made until all students have been found and 
added to the Selected Items section. Multiple rows may be selected by holding 
down the Ctrl key and clicking on all the students needed. To remove a student from 
the Selected Items section, click the box under X column. To add all of the students 
found in the Search Results list to the Selected Items section, click the Add All 
Row(s) button. 

 
Figure 8.30 – Chooser Screen, Selected Items Section 

10. Once all of the students to be assigned have been selected, click the Select button 
at the top of the screen to add them to the screen. 

11. To assign the students to the section, click the Assign Students to Section button 
at the top of the screen. 

 
Figure 8.31 – Assign Students to Section Screen 
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To replace existing section assignments with a new assignment or add new sections to the 
student schedule: 

1. Click on the By Section tab of the screen 

 
Figure 8.32 – Assign Students To Sections Screen, By Section Tab 

2. Select how the current section assignment will be handled from the Student Action 
drop-down list. Copy leaves the existing section in the schedule and just adds the 
matching section. Drop withdraws the student from the existing section, and Move 
deletes the student from the existing section. 

3. Enter the leave date for the existing section in the Date to Withdraw Students field 
in MM/DD/YY format. The date may also be selected by clicking the Calendar  
button. 

4. Enter the start date for the new section in the Date to Enroll Students field in 
MM/DD/YY format. The date may also be selected by clicking the Calendar  
button. 

5. Enter the From Section Pattern to match to the existing section ID. The pattern 
may match a section ID exactly by entering the full section ID such as 1077, or it 
may match only part of the ID such as all section ID starting with 1. The question 
mark is used as a placeholder to match any character, so a match on all section ID 
starting with 1 would be entered as 1????? for a section ID with 6 characters. 

6. Enter the To Section Pattern to match the new section ID. The pattern may match 
a section ID exactly by entering the full section ID such as 1077, or it may match 
only part of the ID such as all section ID starting with 1. The question mark is used 
as a placeholder to match any character, so a match on all section ID starting with 1 
would be entered as 1????? for a section ID with 6 characters. 

7. Click the Process button at the bottom of the screen to make the new assignments. 
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Classes, or sections, may be assigned to students in bulk by using the Class Assignment 
screen as well. To us the Class Assignment to assign classes to several students at once: 

1. Go to the Class Assignment screen, found under Synergy SIS > Schedule 

 
Figure 8.33 – Class Assignment Screen 

2. Select the students to assign to a section by entering some criteria in the Student 
filters section. To select all students at a certain grade level, check the Grades. The 
students can also be filtered by Last Name, First Name, or Gender. To list all 
students that have not been assigned to any sections, check the box for Unassigned 
Only. Once all of the criteria have been added, click the Filter Students button. 

3. Select the sections to be assigned by entering criteria in the Teacher Filters 
section. To select all sections offered to a certain grade level, check the Grades. Or 
sections can be found by the teacher’s Last Name and/or First Name. Click the 
Filter Sections button to list the sections that match the criteria entered. 

 
Figure 8.34 – Class Assignment Screen, Students and Sections Listed 

4. Adjust the enter date to be used for the section assignment by editing the default 
value in the Enter Date field or selecting it by using the Calendar  button. 

5. Check the box in the Add column of the students to add to the section. Click the 
Add button next to the section, and the students will be added to the section. 
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INDIVIDUALLY ASSIGNING CLASSES 
Classes can be assigned to an individual student through two views. They can be modified 
or added using the Student Classes screen or via the Classes tab of the Student screen. To 
modify the student’s class schedule using the Student Classes screen: 

1. Go to the Student Classes screen, found under Synergy SIS > Schedule. 

2. To add a single class, click the Add button and select the class using the Find 
Section screen. 

 
Figure 8.35 - Student Classes Screen 

3. To add multiple classes, click the Chooser button and select the class using the 
Chooser screen. 

4. Once a class has been added, if the student is repeating the course that can be 
indicated by selecting a Repeat Tag.  If the student can receive college credit for 
the course, indicate that in the College Credit drop-down field. the student may be 
made a Teacher Aide in the class by checking the box. If the student is auditing the 
class select the Audit Class checkbox. To override the term for which the student 
will attend the class, select the term from the Term Override column. If the student 
qualifies for alternative funding, check the box in the Qualifies for Alt Funding 
column. 

5. To drop a class from the student’s schedule or to filter the list of classes, maximize 
the Drop Class and Filter Options section by clicking on the Maximize button. 

6. To drop a class from the student’s schedule or to filter the list of classes, maximize 
the Drop Class and Filter Options section by clicking on the Maximize button. 

 
Figure 8.36 - Maximize Button 

7. To drop a class, enter a Leave Date in MM/DD/YY format or select a date using the 
Calendar  button. Click on the line number of the class to drop in the Current 
Class Schedule list, and click the Drop Selected Classes button. Multiple classes 
may be selected by holding down the CTRL key 
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     Figure 8.37 – Student Classes Screen, Drop Class and Filter Options 

8. To filter the list of classes, select the terms to display from the Display Term drop-
down list. If a rotating schedule is used, the Meeting Day can also be selected from 
the drop-down list. Once the selections are made, click the Filter button. 

9. To see the list of classes that have been dropped from the student’s schedule, click 
on the Class Enrollment History tab. 

 
Figure 8.38 – Student Classes Screen, Class Enrollment History 

10. The current Class Schedule report for the student may also be printed from this 
screen by clicking on the Menu button, selecting Reports, and clicking on the Class 
Schedule report. The report pops-up as a PDF in a separate window. 

 
Figure 8.39 – Student Classes Screen, Menu Options 
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The student’s schedule may also be modified from the Classes tab of the Student screen. 
To modify the student’s schedule from the Student screen: 

1. Go to the Student screen, found under Synergy SIS > Student. 

2. Find the student schedule to modify using either the Scroll buttons or Find mode. 

3. Once the student has been located, click on the Classes tab. 

 
Figure 8.40 – Student Screen, Classes Tab 

4. To add a single class to the student’s schedule, click the Add button and select the 
class using the Find Section screen. 

5. To add multiple classes to the student’s schedule, click the Chooser button to use 
the Chooser screen to select multiple classes. 

6. Once a class has been added, if the student is repeating the course that can be 
indicated by selecting a Repeat Tag.  If the student can receive college credit for 
the course, indicate that in the College Credit drop-down field. the student may be 
made a Teacher Aide in the class by checking the box. If the student is auditing the 
class select the Audit Class checkbox. To override the term for which the student 
will attend the class, select the term from the Term Override column. If the student 
qualifies for alternative funding, check the box in the Qualifies for Alt Funding 
column. 

7. To drop a class from the student’s schedule, enter the Leave Date for the class. 

8. Click the Save button at the top of the screen to save the changes. 

9. To delete a class from the student’s schedule, enter the Leave Date for the class 
and click the Save button at the top of the screen. Then check the box in the X 
column and click the Save button again. 
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MASS ASSIGNING TRACKS 
 
For schools that use tracks, tracks may be assigned to the students in bulk. To assign 
tracks to all of the students in the school: 

1. Go to the Mass Assign Track screen, found under Synergy SIS > Schedule. 

 
Figure 8.41 – Mass Assign Track 

2. Select the Period and Term Code for the class in each student’s schedule that 
indicates the track assigned to the student. By default, the period shown is the 
homeroom period entered on the School Setup screen. 

3. Click the Update Track button. 

ASSIGNING HOMEROOMS 
To assign homerooms to students: 

1. Go to the School Setup screen, found under Synergy SIS > System > Setup. 

 
Figure 8.42 – School Setup Screen 

2. Enter the number of the period assigned as the Homeroom Period. 

3. For schools with rotating schedules, select the Homeroom Meeting Day. 

4. Click the Save button at the top of the screen to save the changes. 

 
  



Chapter Eight   Scheduling and Course Guide 
 

Copyright© 2013 Edupoint Educational Systems, LLC 235 

The homeroom assignments may need to be updated periodically; for example, at the 
beginning of a new term. To update the Homeroom assignment: 

1. From the School Setup screen, click on the Menu button and select Update 
Homeroom Data. 

 
Figure 8.43 – Menu Options, Update Homeroom Data 

2. When the process is complete, a message box pops-up listing the number of 
students updated. Click OK to close the message box. 

 
Figure 8.44 – Message Box 

 
To clear all homeroom assignments: 

1. From the School Setup screen, click on the Menu button and select Clear 
Homeroom Data. 

 
Figure 8.45 – Menu Options, Clear Homeroom Data 
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TRACKING DELETED CLASSES 
 
If desired, classes that have been completely deleted from the student schedules can be 
tracked for the Add/Drop Report. To turn this function on, check the Track Class Deletions 
for Add/Drop Report box in the School Scheduling Options screen. This option needs to 
be selected for each school that needs to track deleted classes. 
 

 
Figure 8.46 – School Scheduling Options Screen 

 
To screen the deleted classes: 

1. Go to the Student Classes Deleted screen, found under Synergy SIS > Schedule. 

 
Figure 8.47 – Student Classes Deleted Screen 

2. Each deleted class lists the period assigned, the date the class was deleted, the 
date the class was ended for the student, the term code, and the details of the 
section and course. 

3. Note that classes will only be tracked if a leave date was entered for the class 
before it was deleted. If the class had no leave date when it was deleted, it will 
not appear in the screen. 

4. To remove a class from the screen, check the box in the X column and click the 
Save button at the top of the screen. 
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ENDING TERMS 
 
At the end of each term, each class in the student’s schedule needs to have a leave date 
entered to indicate the student is no longer enrolled in the class. To automatically enter the 
leave date for all classes: 

1. Go to the End Term screen, found under Synergy SIS > Schedule. 

 
Figure 8.48 – End Term Screen 

2. Select the Term to Process from the drop-down list. 

3. Click the Process End Term button. The last day of the selected term will be 
entered as the leave date for all classes that are scheduled for the term. 
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Chapter Nine:
REPORTS 

 
 
 
 
 
 
 
 
 
 
 
 

In this chapter, the following topics are covered: 
 Printing scheduling-related reports 
 Customizing scheduling-related reports 
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AVAILABLE REPORTS 
 
The available reports for Courses, Mass Scheduling and Schedule are found under the 
Synergy SIS Course, Mass Scheduling & Schedule folders. There are four types of reports 
available – Extracts, Individual, List, and Summary. Extracts pull information from Synergy 
SIS in a text file that can then be imported into another program. Individual Reports print 
out information about a single student per page, but can be printed for multiple students at 
one time. List Reports generate summaries for multiple students. Summary Reports 
present numerical report summaries. 
 

COURSE REPORTS 
 
To access the available Course reports: 

1. Open the Synergy SIS Navigation Tree by clicking on the Tree button. 

 
Figure 9.1 – Synergy SIS Navigation Tree 

2. Expand the Synergy SIS folder by clicking on the blue triangle pointing right, next to 
the word Synergy SIS. Once clicked, the triangle turns green and points downward. 

 
Figure 9.2 – Synergy SIS Folder 

 

 
Figure 9.3 – Synergy SIS Folder Expanded 

3. Under the Synergy SIS folder, open the Course folder by clicking on the blue 
triangle pointing right, next to the word Course. Once clicked, the triangle turns 
green and points downward. 

 
Figure 9.4 – Course Folder 

 

 
Figure 9.5 – Course Folder Expanded 



Scheduling and Course Guide   Chapter Nine 
 

240 Copyright© 2013 Edupoint Educational Systems, LLC 

4. Under the Course folder, open the Reports folder by clicking on the blue triangle 
pointing right, next to the word Reports. Once clicked, the triangle turns green and 
points downward. 

 
Figure 9.6 – Reports Folder 

 

 
Figure 9.7 – Reports Folder Expanded 

5. To access the Individual reports, click on the blue triangle next to the word 
Individual. To access the List reports, click on the blue triangle next to the word List. 
To access the Summary reports, click on the blue triangle next to the word 
Summary 

 
Figure 9.8 – Individual, List & Summary 

Folders 

 

 
Figure 9.9 – Individual, List & Summary Folders 

Expanded 

6. Click on the name of the report to open the report and select the options to be used 
in printing the report. 

7. Once the report options have been set, click on the Print button to print the report. 
The report is printed as a PDF file to the screen, which can then be sent to the 
printer. 

  

Reference: This chapter covers only the customizations specific to each 
of the reports used in Courses, and the additional options available on the 
other tabs are explained in the manual titled Synergy SIS – Queries & 
Reports Guide. 
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CRS201 – Course Catalog 
 
The Course Catalog lists all of the courses with their description, ID, credit, and grade level. 
 

 
Figure 9.10 – Course Catalog 
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The report can be customized using the following options: 
 

 
Figure 9.11 – Course Catalog, Report Interface 

• The catalog can be filtered to only display a range of Course ID by entering the 
range in the Course ID boxes. 

• The catalog can also be filtered so that the only courses included match all or 
part of the title of a course, as entered into the Course Title box. 

• The catalog can also be set to only display the courses from a particular 
Department by selecting it from the drop-down list. 

• If checked, Only Show Inactive Courses limits the catalog to only those 
courses marked as inactive on the District Course screen. 

• If checked, Page Break per Department starts each department’s list of 
courses on a new page. 

• If checked, Include Courses in Focus Only would only include the courses 
listed as “opt-in” for the school in focus. 

• If checked, Hide Grades, Hide College Prep or Hide Credit, would exclude 
these items on the report. 
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CRS401 – Course List 
 
The Course List shows all of the courses with their ID, Title and Department. It also displays 
if the course is a College Prep course or not, the Credit awarded for completion of the 
courses, the Academic Type of the course, and if the course is a Core or Elective. 
 

 
Figure 9.12 – Course List 
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The report can be customized using the following options: 
 

 
Figure 9.13 – Course List, Report Interface 

• The list can be filtered to only display a range of Course ID by entering the 
range in the Course ID boxes. 

• The list can also be filtered so that the only courses included match all or part of 
the title of a course, as entered into the Course Title box. 

• The list can also be set to only display the courses from a particular Department 
by selecting it from the drop-down list. 

• If checked, Only Show Inactive Courses limits the list to only those courses 
marked as inactive on the District Course screen. 

• If checked, Include Courses in Focus Only includes the courses listed as “opt-
in” for the school in focus. 
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CRS601 – Course By School Report 
 
The Course By School report is a simplified list of courses showing only the ID and title of 
each course, sorted by the school offering each course. 
 

 
Figure 9.14 – Course By School Report 
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The report can be customized using the following options: 
 

 
Figure 9.15 – Course By School, Report Interface 

 

• If checked, Include Courses in Focus Only includes the courses listed as “opt-
in” for the school in focus. 

• If courses for more than one school are included in the report (if Include Courses 
in Focus Only is not checked), a page break can be inserted so that each 
school’s list starts on a new page by checking Page Break per School. 
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MASS SCHEDULING REPORTS 
 
To access the available Mass Scheduling reports: 

1. Open the Synergy SIS Navigation Tree by clicking on the Tree button. 

 
Figure 9.16 – Synergy SIS Navigation Tree 

2. Expand the Synergy SIS folder by clicking on the blue triangle pointing right, next to 
the word Synergy SIS. Once clicked, the triangle turns green and points downward. 

 
Figure 9.17 – Synergy SIS Folder 

 

 
Figure 9.18 – Synergy SIS Folder 

Expanded 

3. Under the Synergy SIS folder, open the Mass Scheduling folder by clicking on the 
blue triangle pointing right, next to the words Mass Scheduling. Once clicked, the 
triangle turns green and points downward. 

 
Figure 9.19 – Mass Scheduling Folder 

 

 
Figure 9.20 – Mass Scheduling Folder 

Expanded 

4. Under the Mass Scheduling folder, open the Reports folder by clicking on the blue 
triangle pointing right, next to the word Reports. Once clicked, the triangle turns 
green and points downward. 

 
Figure 9.21 – Reports Folder 

 

 
Figure 9.22 – Reports Folder Expanded 

5. To access the Individual reports, click on the blue triangle next to the word 
Individual. To access the List reports, click on the blue triangle next to the word List. 
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To access the Summary reports, click on the blue triangle next to the word 
Summary 

 
Figure 9.23 – Individual, List & 

Summary Folders 

 

 
Figure 9.24 – Individual, List & Summary Folders Expanded 

6. Click on the name of the report to open the report and select the options to be 
used in printing the report. 

7. Once the report options have been set, click on the Print button to print the report. 
The report is printed as a PDF file to the screen, which can then be sent to the 
printer. 

  

Reference: For more information about customizing all 
Synergy SIS reports, please refer to the manual titled 
Synergy SIS – Queries & Reports Guide. This chapter 
covers only the customizations specific to each of the 
reports used in Mass Scheduling, and more options can be 
set for any report printed from Synergy SIS. 
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OSM201 – Student Schedule Analysis 
 
The Student Schedule Analysis report lists all scheduled and requested classes for the 
students in the selected option set. The report also shows any schedule conflicts and the 
alternate periods available for each class. A indicates the class is available in the period, F 
indicates the class is taught in the period but is currently full, and a number indicates the 
period that would be scheduled for the class. 
 

 
Figure 9.25 - Student Schedule Analysis 
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The report can be customized using the following options: 
 

 
Figure 9.26 - Student Schedule Analysis, Report Interface 

 

• The Option Set used for the analysis can be selected from the drop-down list. 
Only option sets for the year and school in focus are available. 

• The Students to Print used for the analysis can be selected from the drop-
down list. All Students, Conflict Free Only or Schedule Conflicts Only are 
available. 

• The One Student Per Page checkbox prints each student on a separate page. 
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STU205 – Student Course Request Profile 
 
The Student Course Request Profile lists all course requests for a student as well as any 
alternate course requests. The report also lists the house and team to which the student is 
assigned, if any. 
 

 
Figure 9.27 - Student Course Request Profile 
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The report can be customized using the following options: 
 

 
Figure 9.28 - Student Course Request Profile, Report Interface 

 

• An individual student or group of students can be selected by filtering on the 
Perm ID, Gender, Last Name, First Name, Middle Name, or Grade. For 
example, if grade 12 is selected the report prints an individual report for each 
student in grade 12. A range of grades may also be selected. 

• The report options can be used to filter the various information displayed for 
each student, including Hide Alternate Courses, Hide Alternate Course 
Requests, Show Add/Drop Signature Footer, Only Show Students with 
Missing Prerequisites, Show Prerequisite Violations, Show Course Credit,  
and Show Course Term. 

• The Show Extended Student Data checkbox prints additional student data.  
Select the Current Enrollment Year is the year from which the data will be 
pulled.  This report is run in the new year, and users can select if they would like 
the enrollment information to print from the current year or the new year. 

• Select to whom the report will be sent in the Parent/Guardian Options group 
box.  The options include Lives With, Contact Allowed, Ed. Rights, Has 
Custody, and Mailings Allowed.   
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OSM401 – Schedule Section List by Teacher 
 
The Schedule Section List by Teacher lists all sections that are created for each teacher for 
the selected option set, and summarizes the maximum number of students in each section, 
the total number of students scheduled for each section, and the number of spaces open in 
each section. 
 

 
Figure 9.29 - Schedule Section List by Teacher 
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The report can be customized using the following options: 
 

 
Figure 9.30 - Schedule Section List by Teacher, Report Interface 

• The Option Set used for the analysis can be selected from the drop-down list. 
Only option sets for the year and school in focus are available. 

  

Note: The Schedule Section List by Teacher automatically sorts 
by teacher, term, period, and section.  You can change the sort 
order on the Sort/Output tab. 



Chapter Nine   Scheduling and Course Guide 
 

Copyright© 2013 Edupoint Educational Systems, LLC 255 

OSM402 – Schedule Section List by Room 
 
The Schedule Section List by Room lists all sections scheduled for each room. For each 
section, the report shows the staff assigned, the total number of students scheduled, and 
the number of students broken down by gender. 
 

 
Figure 9.31 - Schedule Section List by Room 
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The report can be customized using the following options: 
 

 
Figure 9.32 - Schedule Section List by Room, Report Interface 

• The Option Set used for the analysis can be selected from the drop-down list. 
Only option sets for the year and school in focus are available. 
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OSM403 – Schedule Section List by Course 
 
The Schedule Section List by Course lists all sections scheduled by the selected option set 
for each course. For each course and section, the report also shows the staff and room 
assigned, the maximum number of students that can be scheduled, and the total number of 
students currently scheduled. 
 

 
Figure 9.33 - Schedule Section List by Course 
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The report can be customized using the following options: 
 

 
Figure 9.34 - Schedule Section List by Course, Report Interface 

• The Option Set used for the analysis can be selected from the drop-down list. 
Only option sets for the year and school in focus are available. 
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OSM404 – Class Analysis by Period and Course 
 
The Class Analysis by Period and Course lists the results of the option set for each course. 
The report shows the total number of seats available for each course, how many students 
requested the course, how many students would be scheduled for the course, and the 
number of open seats. It also lists the overall average course requests per section for each 
course, and breaks down this average by gender and grade level. 
 

 
Figure 9.35 - Class Analysis by Period and Course 
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The report can be customized using the following options: 
 

 
Figure 9.36 - Class Analysis by Period and Course, Report Interface 

• The Option Set used for the analysis can be selected from the drop-down list. 
Only option sets for the year and school in focus are available. 



Chapter Nine   Scheduling and Course Guide 
 

Copyright© 2013 Edupoint Educational Systems, LLC 261 

OSM405 – Schedule Section List 
 
The Schedule Section List shows all sections created by the selected option set. For each 
section, the report lists the schedule period and term, the room and staff assigned, the total 
number of seats available, and the total number of students scheduled for the section. 
 

 
Figure 9.37 - Schedule Section List 
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The report can be customized using the following options: 
 

 
Figure 9.38 - Schedule Section List, Report Interface 

• The Option Set used for the analysis can be selected from the drop-down list. 
Only option sets for the year and school in focus are available. 
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OSM406 – Schedule Open Periods 
 
The Schedule Open Periods report lists all students in alphabetical order by last name, and 
displays any periods not scheduled for the student for the selected option set by period 
number. If a period displays a + sign, a class has been scheduled for the student. 
 

 
Figure 9.39 - Schedule Open Periods 
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The report can be customized using the following options: 
 

 
Figure 9.40 - Schedule Open Periods, Report Interface 

• The Option Set used for the analysis can be selected from the drop-down list. 
Only option sets for the year and school in focus are available. 

• To show only information about select grades, check the Grades to be included 
in the report. To check or uncheck all grades, use the  buttons. 

• To show only information about select terms, check the Terms to be included in 
the report. To check or uncheck all terms, use the  buttons. 

• Select the range of periods to be included by entering the first period of the 
range in the Start box and the last period in the End box. 
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OSM407 – Course Request Conflict Listing 
 
The Course Request Conflict Listing lists each course and shows what courses are 
scheduled during the same period. It also shows the number of course requests for each 
course and each conflicting course. 
 

 
Figure 9.41 – Course Request Conflict Listing 
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The report can be customized using the following options: 
 

 
Figure 9.42 – Course Request Conflict Listing, Report Interface 

• Check the box to Show Course Titles as well as the Course IDs in the report. 
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OSM408 – Class Analysis by Course and Section 
 
The Class Analysis by Course and Section report lists each course and shows the sections 
scheduled for the course. For each section and course, the report lists the number of 
students scheduled both overall and by gender, the total number of spaces available, the 
number of requests, and the average number of students scheduled in a section. 
 

 
Figure 9.43 – Class Analysis by Course and Section 
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The report can be customized using the following options: 
 

 
Figure 9.44 – Class Analysis by Course and Section 

• The Option Set used for the analysis can be selected from the drop-down list. 
Only option sets for the year and school in focus are available. 

• Check the box labeled Show Only Courses That Have More Requests Than 
Availability so that the report only lists courses that need more sections. 

• Check the box labeled Show House so that the report also shows house 
assignments. 
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OSM409 – Student Course Request Verification Listing 
 
The Student Course Request Verification Listing lists each student and shows the course 
requests submitted for each student. 
 

 
Figure 9.45 - Student Course Request Verification Listing 
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The report can be customized using the following options: 
 

 
Figure 9.46 - Student Course Request Verification Listing, Report Interface 

• To show only information about select grades, check the Grades to be included 
in the report. To check or uncheck all grades, use the  buttons. 

• To screen the report for a single course, enter the Course ID. 
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OSM411 – Class List 
 
The Class List lists all students that are in a class. This list will show the list of students in a 
class and the list may contain information selected through the report interface. 
  

 
Figure 9.1 - Class List 
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The report can be customized using the following options: 
 

 
Figure 9.2 – Class List Report Interface 

 
 
  

• The Option Set used for the report can be selected from the drop-down list. Only option 
sets for the year and school in focus are available. 

• The report can be printed for a single term by selecting the term from the Term Code 
drop-down list. 

• To print the report for a specific range of sections, enter the beginning and ending 
section ID in the Class ID boxes. 

• To print the report for a specific range of grades, select the beginning and ending Grade 
Range from the drop-down list. 

• To print the report for a specific teacher, select the Teacher from the drop-down list. 

• To Hide Totals on this list, select the check box. 

• Include the Following Fields: Perm ID, State ID, Gender, Grade, Ethnic Code, Birth 
Date, Home Language, or Phone Number. 
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OSM414 – Schedule by Department  
 
The Schedule by department is a graphical look at the schedule bases on a specific option 
set. This report is grouped by department, and shows the teacher, room, and period. 
  

 
Figure 9.3 – Schedule by Department List 
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The report can be customized using the following options: 
 

 
Figure 9.4 – Schedule by Department Report Interface 

• The Option Set used for the report can be selected from the drop-down list. 
Only option sets for the year and school in focus are available. 

• Enter the date for which to analyze the periods in the As of Date box in 
MM/DD/YY format. The dates can also be selected using the Calendar button. 

• Select the range of periods to be included by entering the first period of the 
range in the Period Begin box and the last period in the Period End box. 

• To filter the courses displayed on the report by their Department, check which 
Departments to display 
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OSM415 – Schedule by Room  
 
The Schedule by Room is a graphical look at the schedule based on a specific option set. 
This report is grouped by room, and shows which teacher is in the room for each period.  It 
also lists when the classroom is open or if it is scheduled for a study hall. 
  

 
Figure 9.5 – Schedule by Room List 
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The report can be customized using the following options: 
 

 
Figure 9.6 – Schedule by Room Report Interface 

• The Option Set used for the report can be selected from the drop-down list. 
Only option sets for the year and school in focus are available. 

• Enter the date for which to analyze the periods in the As of Date box in 
MM/DD/YY format. The dates can also be selected using the Calendar button. 

• Select the range of periods to be included by entering the first period of the 
range in the Period Begin box and the last period in the Period End box. 

• To filter the courses displayed on the report by their Department, check which 
Departments to display. 

• To indicate which classroom is considered small enter the maximum number of 
students for a small class in the Size limit for “small” classroom field. 

• To indicate which classes are used as a study hall, select the course type from 
the Course type to show as Study Hall group box. 
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OSM416 – Sections Needed by Request  
 
The Sections Needed by Requests report show the numbers of sections needed based on 
the total number of course requests.  It shows the maximum and optimum number of 
students per section based on the definitions entered in the District Course or School 
Course. 
  

 
Figure 9.7 – Sections Needed by Request Report 
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The report can be customized using the following options: 
 

 
Figure 9.8 – Sections Needed by Request Report Interface 

• To print the report for a range of course, enter the beginning and ending Course 
ID. 

• Enter the Course Title the report should print results for. 

• To display the linked courses together, select the option from the Linked 
Course Display field.  The option are None to not display any linked courses 
(default), Primary Linked Only lists only the primary course from each link, and 
All Linked lists all the linked courses.   

• Check the Use Student Count Levels from District box to only use the 
maximums and optimum class size numbers from the district course.  
Otherwise, the report looks at the school course first for maximum and optimum 
class sizes.  If they are blank, then it will look at the district course.    
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OSM417 – Department Section List  
 
The Department Section List displays all the sections in an option set by department. This 
report is grouped by department, teacher, term, period, section, course id, meeting day, and 
room.  It also displays the maximum, total, and open number of seats for each section. 
  

 
Figure 9.9 – Department Section List 
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The report can be customized using the following options: 
 

 
Figure 9.10 – Department Sections List Report Interface 

• Select the Option Set for which to run the report.  This field is required.  

• Select the Department from the drop-down list to print the list for just one 
department. 

• To only include a range of rooms, enter the first and last Room Name. The 
rooms are listed numerically then alphabetically.  

• Select the range of class periods levels to be included by selecting the Period 
from the drop-down list. 

• Select the Staff from the drop-down list to print the list for just one teacher. 

• Select the Subject Area from the drop-down list to print the list for just one 
subject. 
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OSM418 – Room Section List  
 
The Room Section list displays all the sections in an option set that are taught in a 
particular room. This report is grouped by room, department, term, period, section, course 
id, and meeting days.   It also displays the maximum, total, and open number of seats for 
each section. 
 

 
Figure 9.11 – Room Section List 
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The report can be customized using the following options: 
 

 
Figure 9.12 – Room Section List Report Interface 

• Select the Option Set for which to run the report.  This field is required.  

• Select the Department from the drop-down list to print the list for just one 
department. 

• To only include a range of rooms, enter the first and last Room Name. The 
rooms are listed numerically then alphabetically.  

• Select the range of class periods levels to be included by selecting the Period 
from the drop-down list. 

• Select the Staff from the drop-down list to print the list for just one teacher. 

• Select the Subject Area from the drop-down list to print the list for just one 
subject. 
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OSM470 – Pre Schedule Edit List 
 
The Pre Scheduled Edit List lists all students that show an error in their schedules. 
 

 
Figure 9.47 - Pre Schedule Edit List 
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The report can be customized using the following options: 
 

 
Figure 9.48 - Pre Schedule Edit List, Report Interface 

• The Option Set used for the report can be selected from the drop-down list. 
Only option sets for the year and school in focus are available. 

• A Minimum Number of Periods must be entered to list all students that have 
requested at least the number of courses. 
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OSM601 – Course Request Totals 
 
The Course Request Totals lists each course department and shows each course in the 
department. For the course and department, the report lists the total number of student’s 
requests with breakdowns by gender and grade level. 
 

 
Figure 9.49 - Course Request Totals 
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The report can be customized using the following options: 
 

 
Figure 9.50 - Course Request Totals, Report Interface 

• To show only information about select grades, check the Grades to be included 
in the report. To check or uncheck all grades, use the  buttons. 



Chapter Nine   Scheduling and Course Guide 
 

Copyright© 2013 Edupoint Educational Systems, LLC 287 

OSM602 – Student Request Exception 
 
The Student Request Exception report lists any students with fewer course requests than 
selected for the report, or fewer credits than selected for the report. 
 

 
Figure 9.51 - Student Request Exception 
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The report can be customized using the following options: 
 

 
Figure 9.52 - Student Request Exception, Report Interface 

• Select the grade or range of grades to be included by selecting them in the 
Grade fields. 

• To show only information about select terms, check the Term Definition to be 
included in the report. To check or uncheck all terms, use the  buttons. 

• Select the Request Filter Type.  The options include Use Course Request 
Totals and Credits or Use Period Range.  Additional fields are available 
depending on the Request Filter Type selected. 

o Use Course Request Totals and Credits 
 Enter the minimum number of course requests required for each 

student in the Students With Less Than the Following 
Requests. 

 Enter the maximum number of course requests allowed for each 
student in the Students with greater than the following 
requests. 

 Enter the minimum number of credits required for each student in 
the Students With Less Than the Following Credits. 

 Enter the maximum number of credit allowed for each student in 
the Students with greater than the following credits.  

 Select the Total Course Requests Made to filter the results 
displayed. 

• Show all students 

• Show students with the correct number of requests 
only 
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• Show students with too few or too many requests 
only 

• Show students with too few requests only 

• Show students with too many requests only 
o Use Period Range 

 Select the period or range of periods to be included by selecting 
them in the Number of Periods fields. 

• Select Display Feeder Schools to display the last school within the district that 
the student attended.  If the student is new to the district, the feeder school 
column is blank. 
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OSM603 – Open Periods by Grade and Period 
 
The Open Periods by Grade and Period report lists the number of students not scheduled 
during a specific period for a specific period based on an option set.  It also shows if 
students are over scheduled in a specific period. 
 

 
Figure 9.53 – Open Periods by Grade and Period 
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The report can be customized using the following options: 
 

 
Figure 9.54 – Open Periods by Grade and Period, Report Interface 

• The Option Set used for the report can be selected from the drop-down list. 
Only option sets for the year and school in focus are available. 

• To show only information about select terms, check the Term Definition to be 
included in the report. To check or uncheck all terms, use the  buttons. 

• To show only information about select periods, check the Period List to be 
included in the report. To check or uncheck all periods, use the  buttons. 

• To show only information about select grades, check the Grade List to be 
included in the report. To check or uncheck all grades, use the  buttons. 

• To show the totals for each gender in period, check the Show Gender Totals 
check box. 
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OSM801 – Course Request Conflict Matrix 
 
The Course Request Conflict Matrix lists each course and shows the course ID for the 
courses that conflict with the course. 
 

 
Figure 9.55 - Course Request Conflict Matrix 
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The report can be customized using the following options: 
 

• Enter the Number of Requests 
per course, and the report lists all 
courses with that range of 
requests. This is a required 
criterion for the report, but 0 can 
be entered. 

• Select the Course Group from 
the drop-down list to filter the 
courses listed in the report. 
Course Groups are defined in the 
Course Group screen, as 
outlined in Chapter 1. 

• To filter the courses displayed on 
the report by their Academic 
Type, check which Academic 
Types to display. To check or 
uncheck all types, use the  
buttons. 

• To filter the courses displayed on 
the report by their Department, 
check which Departments to 
display. To check or uncheck all 
departments, use the  
buttons. 

• To show only course that have 
been requested, check the Show 
Only Requested Courses. 

• To filter the courses displayed on 
the report by their Course 
Subject Areas, check which 
Subject Areas to display. 

 
Figure 9.56 - Course Request Conflict Matrix, Report 

Interface 
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SCHEDULE REPORTS 
 
To access the available Schedule reports: 

1. Open the Synergy SIS Navigation Tree by clicking on the Tree button. 

 
Figure 9.57 – Synergy SIS Navigation Tree 

2. Expand the Synergy SIS folder by clicking on the blue triangle pointing right, next to 
the word Synergy SIS. Once clicked, the triangle turns green and points downward. 

 
Figure 9.58 – Synergy SIS Folder 

 

 
Figure 9.59 – Synergy SIS Folder 

Expanded 

3. Under the Synergy SIS folder, open the Schedule folder by clicking on the blue 
triangle pointing right, next to the word Schedule. Once clicked, the triangle turns 
green and points downward. 

 
Figure 9.60 – Schedule Folder 

 

 
Figure 9.61 – Schedule Folder Expanded 
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4. Under the Schedule folder, open the Reports folder by clicking on the blue triangle 
pointing right, next to the word Reports. Once clicked, the triangle turns green and 
points downward. 

 
Figure 9.62 – Reports Folder 

 

 
Figure 9.63 – Reports Folder Expanded 

5. To access the Extract reports, click on the blue triangle next to the word Extracts. 
To access the Individual reports, click on the blue triangle next to the word 
Individual. To access the List reports, click on the blue triangle next to the word List.  

 
Figure 9.64 – Extracts, Individual, & 

List Folders 

 

 
Figure 9.65 – Extracts, Individual, & List Folders Expanded 

6. Click on the name of the report to open the report and select the options to be 
used in printing the report. 

7. Once the report options have been set, click on the Print button to print the report. 
The report is printed as a PDF file to the screen, which can then be sent to the 
printer. 

  

Reference: For more information about customizing all Synergy SIS 
reports, please refer to the manual titled Synergy SIS – Queries & 
Reports Guide. This chapter covers only the customizations specific to 
each of the reports used in Scheduling, and more options can be set 
for any report printed from Synergy SIS. 
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STU810 – Grade Book Extract 
 
The Grade Book Extract is designed to be printed and saved as a text file that can be 
imported to a grade book program. It includes the student’s Last Name, First Name, Perm 
ID, Gender, Grade and Email. 
 

 
Figure 9.66 - Grade Book Extract 
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The report can be customized using the following options: 
 

 
Figure 9.67 - Grade Book Extract 

• The report can be printed for a single student or group of students by entering all 
or part of their Perm ID, Last Name or First Name 

• Select the range of grade levels to be included by selecting the Grade from the 
drop-down list. 

• Choose which gradebook program is used from the Extract Type drop-down. 
The extract supports either an Easy Grade Pro Extract or Grade Quick. 
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STU202 – Student Schedule 
 
The Student Schedule shows all classes that have been scheduled for the student, and 
includes the period, teacher and room information for each class. 
 

 
Figure 9.68 – Student Schedule 
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The report can be customized using the following options: 

 
Figure 9.69 - Student Schedule Report Interface, Schedule Info and Student Info sections 

Figure 9.70 - Student Schedule Report Interface 

• To screen the student’s schedule on a specific date, enter the date in the Filter Date 
box in MM/DD/YY format. The date may also be selected by clicking on the Calendar  
button. 

• To see the schedule for a specific range of terms, select the Term Filter Start and 
Term Filter End from the drop-down list. 

• An individual student or group of students can be selected by filtering on the Perm ID, 
Gender, Last Name, First Name, Middle Name, or Grade. For example, if grade 12 is 
selected the report prints an individual report for each student in grade 12. A range of 
grades may also be selected. 

• To remove all student demographic information from the report, check the Hide All 
Personal Information box. 

• To remove the student’s Perm ID from the report, check the box Hide Perm ID. 
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Figure 9.71 - Student Schedule Report Interface, Period Range, Grouping Info and Teacher Info sections 

• To only print the schedule for a specific range of periods, select the Period Begin and 
Period End from the drop-down list. 

• To group the schedule for a specific term and period, select Term & Period from the 
drop-down list.  

• To only show the teacher’s last name, check the Hide Teacher’s First Name box.  
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Figure 9.72 - Student Schedule Report Interface, Include the following fields and Audit Class Options 

• Check the boxes to Show House, Counselor, Locker Number and/or Locker 
Combination. If one of these options is checked, but the student record does not have 
data for that field, the text entered in the text box for that field displays instead. 

• If checked to print, select the Locker Type to display from the drop-down list. 
• If checked to print, select the Locker Combination to Print from the drop-down list. 
• Check the boxes to Show Homeroom Teacher, Homeroom Number and/or Dropped 

Classes. 
• Check the boxes to Hide Class Period, Hide Class Teacher, Hide Class Room, 

and/or Show Course Fees. 
• Check the box to Only show audited classes to only print results for audited classes. 
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MST401 – Section List by Course 
 
The Section List by Course lists all of the sections scheduled for a course. 
 

 
Figure 9.73 - Section List by Course 
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The report can be customized using the following options: 
 

 
Figure 9.74 - Section List by Course, Report Interface 

• Select the term to be included in the report from the Term Filter drop-down list. 

• To remove the total number of students in the course and section, check the box 
labeled Suppress Course Totals. 

• Filter the results based on the date entered in the Student totals as of field.  
When a date is entered, the date prints in the header of the report and the data 
displayed is based on the selected date.  If the date is left blank, no date prints 
in the header. 
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MST402 – Section List by Teacher 
 
The Section List by Teacher lists all of the sections that are assigned to a teacher. 
 

 
Figure 9.75 - Section List by Teacher 
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The report can be customized using the following options: 
 

 
Figure 9.76 - Section List by Teacher, Report Interface 

• To print the report for a single teacher, select the Teacher from the drop-down 
list. 

• Select which Periods should be included on the report by checking the period 
numbers. To check or uncheck all periods, use the  buttons. 

• Select the Terms to include from the drop-down lists. 

• Filter the results based on the date entered in the Student totals as of field.  
When a date is entered, the date prints in the header of the report and the data 
displayed is based on the selected date.  If the date is left blank, no date prints 
in the header. 
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MST403 – Section List by Course and Term 
 
The Section List by Course and Term lists all courses and shows which sections have been 
scheduled for each course. It can also show the total number of students scheduled, the 
number of seats available, and the maximum number of seats in the section. 
 

  
Figure 9.77 - Section List by Course and Term 
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The report can be customized using the following options: 
 

 
Figure 9.78 - Section List by Course and Term, Report Interface 

• Select the Term to be included in the report from the Term Filter drop-down list. 

• To print the report for a single section, enter the Section ID 

• To print the report for a range of courses, enter the beginning and ending 
Course ID. 

• To remove the summary numbers for the section and courses from the report, 
check the Suppress Course Totals box. 

• Filter the results based on the date entered in the Student totals as of field.  
When a date is entered, the date prints in the header of the report and the data 
displayed is based on the selected date.  If the date is left blank, no date prints 
in the header. 
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MST406 – Open Periods 
 
The Open Periods a report lists all students and shows which periods are currently open 
(are not scheduled for a section). 
 

 
Figure 9.79 – Open Periods 
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The report can be customized using the following options: 
 

 
Figure 9.80 – Open Periods, Report Interface 

• Enter the date for which to analyze the periods in the As of Date box in 
MM/DD/YY format. The dates can also be selected using the Calendar button. 

• To show only information about select grades, check the Grades to be included 
in the report. To check or uncheck all grades, use the  buttons. 

• To show only information about select terms, check the Terms to be included in 
the report. To check or uncheck all terms, use the  buttons. 

• Select the range of periods to be included in the report by entering the first 
period in the Start box and the last period in the End box. 
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MST408 – Class Analysis by Course and Section 
 
The Class Analysis by Course and Section report lists each course and shows the sections 
scheduled for the course. For each section and course, the report lists the number of 
students scheduled both overall and by gender, the total number of spaces available, the 
number of requests, and the average number of students scheduled in a section. 
 

 
Figure 9.81 - Class Analysis by Course and Section 
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The report can be customized using the following options: 
 

 
Figure 9.82 - Class Analysis by Course and Section, Report Interface 

• Check the box Show Only Courses Who Have More Requests Than 
Availability to only list courses that do not have enough seats available for the 
number of request. 

•  Check the box Show Only Courses With Sections to list only courses for 
which sections have been created. 

• To show courses and sections for a specific range of periods, select the Period 
Begin and Period End from the drop-down list. 
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MST412 – Class Load Analysis 
 
The Class Load Analysis report lists section id, course title, room number, class size and 
restrictions. 
 

 
Figure 9.83 – Class Load Analysis 
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The report can be customized using the following options: 
 

 
Figure 9.84 – Class Load Analysis, Report Interface 

• To print the report for a single section, enter the Section ID 

• To show courses and sections for a specific range of periods, select the Period 
Begin and Period End from the drop-down list. 

• To show only information about select terms, check the Term Code to be 
included in the report. To check or uncheck all terms, use the  buttons. 
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MST413 – Student Current Schedule Analysis 
 
The Student Current Schedule Analysis lists the schedule for each student, and includes 
the section meeting days, period, teach and room. 
 

 
Figure 9.85 - Student Current Schedule Analysis 
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The report can be customized using the following options: 
 

 
Figure 9.86 - Student Current Schedule Analysis 

• To print only the schedules for a specific range of terms, select the starting and 
ending terms from the Term Filter drop-down lists. 

• To only include a range of sections, enter the beginning and ending Section ID. 

• To print the report for just one grade and/or one gender, select the Grade and/or 
Gender from the drop-down lists. 

• Check the box One Student Per Page to only include one student’s schedule 
on each page of the report. 

• To group the schedule for a specific term and period, select Term & Period from 
the drop-down list. 
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MST414 – Master Schedule by Department  
 
The Master Schedule by Department is a graphical look at the master schedule. This report 
is grouped by department, and shows the teacher, room, and period. 
  

 
Figure 9.13 – Master Schedule by Department List 
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The report can be customized using the following options: 
 

 
Figure 9.14 – Master Schedule by Department Report Interface 

• Enter the date for which to analyze the periods in the As of Date box in 
MM/DD/YY format. The dates can also be selected using the Calendar button. 

• Select the range of periods to be included by entering the first period of the 
range in the Period Begin box and the last period in the Period End box. 

• To filter the courses displayed on the report by their Department, check which 
Departments to display 
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MST415 – Master Schedule by Room  
 
The Schedule by Room is a graphical look at the master schedule based. This report is 
grouped by room, and shows which teacher is in the room for each period.  It also lists 
when the classroom is open or if it is scheduled for a study hall. 
  

 
Figure 9.15 – Master Schedule by Room List 
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The report can be customized using the following options: 
 

 
Figure 9.16 – Master Schedule by Room Report Interface 

• Enter the date for which to analyze the periods in the As of Date box in 
MM/DD/YY format. The dates can also be selected using the Calendar button. 

• Select the range of periods to be included by entering the first period of the 
range in the Period Begin box and the last period in the Period End box. 

• To filter the courses displayed on the report by their Department, check which 
Departments to display. 

• To indicate which classroom is considered small enter the maximum number of 
students for a small class in the Size limit for “small” classroom field. 

• To indicate which classes are used as a study hall, select the course type from 
the Course type to show as Study Hall group box. 
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MST416 – Department Section List  
 
The Department Section List displays all the sections by department. This report is grouped 
by department, teacher, term, period, section, course id, meeting day, and room.  It also 
displays the maximum, total, and open number of seats for each section. 
  

 
Figure 9.17 – Department Section List 
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The report can be customized using the following options: 
 

 
Figure 9.18 – Department Sections List Report Interface 

• Select the Department from the drop-down list to print the list for just one 
department. 

• To only include a range of rooms, enter the first and last Room Name. The 
rooms are listed numerically then alphabetically.  

• Select the range of class periods levels to be included by selecting the Period 
from the drop-down list. 

• Select the Staff from the drop-down list to print the list for just one teacher. 

• Select the Subject Area from the drop-down list to print the list for just one 
subject. 
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MST417 – Room Section List  
 
The Room Section list displays all the sections that are taught in a particular room. This 
report is grouped by room, department, term, period, section, course id, and meeting days.   
It also displays the maximum, total, and open number of seats for each section. 
 

 
Figure 9.19 – Room Section List 
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The report can be customized using the following options: 
 

 
Figure 9.20 – Room Section List Report Interface 

• Select the Department from the drop-down list to print the list for just one 
department. 

• To only include a range of rooms, enter the first and last Room Name. The 
rooms are listed numerically then alphabetically.  

• Select the range of class periods levels to be included by selecting the Period 
from the drop-down list. 

• Select the Staff from the drop-down list to print the list for just one teacher. 

• Select the Subject Area from the drop-down list to print the list for just one 
subject. 
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MST801 – Program of Recitation Report 
 
The Class List prints the list of enrolled students in each section on a separate page, with a 
space to make notations about each student. This versatile report can be used for many 
types of student tracking in each section. 
 
 

 
Figure 9.87 – Program of Recitation Report Example 
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The report can be customized using the following options: 
 
 

 
Figure 9.88 - Student Current Schedule Analysis Report Interface 

• Select the As Of Date this report is produced. 

• To print only the schedules for a specific range of terms, select the starting and 
ending terms from the Term Filter drop-down lists. 

• To only include a range of sections, enter the beginning and ending Section ID. 
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STU408 – Class List 
 
The Class List prints the list of enrolled students in each section on a separate page, with a 
space to make notations about each student. This versatile report can be used for many 
types of student tracking in each section. 
 

  
Figure 9.89 – Class List 
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The report can be customized using the following options: 
 

 
Figure 9.90 – Class List, Report Interface 

• The report can be printed for a single term by selecting the term from the Term 
Code drop-down list. 

• The report can be filtered to include students that were active in the section as 
of the date specified in the Students Active in Class as of: date. 

• To print the report for a specific range of sections, enter the beginning and 
ending section ID in the Section ID boxes. 

• To print the report for a specific range of courses, enter the beginning and 
ending course ID in the Course ID boxes. 

• Select the range of grade levels to be included by selecting the Grade from the 
drop-down list. 

• Select the range of class periods levels to be included by selecting the Period 
from the drop-down list. 
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• Select the Teacher from the drop-down list to print the list for just one teacher. 

• Select the Department from the drop-down list to print the list for just one 
department. 

• To print the list of students without the summary of the total number of students 
in the section listed at the bottom, check the box Hide Totals. 

• To exclude students with term override, select the Exclude Students with 
Term Override not in Term Code checkbox. 

• To include additional information about each student on the list, check the boxes 
in front of the information to add in the Include the Following Fields section. 
Information that can be added is Perm ID, State ID, Gender, Grade, Ethnic 
Code, Birth Date, Enter Date, Home Language, and Phone Number. To 
control how much space each extra column of information takes on the report, 
enter the width of each column in the boxes provided (in inches). 
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STU414 – Student Schedule Preprinted Cards 
 
The Student Schedule Preprinted Cards are designed to be printed on perforated pre-
printed stock to make wallet-sized cards with each student’s schedule. 
 

 

Figure 9.91 - Student Schedule Preprinted Cards 
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The report can be customized using the following options: 
 

• Enter the As of Date in MM/DD/YY 
format to print the schedule for a 
specific date. The date can also be 
selected by clicking the Calendar  
button. 

• To print only the schedules for a 
specific range of terms, select the 
starting and ending terms from the 
Term Filter Start and Term Filter 
End drop-down lists. 

• An individual student or group of 
students can be selected by filtering 
on the Perm ID, Gender, Last 
Name, First Name, Middle Name, 
or Grade. For example, if grade 12 is 
selected the report prints an 
individual report for each student in 
grade 12. A range of grades may 
also be selected. 

• Select how to display the teacher’s 
name for each section from the 
Display Teacher Name drop-down 
list. It can print Full Name, Hide First 
Name, or Hidden. 

• To remove the room number for each 
section, check Hide Room Number. 

• To select the parent/guardian 
information that is printed at the 
bottom of each card, check the box 
or boxes in the Flags and/or Type 
sections. To check or uncheck all of 
the boxes in the Type section, use 
the  buttons. 

• Select which Locker Combination 
to print from the drop-down list. 

• To group the schedules for a specific 
term and period, select Term & 
Period from the drop-down list. 

 
Figure 9.92 - Student Schedule Preprinted Cards, Report Interface 
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STU415 – Student Schedule List 
 
The Student Schedule List prints each student’s schedule with just the basic information 
about each section, including period, term, section ID, course ID & title, the meeting days 
for schools with rotating days, the teacher’s name, and the room name. 
 

 
Figure 9.93 - Student Schedule List 

 



Scheduling and Course Guide   Chapter Nine 
 

332 Copyright© 2013 Edupoint Educational Systems, LLC 

The report can be customized using the following options: 
 

 
Figure 9.94 - Student Schedule List, Report Interface 

• Enter the As of Date in MM/DD/YY format to print the schedule for a specific 
date. The date can also be selected by clicking the Calendar  button. 

• To print only the schedules for a specific range of terms, select the starting and 
ending terms from the Term Filter Start and Term Filter End drop-down lists. 

• An individual student or group of students can be selected by filtering on the 
Perm ID, Gender, Last Name, First Name, Middle Name, or Grade. For 
example, if grade 12 is selected the report prints an individual report for each 
student in grade 12. A range of grades may also be selected. 

• To remove the student’s Perm ID from the report, check the Hide Perm ID box. 

• To group the schedules for a specific term and period, select Term & Period 
from the drop-down list. 

• To print only the teacher’s last name, check the Hide Teacher’s First Name 
box. 
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STU419 – Section Seating Chart 
 
The Section Seating Chart report lists all students and where they sit in the classroom, 
based on the seating chart created in TEACHERVUE. 
 

 
Figure 9.95 – Section Seating Chart 
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The report can be customized using the following options: 
 

 
Figure 9.96 – Section Seating Chart, Report Interface 

 

• To print the report for a single section, enter the Section ID 

• Select the Staff from the drop-down list to print the chart for just one teacher. 

• To show only information about select terms, check the Term Code to be 
included in the report. To check or uncheck all terms, use the  buttons. 

• To customize the abbreviations for the absence codes listed with checkboxes at 
the bottom of each student’s picture, enter the new abbreviations to be printed in 
the Absences Text Field 1, 2, and 3 boxes. 
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STU420 – Lunch Count Totals 
 
The Lunch Count Totals report lists all homerooms at a school and the lunch count totals 
for each section. The areas tallied for each section are setup on the TeacherVUE tab of the 
School Setup screen. 
 
 

 
Figure 9.97 – Lunch Count Totals 

 
 
The report can be customized by selecting the day for which the totals print by entering the 
date in the Run Date field in MM/DD/YY format or selecting it using the Calendar button. 
 

 
Figure 9.98 – Lunch Count Totals Interface 
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Chapter Ten: 
SECURITY 

 
 
 
 
 
 
 
 
 
 
 
 

In this chapter, the following topics are covered: 
 Where security for scheduling-related views may be defined 
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Security for each of the views discussed throughout this manual is defined by two options: the 
PAD Security screen and the Security Definition screen. Both of these views are found 
under Synergy SIS > System > Security. How each of these views work and how security is 
defined is covered in detail in the Synergy SIS - Security Administrator Guide. This chapter 
outlines where the security for each part of each scheduling-related screen may be defined in 
the Security Definition screen. 
 

DISTRICT COURSE SECURITY 
 
Almost everything on the Course tab of the District Course screen, which is found under 
Synergy SIS > Course, is controlled by the security node: 
 

K12.CourseInfo.Course 
 
This security node also controls the Description tab of the District Course screen. 
 

  
Figure 10.1 – District Course Screen, Course Tab 

 
The Alternate Code section on the Course tab is controlled by the security node 
K12.CourseInfo.CourseAltCode. This security node also controls the Alternate Code section 
on the Year Override tab. 
 
The School Types section is controlled by the security node 
K12.CourseInfo.CourseSchoolType. 



Scheduling and Course Guide   Chapter Ten 
 

338 Copyright© 2013 Edupoint Educational Systems, LLC 

Everything on the Description tab of the District Course screen is controlled by the security 
node: 
 

K12.CourseInfo.Course 
 
This security node also controls most of the Course tab of the District Course screen. 
 

 
Figure 10.2 District Course Screen, Description Tab 

 
The Year Override tab of the District Course screen is controlled by four security nodes: 
 

  
Figure 10.3 – District Course Screen, Year Override Tab 

 

• K12.CourseInfo.CourseOverride controls the Course Subject Areas section. 

• K12.CourseInfo.CourseAltCode controls the Alternate Codes section. This 
security node also controls the Alternate Codes section on the Course tab. 

• K12.CourseInfo.CourseAltFunding controls the Qualifies for Alt State Funding 
section. 

• K12.CourseInfo.CourseTechnicalCourse controls the Technical Course section. 
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The Pre/Corequisite tab of the District Course screen is controlled by 3 security nodes: 
 

  
Figure 10.4 – District Course Screen, Pre/Corequisite Tab 

 

• K12.CourseInfo.CourseCoReq controls the Corequisites section. 

• K12.CourseInfo.CoursePreReq controls the Prerequisite section. 

• K12.CourseInfo.CoursePreReqMark controls the Valid Marks for each 
prerequisite in the detailed screen. 

 
The following security nodes do not provide a visible change in security on the views: 

• K12.CourseInfo.CourseDistrictUI  

• K12.CourseInfo.CourseSchool  
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SCHOOL COURSE SECURITY 
 
The School Course screen, found under Synergy SIS > Course, is controlled by the security 
node: 
 

K12.CourseInfo.Setup.CourseOptInGrid 
 

 
Figure 10.5 – School Course Screen 

 
The following security nodes do not provide a visible change in security on the views: 

• K12.CourseInfo.SchoolCourse  

• K12.CourseInfo.Setup.DistrictCourseFind 

• K12.CourseInfo.Setup.CourseOptInDelete 

COURSE GROUP SECURITY 
 
The Course Group screen, found under Synergy SIS > Course, is controlled by 2 security 
nodes: 
 

 
Figure 10.6 – Course Group Screen 

 

• K12.CourseInfo.SchoolYearCourseGroup controls the group itself and the 
description of the group. 

• K12.CourseInfo.CourseGroupCourses controls the Group Courses section. 

 
The following security node does not provide a visible change in security on the views: 

• K12.CourseInfo.CourseGroupUI  
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PREREQUISITE COURSE GROUP SECURITY 
 

The Prerequisite Course Group screen, found under Synergy SIS > Course, is 
governed by two security nodes. 

 
 

• K12.CourseInfo.PreReqGroupCourse controls most of the screen. 
 

• K12.CourseInfo.PreReqGroupCourseMark controls the valid marks accessed 
with the Show Detail button. 

 

SCHOOL ROOM SECURITY 
 
The School Room screen, found under Synergy SIS > System > Setup, is not controlled by 
any security node. 
 

 
Figure 10.7 – School Room Screen 

 

SCHOOL SCHEDULING OPTIONS SECURITY 
 
The Section Options tab of the School Scheduling Options screen, found under Synergy 
SIS > Mass Scheduling > Setup, is controlled by the security node: 
 

• K12.ScheduleInfo.SchoolYearMetDay controls the Meeting Days section 

 

  
Figure 10.8 – School Scheduling Options Screen 
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The Course Request and Walk-In Options tab of the School Scheduling Options 
screen, found under Synergy SIS > Mass Scheduling > Setup, is controlled by the security 
nodes: 

• K12.ScheduleInfo.Setup.SchoolYearOptSchedule controls everything except 
for the Override Term Codes section. 

• K12.ScheduleInfo.Setup.SchoolOverrideTerm controls the Override Term 
Codes section. 

  
Figure 10.9 - School Scheduling Options Screen, Course Request and Walk-In Options Tab 

The House/Team/Exclusion tab of the School Scheduling Options screen, found under 
Synergy SIS > Mass Scheduling > Setup, is controlled by the security nodes: 

• K12.ScheduleInfo.Exclusion controls the Term Exclusion Codes section 

• K12.ScheduleInfo.House controls the House Codes section 

• K12.ScheduleInfo.Team controls the Team Codes section 

  
Figure 10.10 – School Scheduling Options Screen, House/Team/Exclusion Tab 

 
The following security node does not provide a visible change in security on the views: 

• K12.ScheduleInfo.Setup.ScheduleTallyLock  
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WHEEL DEFINITION SECURITY 
 
The Wheel Definition screen, found under Synergy SIS > Mass Scheduling > Setup, is 
controlled by 2 security nodes: 
 

• K12.CourseInfo.CourseWheel controls the wheel itself and the description of 
the wheel. 

• K12.CourseInfo.CourseWheelCourse controls the Course Grid section. 

 

  
Figure 10.11 – Wheel Definition Screen 

 
 

COURSE REQUEST ANALYSIS SECURITY 
 
The Course Request Analysis screen, found under Synergy SIS > Mass Scheduling, is 
controlled by the security node: 
 

K12.ScheduleInfo.MassScheduleInfo.CourseReqAnalysisGrid 
 

 
Figure 10.12 – Course Request Analysis Screen 

 
The following security node does not provide a visible change in security on the views: 

• K12.ScheduleInfo.MassScheduleInfo.CourseReqAnalysis  
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MASS ASSIGN COURSE REQUESTS SECURITY 
 
The Mass Assign tab of the Mass Assign Course Requests screen, found under 
Synergy SIS > Mass Scheduling, is controlled by the security nodes: 

• K12.ScheduleInfo.MassScheduleInfo.SchedMassAssign controls adding and 
deleting the course request definitions, and the changing of the name of the 
group. This node also controls the Other Info tab. 

• K12.ScheduleInfo.MassScheduleInfo.SchedMassAssignToGrid controls the 
Courses To Add grid. 

• K12.ScheduleInfo.MassScheduleInfo.SchedMassAssignFromGrid controls the 
Courses To Find and Replace grid. 

 

 
Figure 10.13 – Mass Assign Course Requests Screen, Mass Assign Tab 

 
The Selected Students tab of the Mass Assign Course Requests screen, found under 
Synergy SIS > Mass Scheduling, is controlled by the security node: 
 

K12.ScheduleInfo.MassScheduleInfo.SchedMassAssignStuGrid 
 

 
Figure 10.14 – Mass Assign Course Requests Screen, Selected Students Tab 

 
 
The Other Info tab of the Mass Assign Course Requests screen, found under Synergy 
SIS > Mass Scheduling, is controlled by the security node: 
 

K12.ScheduleInfo.MassScheduleInfo.SchedMassAssign 
 
This security node also controls adding and deleting the course request definitions and the 
changing of the name of the group.  



Scheduling Administrator & User Guide Chapter Ten 
 

346 Copyright© 2013 Edupoint Educational Systems, LLC 

 
Figure 10.15 – Mass Assign Course Requests Screen, Other Info tab 

 
The following security node does not provide a visible change in security on the views: 

• K12.ScheduleInfo.MassScheduleInfo.SchedMassAssignUI  

 

MASS ASSIGN HOUSE AND TEAM SECURITY 
The Options tab of the Mass Assign House and Team screen, found under Synergy SIS 
> Mass Scheduling, is not controlled by any security node. 
 

 
Figure 10.16 – Mass Assign House And Team, Options Tab 

 
The Additional Filters tab of the Mass Assign House and Team screen, found under 
Synergy SIS > Mass Scheduling, is controlled by the security node: 
 

K12.ScheduleInfo.MassAssignStudentConditionGrid 
 

 
Figure 10.17 – Mass Assign House And Team, Additional Filters Tab 

 
The following security nodes do not provide a visible change in security on the views: 

• K12.ScheduleInfo.MassAssignHouseTeamUI  

• K12.ScheduleInfo.HouseTeamStuGrid  
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MASS ASSIGN SECTIONS SECURITY 
 
The Mass Assign tab of the Mass Assign Sections screen, found under Synergy SIS > 
Mass Scheduling, is controlled by the security nodes: 

• K12.ScheduleInfo.MassScheduleInfo.SchedMassSectionUpdate controls 
adding or deleting definitions, the Options section, and the Gender filter. 

• K12.ScheduleInfo.MassScheduleInfo.SchedMassSectionUpdateGrades controls 
the Grades filter. 

• K12.ScheduleInfo.MassScheduleInfo.SchedMassSectionUpdateToGrid controls 
the Sections To Add grid. 

• K12.ScheduleInfo.MassScheduleInfo.SchedMassSectionUpdateFindGrid 
controls the Sections To Find and Replace grid. 

  
Figure 10.18 – Mass Assign Sections Screen, Mass Assign Tab 

 
The Student Selection tab of the Mass Assign Sections screen, found under Synergy 
SIS > Mass Scheduling, is controlled by the security node: 
 

K12.ScheduleInfo.MassScheduleInfo.SchedMassSectionUpdateStu 
 

 
Figure 10.19 – Mass Assign Sections Screen, Student Selection Tab 

 
The following security node does not provide a visible change in security on the views: 

• K12.ScheduleInfo.MassScheduleInfo.SchedMassSectionUpdateUI  
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SCHEDULE CONTROL SECURITY 
 
The Schedule Control screen, found under Synergy SIS > Mass Scheduling, is controlled 
by the security node: 
 

K12.ScheduleInfo.MassScheduleInfo.OptionSet 
 
This node also controls the Fill Open Periods tab of the Schedule Option Set screen, and 
the Exceed Max Class Size boxes on the Options tab of the Schedule Option Set screen. 
 

 
Figure 10.20 – Schedule Control Screen 

 
The following security nodes do not provide a visible change in security on the screen: 

• K12.ScheduleInfo.MassScheduleInfo.ScheduleControlUI  

• K12.ScheduleInfo.MassScheduleInfo.SchedulingMatrix  

• K12.ScheduleInfo.MassScheduleInfo.SchedulingMatrixGrid  
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SCHEDULE OPTION SET SECURITY 
 
The Options tab of the Schedule Option Set screen, found by clicking the Option Set 
button on the Schedule Control screen under Synergy SIS > Mass Scheduling, is controlled 
by the security nodes: 

• K12.ScheduleInfo.MassScheduleInfo.OptionSet controls the Max Class Size 
boxes. This node also controls the Schedule Control screen, and the Fill Open 
Periods tab of the Schedule Option Set screen. 

• K12.ScheduleInfo.MassScheduleInfo.OptionSetUI controls the Quick Links 

• K12.ScheduleInfo.MassScheduleInfo.OptionSetGradeList controls the 
Grade checkboxes in the Exclude the Following Students section. 

• K12.ScheduleInfo.MassScheduleInfo.OptionSetHouseList controls the 
House checkboxes in the Exclude the Following Students section. 

• K12.ScheduleInfo.MassScheduleInfo.OptionSetTeamList controls the Team 
checkboxes in the Exclude the Following Students section. 

 
Figure 10.21 – Schedule Option Set Screen 
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The Fill Open Periods tab of the Schedule Option Set screen, found by clicking the 
Option Set button on the Schedule Control screen under Synergy SIS > Mass Scheduling, 
is controlled by the security node: 
 

K12.ScheduleInfo.MassScheduleInfo.OptionSet 
 
This security node also controls the Schedule Control screen, and the Exceed Max Class 
Size boxes on the Options tab of the Schedule Option Set screen. 
 

 
Figure 10.22 – Schedule Option Set Screen, Fill Open Periods Tab 

 
The following security nodes do not provide a visible change in security on the screen: 

• K12.ScheduleInfo.MassScheduleInfo.AddOptionSetUI  

• K12.ScheduleInfo.MassScheduleInfo.OptionSetSection  

• K12.ScheduleInfo.MassScheduleInfo.OptionSetSectionGrid  
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SCHEDULE STUDENT SECURITY 
 
The Requests tab of the Schedule Student screen, found by clicking the Open Student 
Schedule link on the Schedule Option Set screen under Synergy SIS > Mass Scheduling, is 
controlled by the security nodes: 

• K12.ScheduleInfo.MassScheduleInfo.SectionStudentGrid controls the 
Course Requests grid. 

• K12.ScheduleInfo.MassScheduleInfo.SchedStudentGrid also controls the 
Course Requests grid. 

 

 
Figure 10.23 – Schedule Student Screen, Requests Tab 
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The Analysis tab of the Schedule Student screen, found by clicking the Open Student 
Schedule link on the Schedule Option Set screen under Synergy SIS > Mass Scheduling, is 
controlled by the security node: 
 

K12.ScheduleInfo.MassScheduleInfo.SchedAnalysisGrid 
 

 
Figure 10.24 – Schedule Student Screen, Requests Tab 
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The Schedule tab of the Schedule Student screen, found by clicking the Open Student 
Schedule link on the Schedule Option Set screen under Synergy SIS > Mass Scheduling, is 
controlled by the security node: 
 

K12.ScheduleInfo.MassScheduleInfo.SchedSchedulesGrid 
 

 
Figure 10.25 – Schedule Student Screen, Requests Tab 

 
The following security nodes do not provide a visible change in security on the screen: 

• K12.ScheduleInfo.MassScheduleInfo.SchedStudentUI  

• K12.ScheduleInfo.MassScheduleInfo.StudentScheduleResult  

• K12.ScheduleInfo.MassScheduleInfo.StudentOpenPeriod  
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SCHED SECTION SECURITY 
 
The Current Students tab of the Sched Section screen, found by clicking the Open 
Schedule Section link on the Schedule Option Set screen under Synergy SIS > Mass 
Scheduling, is controlled by the security nodes: 

• K12.ScheduleInfo.MassScheduleInfo.SchedSection controls the entire 
Current Students tab except the Students grid. 

 

 
Figure 10.26 – Sched Section Screen 

 
The Meeting Days tab of the Sched Section screen is controlled by the security node: 
 

K12.ScheduleInfo.MassScheduleInfo.SchedSectionMetGrid 
 

 
Figure 10.27 – Sched Section Screen, Meeting Days Tab 

 
The following security nodes do not provide a visible change in security on the screen: 

• K12.ScheduleInfo.MassScheduleInfo.SchedSectionUI  

• K12.ScheduleInfo.MassScheduleInfo.SchedSectionMetDay  

• K12.ScheduleInfo.MassScheduleInfo.SchedSectionSelection  

• K12.ScheduleInfo.MassScheduleInfo.SchedSectionStaff  

• K12.ScheduleInfo.MassScheduleInfo.SectionSelectionGrid  
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OPTION SET WHEEL SECURITY 
 
The Option Set Wheel screen, found by clicking the Open Option Set Wheel link on the 
Schedule Option Set screen under Synergy SIS > Mass Scheduling, is controlled by the 
security node: 
 

K12.ScheduleInfo.MassScheduleInfo.OptionSchedWheelGrid 
 

 
Figure 10.28 – Option Set Wheel Screen 

 
The detailed screen of the Option Set Wheel screen, found by clicking the Open Option 
Set Wheel link on the Schedule Option Set screen under Synergy SIS > Mass Scheduling, 
is controlled by the security node: 
 

K12.ScheduleInfo.MassScheduleInfo.OptionSchedWheelDetailGrid 
 

 
Figure 10.29 – Option Set Wheel Screen, Detailed Screen 

 
The following security nodes do not provide a visible change in security on the screen: 

• K12.ScheduleInfo.MassScheduleInfo.OptionSchedWheelUI  

• K12.ScheduleInfo.MassScheduleInfo.CourseWheelCombo  

• K12.ScheduleInfo.MassScheduleInfo.OptionSchedWheel  

• K12.ScheduleInfo.MassScheduleInfo.OptionSchedWheelSection  
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SCHEDULE REQUEST SECURITY 
 
The Schedule Request screen, found under Synergy SIS > Mass Scheduling, is controlled 
by the security nodes: 

• K12.ScheduleInfo.MassScheduleInfo.StudentRequestGrid controls the 
Student Requests grid. 

• K12.ScheduleInfo.MassScheduleInfo.StudentScheduleRequestAlternate 
controls the Alternatives for Electives grid. 

 
Figure 10.30 – Schedule Request Screen 

 
The following security nodes do not provide a visible change in security on the screen: 

• K12.ScheduleInfo.MassScheduleInfo.ScheduleRequestUI  

• K12.Scheduling.StudentSchedule 

• K12.ScheduleInfo.MassScheduleInfo.StudentScheduleRequest  

• K12.ScheduleInfo.MassScheduleInfo.CrsAltStuSchedRequest  

• K12.ScheduleInfo.MassScheduleInfo.CrsStuSchedRequest  

 
 

UPDATE SCHEDULE SECURITY 
 
The Update Schedule screen, found under Synergy SIS > Mass Scheduling, is not 
controlled by any security node. 
 

 
Figure 10.31 – Update Security Screen 

 
The following security node does not provide a visible change in security on the screen: 

• K12.ScheduleInfo.MassScheduleInfo.UpdateScheduleUI  
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WALK IN SCHEDULE SECURITY 
 
The Request tab of the Walk In Schedule screen, found under Synergy SIS > Mass 
Scheduling and Synergy SIS > Schedule, is controlled by the security node: 
 

K12.ScheduleInfo.MassScheduleInfo.WalkInCourseRequestGrid 
 

 
Figure 10.32 – Walk In Schedule Screen, Request Tab 
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The Analysis tab of the Walk In Schedule screen, found under Synergy SIS > Mass 
Scheduling and Synergy SIS > Schedule, is controlled by the security node: 
 

K12.ScheduleInfo.MassScheduleInfo.WalkInSchedAnalysisGrid 
 

 
Figure 10.33 – Walk In Schedule Screen, Analysis Tab 

 



Chapter Ten Scheduling Administrator & User Guide 
 

Copyright© 2013 Edupoint Educational Systems, LLC 359 

The Schedule tab of the Walk In Schedule screen, found under Synergy SIS > Mass 
Scheduling and Synergy SIS > Schedule, is controlled by the security node: 
 

K12.ScheduleInfo.MassScheduleInfo.WalkInScheduleGrid 
 

 
Figure 10.34 – Walk In Schedule Screen, Schedule Tab 

 
The following security nodes do not provide a visible change in security on the views: 

• K12.ScheduleInfo.MassScheduleInfo.WalkInScheduleUI  

• K12.ScheduleInfo.MassScheduleInfo.WalkInResult  

• K12.ScheduleInfo.MassScheduleInfo.WalkInSchedSectionSelection  
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BELL SCHEDULE DEFINITION SECURITY 
 
The Bell Schedule Definition screen, found under Synergy SIS > Attendance > Setup and 
Synergy SIS > Schedule > Setup, is controlled by the security nodes: 
 

• K12.ScheduleInfo.SchoolYearBellSched controls adding and deleing 
definitions, and the Code and Bell Schedule Name 

• K12.ScheduleInfo.BellScheduleGrid controls the Bell Schedule Definition grid 

 

 
Figure 10.35 – Bell Schedule Definition Screen 

 
The following security nodes do not provide a visible change in security on the views: 

• K12.ScheduleInfo.BellScheduleUI  

• K12.ScheduleInfo.SchoolYearBellSchedPer  

• K12.AttendanceInfo.Setup.SchoolYearBellSchedule  

• K12.AttendanceInfo.Setup.SchoolYearBellSchedulePer  
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PERIOD ROTATION DEFINITION SECURITY 
 
The Rotation Days tab of the Period Rotation Definition screen, found under Synergy 
SIS > Attendance > Setup and Synergy SIS > Schedule > Setup, is controlled by the 
security node: 
 

K12.ScheduleInfo.RotationDefinitionGrid 
 

 
Figure 10.36 – Period Rotation Definition Screen, Rotation Days Tab 

 
The Rotation Periods tab of the Period Rotation Definition screen, found under Synergy 
SIS > Attendance > Setup and Synergy SIS > Schedule > Setup, is controlled by the 
security node: 
 

K12.ScheduleInfo.RotationPeriodDefinitionGrid 
 

 
Figure 10.37 – Period Rotation Definition Screen, Rotation Periods Tab 

 
The following security nodes do not provide a visible change in security on the views: 

• K12.ScheduleInfo.RotationDefinitionUI  

• K12.AttendanceInfo.Setup.SchoolYearRotationCycle  

• K12.AttendanceInfo.Setup.SchoolYearRotationCyclePer  

• K12.ScheduleInfo.SchoolYearRotCycle  

• K12.ScheduleInfo.SchoolYearRotCyclePer  
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WALK-IN SCHEDULING WHEEL DEF SECURITY 
 
The Option Grid of the Walk-In Scheduling Wheel Def screen, found under Synergy SIS > 
Schedule > Setup, is controlled by the security node: 
 
 

K12.ScheduleInfo.WalkinWheelDefGrid 
 

 
Figure 10.38 – Walk-In Scheduling Wheel Def Screen, Option Grid 

 
The detailed screen of the Walk-In Scheduling Wheel Def screen, found under Synergy 
SIS > Schedule > Setup, is controlled by the security node: 
 

K12.ScheduleInfo.WalkinWheelDefGridDetailGrid 
 

 
Figure 10.39 – Walk-In Scheduling Wheel Def Screen, Detailed Screen 

 
The following security nodes do not provide a visible change in security on the views: 

• K12.ScheduleInfo.WalkinWheelUI  

• K12.ScheduleInfo.WalkinWheel  

• K12.ScheduleInfo.WalkinWheelSection  
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ASSIGN STUDENTS TO SECTIONS SECURITY 
 
The By Student tab of the Assign Students To Sections screen, found under Synergy 
SIS > Schedule, is controlled by the security nodes: 

• K12.ScheduleInfo.MassAssignSections controls everything but the Students 
grid. It also controls the By Section tab. 

• K12.ScheduleInfo.MassAssignmentSectionGrid controls the Students grid. 

 
Figure 10.40 – Assign Students To Sections Screen, By Student Tab 

 
The By Section tab of the Assign Students To Sections screen, found under Synergy 
SIS > Schedule, is controlled by the security node: 
 

K12.ScheduleInfo.MassAssignSections 
 
This security node also controls everything on the By Student tab except the Students grid. 
 

 
Figure 10.41 – Assign Students To Sections Screen, By Section Tab 

 
The following security nodes do not provide a visible change in security on the views: 

• K12.ScheduleInfo.MassReplaceSection  

• K12.ScheduleInfo.MassReplaceSectionFromGrid  

• K12.ScheduleInfo.MassReplaceSectionToGrid  

• K12.ScheduleInfo.MassReplaceSectionUI  

• K12.ScheduleInfo.MassReplaceToGrid  
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CLASS ASSIGNMENT SECURITY 
 
The Class Assignment screen, found under Synergy SIS > Schedule, is controlled by the 
security nodes: 
 

• K12.ScheduleInfo.MassAssignSectGrid controls the Classes grid 

• K12.ScheduleInfo.MassAssignStuGrid controls the Students grid 

 

 
Figure 10.42 – Class Assignment Screen 

 
The following security nodes do not provide a visible change in security on the views: 

• K12.ScheduleInfo.MassAssign  

• K12.ScheduleInfo.MassAssignUI  

 
 

END TERM SECURITY 
 
The End Term screen, found under Synergy SIS > Schedule, is not controlled by any 
security node. 
 

 
Figure 10.43 – End Term Screen 

 
The following security node does not provide a visible change in security on the views: 

• K12.ScheduleInfo.Setup.EndTerm  



Chapter Ten Scheduling Administrator & User Guide 
 

Copyright© 2013 Edupoint Educational Systems, LLC 365 

MASS ASSIGN TRACK SECURITY 
 
The Mass Assign Track screen, found under Synergy SIS > Schedule, is not controlled by 
any security node. 
 

 
Figure 10.44 – Mass Assign Track Screen 

 
The following security node does not provide a visible change in security on the views: 

• K12.ScheduleInfo.MassAssignTrack  
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SECTION SECURITY 
 
The Current Students tab of the Section screen, found under Synergy SIS > Schedule, is 
controlled by the security nodes: 

• K12.ScheduleInfo.Section controls everything but the Students grid. The node 
also controls the Teaching Options and Teacher Experience Security sections 
on the Additional Staff tab. 

• K12.ScheduleInfo.ClassStudent controls the Students grid. This node also 
controls the Student Enrollment History tab. 

  
Figure 10.45 – Section Screen, Current Students Tab 

 
The Student Enrollment History tab of the Section screen, found under Synergy SIS > 
Schedule, is controlled by the security node: 
 

K12.ScheduleInfo.ClassStudent 
 
This security node also controls the Students grid on the Current Students tab. 
 

 
Figure 10.46 – Section Screen, Student Enrollment History Tab 
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The Meeting Days tab of the Section screen, found under Synergy SIS > Schedule, is 
controlled by the security node: 
 

K12.ScheduleInfo.SchYrSecMetGrid 
 

 
Figure 10.47 – Section Screen, Meeting Days Tab 

 
The Additional Staff tab of the Section screen, found under Synergy SIS > Schedule, is 
controlled by the security nodes: 
 

• K12.ScheduleInfo.Section controls the Teaching Options and the Teacher 
Experience Security sections. This security node also controls everything on the 
Current Students tab except the Students grid. 

• K12.ScheduleInfo.SchoolYearSectionStaff controls the Additional Staff grid. 

 

  
Figure 10.48 – Section Screen, Additional Staff Tab 

 
The Synchronize Section Meeting Day Period Options screen, found under the Menu 
options for the Section screen, is controlled by the security node: 
 

K12.ScheduleInfo.SynchronizeSectionMeetingDayPeriods 
 

 
Figure 10.49 – Section Screen, Menu, Synchronize Section Meeting Day Period Options 

 
The following security nodes do not provide a visible change in security on the views: 

• K12.ScheduleInfo.SectionUI  

• K12.ScheduleInfo.SchoolYearSectionMetDay  

• K12.ScheduleInfo.MassScheduleInfo.SynchronizeSectionMeetingDayPeriodsUI 
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STUDENT CLASSES SECURITY 
 
The Student Classes screen, found under Synergy SIS > Schedule, is controlled by the 
security node: 
 

K12.ScheduleInfo.StudentClassGrid 
 
This security node controls both tabs of the screen. 
 

 
Figure 10.50 – Student Classes Screen, Current Classes Tab 

 

 
Figure 10.51 – Student Classes Screen, Class Enrollment History Tab 

 
The following security nodes do not provide a visible change in security on the views: 

• K12.ScheduleInfo.StudentClassUI  

• K12.ScheduleInfo.StudentClass  
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STUDENT CLASSES DELETED SECURITY 
 
The Student Classes Deleted screen, found under Synergy SIS > Schedule, is controlled 
by the security node: 
 

K12.ScheduleInfo.StudentClassDelete 
 

 
Figure 10.52 – Student Classes Deleted Screen 

 
 

SCHEDULING REPORTS SECURITY 
 
While report security options are available under the Security Definition screen, it is 
recommended to only use the PAD tree security to control access to reports. 
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